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Preface

This guide provides information describing how to install, configure and use NetScreen-
Global PRO Report Manager.

AUDIENCE

The NetScreen-Global PRO Report Manager User’s GuideTM   is intended primarily for 
network and security administrators responsible for installing, configuring, and using 
Report Manager.

NEW FEATURES

Report Manager version 4.0 includes the following new features.

• Historical Reports Scheduler

• Extended Attack Status Monitoring and Reporting

• Zone-based Monitoring and Reporting

• Real-time Monitoring of Active Sessions

• VPN Monitoring Enhancements

• Scalability Enhancements

• SNMP Integration

• MS-SQL Database Support

• PostgreSQL Database Support

• Event Archiving

• Support for ScreenOS 4.0

OTHER RELATED SOFTWARE DOCUMENTS

To obtain technical documentation for any NetScreen product, visit www.netscreen.com/
support/manuals.html. To access the latest NetScreen documentation, see the Current 
Manuals section. To access archived documentation from previous releases, see the 
Archived Manuals section.

www.netscreen.com/support/manuals.html
www.netscreen.com/support/manuals.html
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To obtain the latest technical information on a NetScreen product release, see the release 
notes for that release. To obtain release notes, visit www.netscreen.com/support and 
select Software Download. Select the product and version, then click Go. To perform 
this download, you must be a registered user.

If you find any errors or omissions in the following content, please contact us at the e-mail 
address below:  techpubs@netscreen.com

PUBLICATION RECORD

NetScreen-Global PRO Report Manager software version: 4.0

Document date: Wednesday, December 11, 2002.

Specifications and information in this document are subject to change.

CONVENTIONS

The following defines the notation conventions used throughout this guide:

• All command lines appear in courier font.

• Anything inside < > is a variable.

• IP addresses are represented by <a.b.c.d> and <w.x.y.z>.

• A subnet mask is represented by <A.B.C.D>.

CONTACTING TECHNICAL SUPPORT

Technical support is available to registered users of NetScreen-Global PRO.

• Web site: http:// support.netscreen.com

• E-mail: support@netscreen.com

• Fax: 1-408-730-6100

• Voice: 1-800-638-8296

When contacting NetScreen Technologies, Inc. for technical support, please provide us 
with the following information:

• Your Service Level Agreement ID number.

• Your Name, Company and Telephone Number.

• Your fax number and an e-mail address.

• Equipment Type and Serial Number. 

• Detailed description of the problem or conditions of failure. 

http://www.netscreen.com/support
mailto:techpubs@netscreen.com
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The Technical Assistance Center (TAC) is staffed with highly trained Customer Service 
Engineers ready to provide technical troubleshooting assistance for our integrated 
Internet security appliances and software products. NetScreen's preferred partners and 
authorized partners support the entire product line and should be your first point of 
contact for addressing technical product information. 

International customers are supported by NetScreen's in-country partners. 

Customers without telephone support contracts can purchase support by the hour on a 
major credit card over the phone from 6am to 6pm PT (Pacific Time) weekdays. To 
purchase, please specify part number NS-CS5-001.

Technical Support Availability
Standard Hours: 6:00am to 6:00pm PT (Pacific Time) Monday through Friday.

Premium Hours: 24 hours per day, seven days a week.
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1
Chapter 1

Introduction to Report 
Manager

Welcome to NetScreen-Global PRO Report Manager, the scalable security monitoring and 
reporting tool for NetScreen devices. Use Report Manager to proactively monitor key 
details about your NetScreen security system including the up/down status of your 
NetScreen devices, security-related events, protocol and policy usage trends, and 
performance baselines. You can also use Report Manager to generate reports allowing you 
to further view and analyze information about your NetScreen security deployment.

This chapter provides an introduction to the many benefits and features available in the 
4.0 release of Report Manager. It also includes an overview of the architecture and 
concepts allowing you to better understand how Report Manager works.

Its main sections include:

• Report Manager Overview

• Benefits of Using Report Manager

• New Features in Report Manager 4.0

• How Report Manager Works

• Next Steps
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REPORT MANAGER OVERVIEW
Report Manager is the monitoring and reporting software component for NetScreen-
Global PRO. You can use Report Manager to proactively monitor key details about your 
NetScreen security system including the up/down status of your NetScreen devices, 
security-related events, protocol and policy usage trends, and performance baselines. 
With Report Manager, you can also customize and generate reports to further track and 
analyze device traffic, events, and attack information.

There are three main user interfaces that you will use in Report Manager:

• Report Manager Console

• Monitor Console

• Historical Reports Console

Report Manager Console
The Report Manager Console is the main interface that you will use to add, configure and 
administer your users, devices, and Data Collectors in the Report Manager system.
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Monitor Console
The Monitor Console is the main interface that you will use to monitor your NetScreen 
security deployment. The Monitor Console includes two main windows allowing you an at-
a-glance view of the up/down status of your NetScreen devices as well as event 
summaries. You can also use the Monitor Console to monitor the following in real-time:

• VPN

• NSRP Status

• Events

• Device Statistics such as policy status, protocol status etc...
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Historical Reports Console
The Historical Reports Console is a web-based interface that allows you to generate 
reports from data that is stored in a relational database. You can use a web browser 
(Netscape Navigator 6.0 or higher or Internet Explorer 6.0 or higher) to access the 
Historical Reports Console. Use the Historical Reports Console to customize and generate 
reports related to traffic statistics, alarms, service level agreements, device resource 
statistics and logs.
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BENEFITS OF USING REPORT MANAGER
Report Manager provides the following key benefits:

• Real-Time Monitoring of Your Security Infrastructure

• Historical Reporting

• E-mail Notification of Alerts

• Reliable Data Transfer Using TCP/IP

• Carrier-Class Scalability

• Device Troubleshooting

• Integration With 3rd Party Applications

Real-Time Monitoring of Your Security Infrastructure
Report Manager allows you to monitor all aspects of your NetScreen security deployment 
in real-time.

Tracking Device Status
Through the Monitor Console you can view the up/down status of all your NetScreen 
devices at-a-glance. Report Manager also allows you to configure individual display filters 
allowing you to view a graphical summary of events as they occur on your devices. From 
the graphical view, you can access more detailed information describing those events. You 
can also access additional information describing the distribution of network traffic on 
each device by policy and protocol, event logs, alarms, and system alerts.

Tracking VPN Status
If you are implementing virtual private networks, you can use the Report Manager VPN 
Monitor to view the up/down status of your VPN tunnels at-a-glance. You can also view 
security associations (SAs) related to each VPN tunnel, and other statistics.

Tracking High Availability (HA) Status
If you are implementing NetScreen Redundancy Protocol (NSRP) for the purpose of 
deploying clusters in your NetScreen security system, you can use the NSRP Monitor to 
get an at-a-glance status of your NetScreen systems that are in “clusters.” From this view, 
you can track information related to virtual security devices (VSDs) and run-time objects 
(RTOs) that have been attached to each cluster.
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Historical Reporting
Use the Historical Reports Console to customize and generate reports on historical data. 
You can choose from a selection of over 70 reports to view and analyze alarms, network 
traffic, device and VPN statistics, system resources, logs, and other administrative 
information.

Generating Reports for Service Level Agreements
Use the Historical Reports suite of Service Level Agreement reports to track and validate 
VPN and device uptime/downtime statistics, VPN latency, availability, and total 
throughput.

E-mail Notification of Alerts
Report Manager alerts you of critical events as they occur on your network security 
system. You can also configure Report Manager to send you an e-mail to notify you when 
alerts occur.

Reliable Data Transfer Using TCP/IP
Report Manager uses a TCP/IP based protocol called NetScreen Server Protocol (NSP) to 
ensure reliable data transfer to and from each system component.

Carrier-Class Scalability
Report Manager lets you manage large groups of NetScreen devices by associating each 
device with a scalable Data Collector. Each Data Collector can manage several hundreds 
of NetScreen devices. Simply increase the number of Data Collectors to match the need 
for additional devices.

Fail-Over Support
Report Manager also provides fault management across multiple devices as well as real-
time device statistics for individual NetScreen devices.

Role-Based Administration
Use Report Manager’s advanced configuration management tools to assign privileges to 
your users and administrators according to their specific roles.
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Device Troubleshooting
Report Manager allows you to communicate using Telnet or a Secure Command Shell to 
query on the status of a device. You can use this capability to issue a “get” Telnet 
command to a NetScreen device or a NetScreen CLI command to the SCS (Secure 
Command Shell) on the device to troubleshoot problems.

Integration With 3rd Party Applications
You can further extend Report Manager functionality by integrating it with third party 
tools such as Micromuse Netcool, HP OpenView, and TelAlert.
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NEW FEATURES IN REPORT MANAGER 4.0
Report Manager 4.0 provides the following new features:

• Support for ScreenOS 4.0

• Historical Reports Scheduler

• Extended Attack Status Monitoring and Reporting

• Zone-based Monitoring and Reporting

• Real-time Monitoring of Active Sessions

• VPN Monitoring Enhancements

• Scalability Enhancements

• SNMP Integration

• MS-SQL Database Support

• PostgreSQL Database Support

• Event Archiving

Support for ScreenOS 4.0
Report Manager supports NetScreen devices running the latest version of ScreenOS 4.0.

Historical Reports Scheduler
Report Manager eases the administrative burden of customizing and generating reports 
manually. With the Historical Reports Scheduler, you can now create a report profile to 
save your individual report configuration settings. You can then use these profiles to 
schedule the generation of your reports automatically. You can also configure Report 
Manager to notify you by e-mail when your reports are available to view.

Extended Attack Status Monitoring and Reporting
There are several new reports that you can generate from the Historical Reports Console. 
IDS Counter Reports extend your ability to view and analyze information related to 
network defense and protocol anomalies. Event Count Summary Reports now make it 
easier for you to track the number and frequency of specific events.

Zone-based Monitoring and Reporting
You can now also view all interface-related reports (i.e., Policy Summary, Protocol 
Summary, Ethernet Statistics, Flow Statistics, and Interface Attack reports) based on 
zone information.
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Real-time Monitoring of Active Sessions
There is now an additional view called “Active Sessions” in the Monitor Console Active 
Statistics View. You can use the Active Sessions view to monitor currently active sessions 
on a device at the virtual system level.

VPN Monitoring Enhancements
The Report Manager VPN Monitor now allows you to select and view VPN information 
and statistics according to VPN tunnel. Previous versions of Report Manager only allowed 
you to view VPN status according to device.

Scalability Enhancements
If you require traffic log information, you no longer have to worry about performance 
degradation related to storing traffic logs in a database. Report Manager now allows you 
to store traffic log information to flat files on the Data Collector.

SNMP Integration
Report Manager allows integration with other Simple Network Management Protocol 
(SNMP) monitoring systems. Furthermore, if you are using Report Manager as a proxy for 
your NetScreen devices, Report Manager will support de-duplication of traps as well as 
user-defined mapping of severity levels.

MS-SQL Database Support
Report Manager supports Microsoft SQL Server 2000 allowing you greater flexibility in 
choosing where to store your information.

PostgreSQL Database Support
Report Manager comes bundled with PostgreSQL Server 7.1 providing an out-of-the-box 
low-end repository solution.

Event Archiving
Report Manager allows you to archive unsent event messages in a temporary cache. 
During failover scenarios, Report Manager will flush messages in its temporary cache to 
the next stage server when it becomes available. This prevents any events from being lost 
during periods when the device and Data Collector may become disconnected.
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HOW REPORT MANAGER WORKS
Report Manager is built around a three-tier architecture that consists of the following:

• NetScreen Devices

• Report Manager Server

• Report Manager User Interface

NetScreen Devices
NetScreen devices that you have implemented for firewall, VPN, and bandwidth 
management services provide all the information that you can monitor and generate 
reports on using Report Manager.

NetScreen Devices
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Report Manager Server
The Report Manager server is primarily responsible for collecting and storing all the data 
that is provided by each NetScreen device. There are several components in the Server 
tier that make this possible:

• Data Collector

• Master Controller

• Database

• Historical Reports Server

Data Collector
A Data Collector (DC) is a stand-alone server that collects performance and fault-related 
statistics from each NetScreen device. The Data Collector polls each device periodically to 
obtain device statistics, such as protocol distribution and policy statistics.

The Data Collector is responsible for sending information to the Report Manager Console 
with real-time performance statistics and log data. It also forwards information to the 
Master Controller for storage on the database.

Data Collectors also perform the following additional functions:

• Message consolidation (de-duplication of repeated events and consolidating 
them)

• SNMP integration (trap forwarding to multiple SNMP managers)

DC MC/DB HRS

Report Manager Server

NetScreen Devices
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• Netcool integration (event forwarding to Micromuse's Netcool system)

• TelAlert integration (for alarm management)

• Role based administration

• E-mail event alerts and global message filtering

• Monitor filtering for consoles on specific events or severity levels

Depending upon the size of your NetScreen security system, you may install one or more 
Data Collectors to extend your data collecting ability.

Master Controller
A Master Controller (MC) communicates with the Data Collector(s), the database, and the 
Report Manager Consoles. It is primarily responsible for transferring information to and 
from each Data Collector and the Monitor Console to the database.

Database
Report Manager currently employs a third party relational database as the central 
repository for all device information that is collected by each Data Collector. This provides 
several key benefits:

• Provides an open schema for 3rd party billing infrastructures, reporting tools 
etc.

• Provides built-in capabilities for load balancing, scaling, redundancy and 
failover

• Addresses many common information storage issues such as indexing, data 
management etc.

• Includes tools already available for data mining and database management

• Includes built-in transaction processing

• Includes standard SQL processing/scripting engine for query processing

Report Manager currently supports multiple databases including: Oracle, MS-SQL, and 
PostgreSQL.

Historical Reports Server
The Historical Reports Server is based on Tomcat technology which embeds a web server 
that allows you to access and view data on the main database from any web browser.
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Report Manager User Interface
The Report Manager user interface provides access to device data using various views. 
There are two applications that you will use in Report Manager:

• Report Manager Console

• Historical Reports Console

Report Manager Console
The Report Manager Console includes two interfaces:

• Report Manager Console interface allowing you to configure and administer 
your NetScreen devices for Report Manager, manage Data Collectors, manage 
role-based administrators, and access information on the system’s health.

• Monitor Console interface allowing you to monitor key information about your 
NetScreen devices including the up/down status, as well as the traffic and events 
that are occurring on them.

You can access both the Report Manager Console and the Monitor Console when you 
launch the Report Manager application.

Historical Reports Console
The Historical Reports Console is a web-based interface that allows you to access Report 
Manager data that is stored on the main database. You can use a web browser to access 
the Historical Reports Console. Use the Historical Reports Console to generate reports 
allowing you to analyze network traffic, events, and attacks.
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Report Manager Communications
Report Manager uses a TCP/IP-based communication layer called NetScreen Server 
Protocol (NSP) to transfer data to and from each component.

In addition, Report Manager uses HTTP/HTTPS to transfer data to and from the 
Historical Reports Console and the Historical Reports Server.

Securing Communications
NSP is not an encrypted protocol. To secure the data transfer, it is highly recommended 
that you run a VPN tunnel for each pair of connections. You can secure historical reports 
using HTTPS.

NetScreen Devices

DC MC/DB HRS

Console HRS Console

Report Manager Server

Report Manager User Interface

NSP/IP Sec

NSP/IP Sec

NSP/IP Sec

HTTP/HTTPS
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REPORT MANAGER DATA
The following table lists all the types of data that Report Manager polls from the devices.

The Data Collector will also receive information that is pushed to it from each device 
whenever such information becomes available. The following table lists all the types of 
data that are pushed from the device to Report Manager.

Polled Data Description

Protocol distribution table Statistics collected on a per interface/vsys basis for bytes 
and packets distribution on a per protocol basis.

Policy distribution table Statistics collected on a per policy basis for bytes, packets, 
and number of connections.

Ethernet statistics table Statistics collected for each physical interface.

Flow statistics table Statistics related to flow level counters on a per virtual 
interface basis.

Attack statistics table Statistics collected for all the IDS counters on a per virtual 
interface basis.

VPN Monitoring statistics VPN statistics for each tunnel that includes SA request, 
establishment and teardown times, bytes/packets info, 
availability, latency, users etc.

NSRP monitoring statistics All statistics related to NSRP including VSD and RTO 
data.

Device resources statistics Utilization, memory and session-related statistics for the 
device.

SA Monitor statistics SA statistics and related information used in real-time 
monitoring.

Pushed Data Description

Traffic logs Traffic logs are generated when a session has terminated.

Traffic alarms Traffic alarms are generated based on preset thresholds.

Attack alarms Attack alarms are generated based on preset thresholds or 
configuration.

Event alarms Event alarms are related to VPN tunnel events or device 
events such as fan failure, CPU utilization threshold 
crossed etc.

Configuration logs Any configuration-related event generates a log.

Information logs Information logs are related to VPN/IKE or other events 
that are informational.

Self logs logs of traffic that terminate at the device.
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Device status indicates the up/down status of the device.

Pushed Data Description
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NEXT STEPS
Now that you have reviewed how Report Manager works, you are ready to install, 
configure and use Report Manager.

For more information on... Refer to...

Installing Report Manager Chapter 2

Getting Started Using Report 
Manager

Chapter 3

Configuring Report Manager Chapter 4

Monitoring Real-time information Chapter 5

Generating historical reports Chapter 6

Tuning Report Manager Chapter 7

Troubleshooting Chapter 8

Upgrading from Report Manager 
3.x to 4.0

Chapter 9

Integrating Report Manager with 
3rd party applications

Chapter 10

Configuring Data Collectors for 
failover protection

Chapter 11

Configuring Master Controllers for 
failover protection

Chapter 11
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2
Chapter 2

Installing Report Manager
This chapter contains information that describes how to install and setup an initial 
working Report Manager system. This process includes installing the required software 
for the server components (Master Controller, Data Collector, Historical Reports Server, 
and if applicable, PostgreSQL database); starting each Report Manager component; 
installing the required client software; and configuring Data Collectors, devices, and users 
in Report Manager.

After successful installation, you will be able to get real-time monitoring information and 
historical reports for the devices that you have configured.

This chapter includes the following sections:

• Planning Your Installation

• Gathering Pre-Installation Information

• Hardware and Software Requirements

• Installation Process

• Installing the Database

• Installing the Master Controller

• Creating the Database Schema

• Installing the Data Collector

• Installing the Historical Reports Server

• Installing the Report Manager Console

• Configuring Report Manager For the First Time

• Uninstalling Report Manager
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PLANNING YOUR INSTALLATION
You can design and implement Report Manager to scale to small, medium, and large 
enterprises as well as service provider deployments. Since Report Manager allows 
multiple points of control and administration, you can configure it to operate independent 
of geographical locations.

Work with your NetScreen Professional Services consultant to plan and configure your 
Report Manager installation to work within your specific network environment.

There are several configurations to choose from:

• Typical Configuration (Recommended)

• Minimal Configuration

• Advanced Configuration

Typical Configuration (Recommended)
For most typical configurations, it is recommended that you install each server component 
(Data Collector, Master Controller, Database, Historical Reports Server) on its own 
separate, dedicated computer. The Master Controller can be installed on the same 
computer as the database.

DC MC/DB HRS

NetScreen Devices

Console
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Minimal Configuration
In some cases, you may be able to install the Data Collector on the same computer as the 
Historical Reports Server. This configuration minimizes the hardware required to install 
Report Manager. Review this configuration option with your NetScreen Professional 
Services consultant to see if it may be appropriate for your specific deployment.

Advanced Configuration
In deployments where high availability is required, it is also possible to configure Data 
Collectors and master controllers for failover and optimum load balancing.

Configuring Data Collectors For Failover Protection
To configure Report Manager for failover, you will want to run separate Data Collectors 
on different computers to manage the same set of devices. You can designate one Data 
Collector as the primary Data Collector and another as the secondary Data Collector for 
each device. If the primary Data Collector fails after two unsuccessful attempts, the 

MC/DB

Console

NetScreen Devices

DC/HRS
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device will switch its functions over to the secondary Data Collector. In the background, 
the device will keep trying to communicate with its primary Data Collector. If the primary 
Data Collector becomes available, the device will switch back over. There is a time-out 
period of 30 seconds between each attempt for either Primary or Secondary.

Refer to Configuring Data Collector Failover Protection in Chapter 11 for more 
information on configuring Data Collectors for failover protection.

NetScreen Devices

Primary DC

IP: 10.100.40.111

Secondary DC

IP: 10.100.40.222

If the device’s connection to the Primary Data Collector 
fails, the device will attempt to connect to the Secondary 
Data Collector.
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Configuring Master Controllers For Failover Protection
You can also configure your Master Controllers in failover mode as well. The following is 
an example of an Master Controller failover configuration. This configuration provides 
load balancing as well as failover.

Refer to Configuring Master Controller Failover Protection in Chapter 11 for more 
information on configuring Master Controllers for failover protection.

NetScreen Devices

Primary DC

IP: 10.100.40.111

Secondary DC

IP: 10.100.40.222

1. If the Data Collector connection to the Primary Master Controller 
fails, the Data Collector will attempt to connect to the Secondary Mas-
ter Controller.

Primary MC

IP: 10.100.40.333

Secondary MC

IP: 10.100.40.444
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Scalability
The Report Manager architecture scales to support additional devices. If the need to 
manage additional device groups grows, add additional Data Collectors to manage them 
on separate machines.

NetScreen Devices

DC

DC DC

Add Data Collectors to handle additional device groups.
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Report Manager Services
As you plan your installation, it will help to understand how Report Manager establishes 
connections between each server component. After you have installed each server 
component, you will be able to test the connection between each server component and 
verify that they can communicate with each other.

Data Collector Services
The Data Collector is primarily responsible for gathering data from your NetScreen 
devices. It is also responsible for forwarding this information to the Report Manager 
Console for viewing or to the Master Controller for later storing the data on the database. 
To do this, the Data Collector must act as both a client and a server.

When you first start the Data Collector, it starts two servers - one for the device, and one 
for the Report Manager Console. The Data Collector launches and starts each server by 
instantiating an NSP server object. This in turn sets up a listener port - one on port 15400 
as a TCP service to establish a connection with the device; and one on port 15404 to 
establish a connection with the Report Manager Console. When the service is up, the 
device can connect to it.

The Data Collector also starts a client service to communicate with the Master Controller 
on port 15402. This is to get configuration data from the database.

All ports are factory set and cannot be changed.

The following table lists and describes the key connections between each Report Manager 
server component.

Connection Description Protocol Port

NetScreen Device to Data Collector Device session with Data Collector TCP 15400

Data Collector to Master Controller Data Collector to Master Controller 
session

TCP 15402

Report Manager Console to Master 
Controller

Console to Master Controller 
session

TCP 15403

Report Manager Console to Data 
Collector

Console to Data Collector session TCP 15404
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GATHERING PRE-INSTALLATION INFORMATION
Before installing Report Manager, you will need to identify and define the following 
information:

• Common Installation Variables

• Master Controller Installation Variables

• Historical Reports Server Installation Variables

• Data Collector Installation Variables

• PostgreSQL Database Installation Variables

• Report Manager Console Installation Variables

Common Installation Variables
There are several installation variables that are common to all Report Manager 
components. The following table is provided to help you define information that you will 
need to install all components.

Variable Description Default Value Enter your value

Customer 
Authentication ID

The Customer Authentication ID is a 
customer-specific identification number 
that is used by Report Manager to 
recognize the component parts that are 
similar to each installation. You will need 
to define a Customer Authentication ID 
and make a note of it, as you will need 
this ID to install most of your Report 
Manager components. 
The Customer Authentication ID can be a 
unique password, containing both letters 
and characters. It must however match 
all components of the suite for Report 
Manager to work. The ID that you enter 
will be encrypted and used to 
authenticate each Report Manager 
component.

netscreen

Database Type This is the type of database that you 
intend to use with Report Manager. 
Report Manager currently supports three 
relational databases - Oracle, MS-SQL 
Server 2000 and PostgreSQL.
To specify Oracle, enter “oracle”
To specify MS-SQL, enter “mssql”
To specify PGSQL, enter “pgsql”

oracle
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Master Controller Installation Variables
To install the master controller, you will need to first identify and define basic 
information about the database that you plan to use with Report Manager.

The following table is provided to help you define information that you will need to install 
the Master Controller.

Historical Reports Server Installation Variables
To install the Historical Reports Server, you will need the database information that you 
identified and defined for the Master Controller. You can also customize elements of the 
Historical Reports Console and reports to include your company’s or customer’s logo and 
web site address. To do this, you will need to identify and define the URL and any images 
that you wish to associate with your reports. You will also need to define 7port numbers 
that you want the Historical Reports Server to listen on for secure and non-secure 
communications, and the time interval that you wish the Historical Reports Server to 
timeout sessions.

Database Name This is the unique name of the database. myora (for 
Oracle)

mypg (for 
PGSQL)

No default for 
MS-SQL

Installation Directory This is the path to the directory where you 
will install the Report Manager server 
software.

/opt/NETSglPRO/

Variable Description Default Value Enter your value

Database Port Port number that the database 
listens on for communications.

1521

Database Server IP 
Address

IP Address for the database.

Database User Name Authorized user name in the 
database.

Scott

Database Password Authorized password associated 
with the Database User Name.

tiger

Data Table Space Name of the database table space. USERS

Index Table Space Name of the database table index. INDX

Variable Description Default Value Enter your value



Chapter 2 Installing Report Manager

28 NetScreen-Global PRO Report Manager User’s Guide

The following table is provided to help you define information that you will need to install 
the Historical Reports Server:

Variable Description Default Value Enter your value

Database Port Port number that the database 
listens on for communications.

1521

Database Server IP 
Address

IP Address for the database.

Database Username Authorized user name in the 
database.

Scott

Database Password Authorized password associated 
with the Database User Name.

tiger

Report Title Image Directory path to the image that 
you want displayed on your 
specific Historical Reports 
Console.

images/
yourCompany 

Logo.jpg

Report Title URL URL that you want linked to the 
Report Title Image.

www.netscreen.com

HTTP Port Non-secure port that the Historical 
Reports Server listens on.

8080

HTTPS Port Secure port that the Historical 
Reports Server listens on.

8443

Session Timeout Amount of time (in seconds) that 
the Historical Reports Server will 
wait before timing out individual 
sessions.

30 minutes

Historical Reports 
Server IP

IP address for the Historical 
Reports Server.

SMTP Server IP IP address of the Simple Mail 
Transfer Protocol (SMTP) Server.

Sender’s Email Address E-mail address used to send 
notifications of completed 
Historical Reports profile tasks.

Disk Space for Reports 
in MB

Amount of disk space (in MB) 
allocated for Historical Reports 
profiles.
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Data Collector Installation Variables
To install the Data Collector, you will need to identify the IP address for the Master 
Controller to which you want it assigned, and define a directory location for your Data 
Collector log files.

The following table is provided to help you define information that you will need to install 
the Data Collector.

PostgreSQL Database Installation Variables
To install the PostgreSQL database, you will need to define basic variables for your 
database.

The following table is provided to help you define information that you will need to install 
the PostgreSQL database.

Report Manager Console Installation Variables
To install the Report Manager Console, you will need the IP address for the Master 
Controller that you defined when you installed the Data Collector.

Variable Description Default Value Enter your value

Master Controller IP 
Address

IP Address of the Master Controller 
that you want to assign this Data 
Collector.

N/A

Device Logfile Path Directory path where you want 
Report Manager to store device log 
files.

/opt/NETSglPRO/
devlog

Variable Description Default Value Enter your value

Master Controller IP 
Address

IP Address of the Master Controller 
that you want to assign the 
database.

N/A

Database Name This is the unique name of the 
database.

mypg

Database Username Authorized user name in the 
database.

prouser

Database Password Authorized password associated 
with the Database User Name.

netscreen
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HARDWARE AND SOFTWARE REQUIREMENTS
Use the following hardware and software requirements to identify the computers on 
which you plan to install each Report Manager component. Before you begin the process of 
installing your Report Manager components, you must verify that each computer meets 
minimum system requirements.

Hardware Requirements
The following minimum hardware requirements must be met for each server component.

Note: If you are installing multiple components on the same computer, you must ensure 
that the computer meets the total (added-up) requirements for each component. For 
example, if you plan on installing the Data Collector and Historical Reports Server on the 
same computer, you will need to ensure that there is a minimum of 512 MB of RAM on the 
computer (256 MB for the Data Collector plus 256 MB for the Historical Reports Server).

Component Hardware Requirements

Oracle/MS-SQL Database Refer to the manufacturer’s minimum hardware requirements 
included for each specific software package.

PostgreSQL Database Sun Microsystems SPARC IIi 400 MHz (or higher)
256 MB RAM
8 GB disk space (minimum)
Database partition of at least 5.0 GB
1 GB swap space on the system (recommended)

Master Controller Sun Microsystems SPARC IIi 400 MHz (or higher)
256 MB RAM
200 MB disk space (minimum)
1 GB swap space on the system (recommended)

Data Collector Sun Microsystems SPARC IIi 400 MHz (or higher)
256 MB RAM
3 MB per device
1 GB swap space on the system (recommended)
200 MB disk space (minimum)*

* Additional disk space required if storing traffic logs to disk (10 MB 
per log file)

Historical Reports Server Sun Microsystems SPARC IIi 400 MHz (or faster)
256 MB RAM
1 GB disk space (minimum)

Report Manager Console IBM-compatible PC
256 MB RAM
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Software Requirements
The following software requirements must be met for each Report Manager component.

Component Software Requirements

All server components 
- Data Collector
- Master Controller
- Database
- Historical Reports Server

Solaris 8 or 9 operating system
Perl (optional: if you want the Data Collector to run traffic log queries)

Report Manager Console Microsoft Windows 2000 with Service Pack 1 or
Microsoft Windows NT 4.0 Workstation or Server with Service Pack 6a

Historical Reports Console Internet Explorer version 6.0 or higher (required)
Netscape Navigator version 6.0 or higher (required))

NetScreen device NetScreen-OS 2.6.0 or higher
NetScreen-OS 4.0 (recommended)
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INSTALLATION PROCESS
The process of installing Report Manager includes the following steps. For typical 
installations, you can expect to complete each step in the amount of time suggested. These 
times however, may vary for each installation:

Installation CD Contents
Report Manager contains three installation CDs: one for the documentation, one for the 
server components (for Solaris) and one for the client software (for Windows).

The server component installation CD includes the following files:

• PGinstall.bin - this is the installer file that is used to install the PostgreSQL 
relational database.

• PROinstall.bin - this is the installer file that is used to install the Report 
Manager server components including the Master Controller, Data Collector, 
and Historical Reports Server.

• PROupgrade.bin - this is the installer file that is used to upgrade existing 
Report Manager v3.x server components to v4.0.

The client installation CD includes the following file:

• RM_client_setup.exe - this is the installer file that is used to install the Report 
Manager client component including Crystal Reports templates. It is also used 
to upgrade an existing Report Manager v3.x client and Crystal Report templates 
to v4.0.

Step Description Expected time to complete

1 Install the PostgreSQL database (if applicable). If you 
are using Oracle or MS-SQL server, verify that the 
database is running.

10 min.

2 Install the Master Controller. Installing the Master 
Controller generates SQL scripts that are required to 
create and initialize the database schema.

10 min.

3 Create the database schema by running the SQL 
scripts on the database computer.

10 min.

4 Install the remainder of the Report Manager server 
software components including Data Collectors and the 
Historical Reports Server.

10 min.

5 Install the Report Manager Console software. Start the 
Report Manager Console.

5 min.

6 Add and configure your Data Collectors and devices in 
the Report Manager system.

Will vary depending upon the 
number of Data Collectors and 

devices you have.
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INSTALLING THE DATABASE
Report Manager supports the following relational databases:

• Oracle

• MS-SQL

• PostgreSQL

If you plan to run Oracle or MS-SQL server with Report Manager, refer to the 
documentation included with your specific database for more information on how to 
install the database.

Installing Required JDBC Driver For MS-SQL
If you are using MS-SQL server with Report Manager, you will need to download the SQL 
Server 2000 Driver for JDBC. This driver file is available on the Internet from the 
Microsoft web site. It is required to allow you to gain JDBC access to the SQL Server 2000 
from Report Manager.

1. From a UNIX machine (preferably the computer where you have installed the 
Master Controller), launch a web browser and navigate to the Microsoft 
corporate web site downloads page. The URL is: http://www.microsoft.com/sql/
downloads/default.asp.

2. Click on the hyperlink provided to Download the SQL Server 2000 Driver for 
JDBC. This will take you to the Microsoft SQL Server 2000 Driver for JDBC 
download page.

3. Click to specify that you want to download the UNIX (English) version of the 
driver. A web page dialog for the MSDN Online Code Center will appear. It will 
prompt you to accept the terms of the License Agreement.
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4. Click Yes to accept the terms of the License Agreement and continue. The file 
download process will begin. A dialog will appear prompting you to either Open 
or Save the file to your computer. Click to Save the file to your computer. This 
will download a tar file called mssqlserver.tar to your computer.

5. Create a new temporary directory (i.e., temp1), and move the mssqlserver.tar 
file to that directory.

6. From the temporary directory, run the following commands:

tar xvf mssqlserver.tar

ksh install.ksh

7. Follow the instructions to complete. When prompted for the installation 
directory, enter <temp2>. Temp2 is the name of an additional temporary 
directory that has not yet been created. The JDBC driver files will be saved in a 
subdirectory called lib in this temporary directory.

8. Change directories to the lib subdirectory in the new temporary directory (i.e., 
cd <temp2>/lib). The JDBC driver files will appear as follows: 

msbase.jar

mssqlserver.jar

msutil.jar

9. Transfer all the jar files to the classes subdirectory in the Report Manager 
installation directory (i.e., <RM_INSTALL_DIR>/classes) on the computer 
where you have installed the Master Controller computer (if you are not already 
on the Master Controller computer).
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Installing the PostgreSQL Database
Report Manager includes PostgreSQL 7.1. If you are not running Oracle or MS-SQL 
Server, you can install the PostgreSQL database for Report Manager.

1. Ensure that you are logged on to the server computer using an account with the 
appropriate privileges.

2. Insert the NetScreen-Global PRO Report Manager installation CD that contains the 
PostgreSQL database software.

3. If you wish to install the PostgreSQL database using the graphical user 
interface, enter the following command at the prompt:

./PGinstall.bin
The installer will launch and guide you through the installation process.

If you wish to install the PostgreSQL database in Console Mode, enter the 
following command at the prompt:

./PGinstall.bin -i console

Note: You can expect the process of installing the PostgreSQL database to take 
approximately 10 minutes. Note that this is the actual time to complete the task of running 
the PostgreSQL installer. It does not include any other time required to prepare or plan 
your actual deployment of Report Manager.

Note: You must run the PostgreSQL installer as a non-root user.
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4. Review the Installation Introduction screen, then click Next to continue. If you 
are in Console Mode, press [Enter] to continue.

The installer displays the Report Manager software License Agreement.
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5. Review the License Agreement, and if you accept the terms, click in the 
checkbox indicating that you accept the terms of the License Agreement. Click 
Next to continue. If you are in Console Mode, you may need to press [Enter] 
several times to read the entire License Agreement. Press [Y] to accept the 
terms of the License Agreement to continue.

The installer displays a screen with Important Information related to the 
installation procedure.

6. Review the information and click Next to continue. If you are in Console Mode, 
press [Enter] to continue.
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The installer will prompt you to specify an installation directory. The installer 
will create a subdirectory tree for “<user_home_dir>/pgsql” by default.

7. Select the default location or click Choose... to browse to a different location. 
Click Install to continue. If you are in Console Mode, press [Enter] to select 
the default installation directory or enter an absolute path to the directory 
where you wish to install.

Note: Verify that you have the appropriate write privileges to the installation 
directory.
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The installer will perform a check to ensure that you are not the root user. If you 
are the root user, an error message will appear indicating that you must not be 
the root user to run the PostgreSQL installer, and the installer will exit.

The installer next performs a check for required system parameters. If the 
parameters do not exist, a dialog will appear indicating that:

"System parameter settings for shared memory and 
semaphore are required. Please run <install>/scripts/
pgsql/setSem.pl script as root user, and then reboot the 
system."

If you receive this message, you will need to run the setSem.pl script manually 
as root. This will invoke the following:

set shmsys:shminfo_shmmax=4294967295
set shmsys:shminfo_shmmin=1
set shmsys:shminfo_shmmni=100
set shmsys:shminfo_shmseg=10
set semsys:seminfo_semmni=100
set semsys:seminfo_semmsl=100
set semsys:seminfo_semmns=200
set semsys:seminfo_semopm=100
set semsys:seminfo_semvmx=32767

After the script runs, reboot the computer, and then run the PostgreSQL 
installer again.
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If the required system parameters do exist, the installer next displays the 
PostgreSQL License Agreement.

8. Review the License Agreement, and if you accept the terms, click in the 
checkbox indicating that you accept the terms of the License Agreement. Click 
Next to continue. If you are in Console Mode, you may need to press [Enter] 
several times to read the entire License Agreement. Press [Y] to accept the 
terms of the License Agreement to continue.

The installer next prompts you to enter database information required to install 
the PostgreSQL database.

9. Enter the following information:

• Database Name - specify a database name. This name must match the 
database name that you provided when installing the Master Controller.

• Database User Name - specify the authorized database user name. The 
default database username is “prouser”.

• Database Password - specify the password for the authorized database 
user. The default database password is “netscreen”.

Note: The database port number is factory set to 5432 by default. It is not 
configurable.
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Click Next to continue. If you are in Console Mode, press [Enter] to continue.

In console mode, the configuration screen appears as follows:

The installer will proceed to create the database schema, initialize the database 
by populating the data tables, and start the database automatically.

Note: The process of creating and initializing the database schema may take 
approximately 5 to 10 minutes.
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When finished, the installer displays a screen indicating that the installation 
process is complete.

Starting the PostgreSQL Database
After installing the PostgreSQL database, the database will start automatically. If you 
want to start the PostgreSQL database manually:

1. Navigate to the startup subdirectory in the Report Manager installation 
directory:

<install directory>/pgsql/startup

2. Run the PostgreSQL database start command:

% glproPG start 

3. If you want the PostgreSQL database to start automatically when the system 
reboots, enter run_control_pg.sh from the scripts subdirectory in the 
Report Manager installation directory. For example, you would run the following 
commands:

<install directory>/scripts/run_control_pg.sh

Note: You must run this command as a super user.
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Securing Access to the Database
Once you have installed the PostgreSQL database, you will want to secure access to it. To 
do this, you will need to edit a parameter in the PostgreSQL database configuration file.

1. Navigate to the /pgsql/data subdirectory located in installation directory of 
the computer where you installed the PostgreSQL database. For example, you 
would navigate to:

<install_dir>/pgsql/data

2. Open the pg_hba.conf file in any text editor.

3. Comment out the host parameter by adding a “#” sign before the entry. For 
example, the parameter would appear as follows:

#host <database name> <host IP address> <net mask> 
password

4. For each machine that you want to allow access to the database, add the IP 
address of the machine using the host parameter. For example, if you only 
wanted to allow a computer with an IP address of 10.192.00.123 to the database, 
you would enter the following:

host mypg 10.190.00.123 255.255.255.255 password

5. Save the file when you are done editing.

6. Restart the database for your changes to take effect.

Editing the Database IP Address
If for any reason you need to edit the database IP Address:

1. Stop the Master Controller.

2. Edit the db.ip.addr parameter with the new IP Address in the pro.mc.init 
file on the Master Controller machine

3. Restart the Master Controller.

4. If you are running Oracle with Report Manager, you will also need to edit the 
Net8 service created on the machine running IIS / Crystal Report. You can do 
this by first starting the Net8 Assistant. In the Net8 Assistant, highlight the 
Net8 service that you created. In the Address Configuration's "Host Name" edit 
box, change the value to the new IPaddress of the Oracle database machine. 
Save your changes.



Chapter 2 Installing Report Manager

44 NetScreen-Global PRO Report Manager User’s Guide

INSTALLING THE MASTER CONTROLLER
It is recommended that you install the Master Controller on the same computer that you 
are running the database for Report Manager. During the installation of the Master 
Controller, the installer uses the data that you enter to generate several SQL scripts. You 
will need to run these scripts against the database to create the database schema.

You can install the Master Controller using the Graphical User Interface-based installer 
or from the Shell Command Line using Console Mode.

Installing the Master Controller Software
1. Ensure that you are logged on to the server computer using an account with the 

appropriate privileges.

2. Insert the NetScreen-Global PRO Report Manager installation CD that contains the 
server components. The CD will mount automatically as /cdrom/
PROinstall.bin.

To mount the CD manually, enter the following command: 

mount -o ro -F hsfs /dev/dsk/device /cdrom

</dev/dsk/device> is the CD-ROM drive device entry

3. If you wish to install Report Manager using the graphical user interface, enter 
the following command at the prompt:

./PROinstall.bin
The installer will launch and guide you through the installation process.

If you wish to install Report Manager in Console Mode, enter the following 
command at the prompt:

./PROinstall.bin -i console

Note: You can expect the process of installing the Master Controller to take approximately 
10 minutes. Note that this is the actual time to complete the task of running the installer to 
install the Master Controller. It does not include any other time required to prepare or plan 
your actual deployment of Report Manager.

Note: To view the complete contents of the CD, issue an “ls” command.



Installing the Master Controller

NetScreen-Global PRO 45

4. Review the Installation Introduction screen, then click Next to continue. If you 
are in Console Mode, press [Enter] to continue.

The installer displays the Report Manager software License Agreement.

5. Review the License Agreement, and if you accept the terms, click in the 
checkbox indicating that you accept the terms of the License Agreement. Click 
Next to continue. If you are in Console Mode, you may need to press [Enter] 
several times to read the entire License Agreement. Press [Y] to accept the 
terms of the License Agreement to continue.
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The installer displays a screen with Important Information related to the 
installation procedure.

6. Review the information and click Next to continue. If you are in Console Mode, 
press [Enter] to continue.

The installer will prompt you to specify an installation directory. The installer 
will create a subdirectory tree including subdirectories for “opt” and 
“NETSglPRO” (i.e., /opt/NETSglPRO) by default.
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7. Select the default location or click Choose... to browse to a different location. 
Click Install to continue. If you are in Console Mode, press [Enter] to select 
the default installation directory or enter an absolute path to the directory 
where you wish to install.

The installer displays a screen prompting you to select which server components 
you wish to install.

8. Use the Feature Set pull-down menu and select Master Controller. Click 
Install to continue.

Note: Verify that you have the appropriate write privileges to the installation 
directory.
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If you are in Console Mode, enter 1 to install the Master Controller, then press 
[Enter] to continue.

You can monitor the progress via the task bar at the bottom of the screen. When 
finished, the installer prompts you to enter database information required to run 
the Master Controller.
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9. Enter the following information:

• Database Type - use the pull-down menu and specify a database type (i.e., 
ORACLE for Oracle, MSSQL for MS-SQL or PGSQL for PostgreSQL). The 
default database type is “ORACLE”.

• Database Name - specify a database name. The default database name is 
“myora”.

• Database Port - specify the database port number for the database listener. 
The default database port number is 1521.

• Database Server IP Address - specify an IP Address for the database 
server.

• Database Username - specify the authorized database user name. The 
default database username is “Scott”.

• Database Password - specify the password for the authorized database 
user. The default database username is “tiger”.

• Customer Authentication ID - Create a Customer Authentication ID and 
make a note of it, as you will need to enter the same ID in the Customer 
Authentication ID field during the installation of other Report Manager 
components.

10. Click Next to continue. If you are in Console Mode, press [Enter] to continue. 
The installer checks to ensure that you have entered a valid database type and 
Database Server IP address. If you have incorrectly entered either value, the 
installer will prompt you to re-enter them.

11. If you specified Oracle as the database type, you will need to enter the following 
information:

• Data Table Space - specify the data table space. The default data table 
space is “USERS”.

• Index Table Space - specify the index table space. The default index table 
space is “INDX”.

Note: If you are using a database other than Oracle, you may need to edit the 
Database Username value.

Note: If you are using a database other than Oracle, you may need to edit the 
Database Password value.
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The installer displays a screen indicating that the installation process for the 
Master Controller is done.

12. Click Done to exit the installer. If you are in Console Mode, press [Enter] to 
exit.
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CREATING THE DATABASE SCHEMA
As mentioned previously, the Report Manager installer generates several SQL scripts 
using data that you entered during installation of the Master Controller. You will need 
these scripts to create the database schema if you are running Oracle or MS-SQL.

Verifying That the Scripts are on the Database Computer
If you installed the Master Controller on a different computer as the database (i.e., if you 
are using MS-SQL server), you will need to first transfer the SQL scripts from the 
appropriate scripts subdirectory on the computer where you installed the Master 
Controller, to the Report Manager installation directory on the computer where you have 
installed your database. Once this is done, you can run the scripts against the database to 
create the database schema. The process of running the database schema scripts depends 
on the type of database that you are running with Report Manager.

If you are running Oracle
1. Start the database and verify that it is running. Refer to the documentation 

included with your specific database for more information on how to start the 
database.

2. Navigate to the scripts subdirectory in the installation directory.

3. Run the following .sql scripts in order:

glpro_orcl_create_user.sql

This is required only if you have not already created the database username and 
password.

glpro_orcl_create_table.sql

glpro_orcl_create_constraint.sql

glpro_orcl_init_table.sql

For example, you would run the following command:

sqlplus -s system/manager < glpro_orcl_create_table.sql

Note: If you installed the PostgreSQL database, the database schema is created 
automatically.
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If you are running MS-SQL Server
1. Use the SQL Server Enterprise Manager to create a specific database for Report 

Manager (i.e., "gprodb").

2. Create a user for Report Manager. Configure this user to use SQL Server 
Authentication, and create a password for the user.

3. Assign the user to the database you created (i.e., "gprodb").

4. Grant all database permissions to the user.
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5. Use the MS SQL Server Query Analyzer to check and then run the following 
scripts in order to create the database schema:

glpro_mssql_create_table.sql

glpro_mssql_create_constraint.sql

glpro_mssql_create_function.sql

glpro_mssql_init_table.sql

Starting the Master Controller
1. Navigate to the startup subdirectory in the Report Manager installation 

directory:

<install directory>/startup

2. Run the Master Controller start command:

% glproMC start

3. If you want the Master Controller to start automatically when the system 
reboots, enter run_control_mc.sh from the scripts subdirectory in the 
Report Manager installation directory. For example, you would run the following 
commands:

<install directory>/scripts/run_control_mc.sh

Verifying that the Master Controller Can Connect to the 
Database
Verify that the Master Controller can connect to the database by sending a ping to 
database IP address.

Testing the Master Controller
Run the glproMC test command to verify whether or not you can establish a connection 
to the database from the Master Controller.

1. Navigate to the startup subdirectory in the Report Manager installation 
directory

2. Run the glproMC test command:

<install_directory>/startup/glproMC test

Note: You can disregard any error message that indicates that the script “cannot 
drop a specific function, because it does not exist in the system catalog.”

Note: You must run this command as a super user.
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A message will appear indicating whether the connection is set and if 
authentication has succeeded. If successful, you will receive the following 
message:

Troubleshooting Failed Tests
The following table describes how you can troubleshoot common errors that you may 
experience testing the Master Controller.

Editing the Master Controller IP Address
If for any reason you need to edit the IP address for the Master Controller:

If you have already started your data collectors, use the Report Manager console to 
reconfigure the Master Controller IP Address in Report Manager. Refer to the section 
describing how to configure the Master Controller IP Address in Chapter 4 for more 
information.

If you have not yet started your data collectors, edit the mc.ip.addr and 
mc.secondary.ip.addr in the pro.dc.init file.

Test results:

Db connection status: Passed

Db schema initialization check: Passed

Db schema version check: Passed (Version: CCG0ac)

Test results: Probable Causes

DB connection status: Failed The database login id or password is incorrect.
The database is unreachable.
The database server is not running.
Troubleshooting Tip: Verify that all database 
properties (db.user.id and db.passwd) are 
configured correctly in the Master Controller 
initialization file (pro.mc.init). You should also try 
to ping the database server to verify the 
connection.

Db connection status: Passed

Db schema initialization check: 
Failed

The SQL scripts required to create the database 
schema have not been run against the database.
Troubleshooting Tip: Run the "sql" scripts that 
were generated as part of Master Controller 
installation on the database. 
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INSTALLING THE DATA COLLECTOR
After you have installed the Master Controller and created the database schema, you can 
proceed to install your Data Collectors. It is recommended that you install each Data 
Collector on a dedicated computer.

Installing the Data Collector Software
1. Ensure that you are logged on to the server computer using an account with the 

appropriate privileges.

2. Follow the same procedures described to run the Report Manager installer on 
the computer that you wish to install the Data Collector. When the installer 
displays the screen prompting you to select which server components you wish to 
install, use the Feature Set pull-down menu and select Data Collector. You can 
also click on the Data Collector checkbox. Click Install to continue.

If you are in Console Mode, enter 2 to install the Data Collector, then press 
[Enter] to continue.

You can monitor the progress via the task bar at the bottom of the screen. When 
finished, the installer prompts you to enter information required to run the Data 
Collector.

Note: You can expect the process of installing the Data Collector to take approximately 10 
minutes. Note that this is the actual time to complete the task of running the installer to 
install the Data Collector. It does not include any other time required to prepare or plan 
your actual deployment of Report Manager.
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3. Enter the following information:

• Master Controller IP Address - specify an IP address for the Master 
Controller.

• Device Logfile Path - specify the directory location where you want to 
store log files for the Data Collector. The default device log file path is 
“<install directory>/devlog”.

• Customer Authentication ID - enter the same Customer Authentication 
ID that you provided during installation of the Master Controller.

4. Click Next to continue. If you are in Console Mode, press [Enter] to continue.

The installer displays a screen indicating that the installation process is 
complete.

5. Click Done to exit the installer. If you are in Console Mode, press [Enter] to 
exit.

Starting the Data Collector
1. Navigate to the startup subdirectory in the Report Manager installation 

directory:

<install directory>/startup

2. Run the Data Collector start command:
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% glproDC start

3. If you want the Data Collector to start automatically when the system reboots, 
enter run_control_dc.sh from the scripts subdirectory in the Report 
Manager installation directory. For example, you would run the following 
commands:

<install directory>/scripts/run_control_dc.sh

Testing the Data Collector
Run the test command to verify whether or not you can establish a connection to the 
Master Controller from the Data Collector.

1. Navigate to the startup subdirectory in the Report Manager installation 
directory on the computer where you have installed the Master Controller.

2. Run the glproDC test command. For example, you would enter the following 
command:

<install_directory>/startup/glproDC test

A message will appear indicating whether the connection is set and if 
authentication has succeeded. If successful, you will receive the following 
message:

Troubleshooting Failed Tests
The following table describes how you can troubleshoot common errors that you may 
experience testing the Data Collector.

Note: You must run this command as a super user.

Test results:

MC connection status: Passed

MC authentication status: Passed

DC in Report Manager Database: Yes

Test results: Probable Cause

Test results:

MC connection status: Passed

MC authentication status: 
Failed

The Customer Authentication Id provided during the 
Master Controller install does not match the ID 
provided during the Data Collector install.
Troubleshooting Tip: Verify that all properties 
(pro.customer.authenticate) are configured correctly in 
the Data Collector initialization file (pro.dc.init).
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Disabling DNS Lookup (Optional)
The Data Collector performs a reverse DNS lookup for socket connections. If you have a 
fast DNS server, the Data Collector resolves reverse DNS lookups without issue. Slow 
DNS response can however, cause intermittent device connection problems. To resolve 
this issue, it is recommended that you disable DNS lookup on the Data Collector 
computer.

To disable DNS lookup:

1. Locate the /etc/nsswitch.conf file.

2. Open the file in a text editor on Solaris. If DNS is enabled for name resolution, 
you will see an entry for hosts. For example, the entry would appear as follows:

hosts: files dns

3. Remove the "dns" value from this line.

4. Save the file.

Test results:

MC connection status: Passed

MC authentication status: 
Passed

DC in Report Manager Database: 
No

The Data Collector has not yet been added to the 
Report Manager system.
Troubleshooting Tip: Launch Report Manager and 
verify if the Data Collector has been added to the 
Report Manager system. If not, add the Data Collector, 
and re-run the test.

Test results:

MC connection status: Failed 
(timeout)

The Master Controller is not running or the Master 
Controller’s network address is unreachable.
Troubleshooting Tip: Launch the Master Controller 
by running “glproMC start” from the startup directory.

Test results: Probable Cause
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INSTALLING THE HISTORICAL REPORTS SERVER
It is recommended that you install the Historical Reports Server on a dedicated computer.

Installing the Historical Reports Server Software
1. Log into the computer that you want to install the Historical Reports Server as 

the root user.

2. Follow the same procedures described to run the Report Manager installer on 
the computer that you wish to install the Historical Reports Server. When the 
installer displays the screen prompting you to select which server components 
you wish to install, use the Feature Set pull-down menu and select Historical 
Reports Server. You can also click on the Historical Reports Server checkbox. 
Click Install to continue.

Note: You can expect the process of installing the Historical Reports Server to take 
approximately 10 minutes. Note that this is the actual time to complete the task of running 
the installer to install the Historical Reports Server. It does not include any other time 
required to prepare or plan your actual deployment of Report Manager.
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If you are in Console Mode, enter 3 to install the Historical Reports Server, then 
press [Enter] to continue.

You can monitor the progress via the task bar at the bottom of the screen. When 
finished, the installer prompts you to enter information required to run the 
Historical Reports Server.
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3. Enter the following information:

• Database Type - specify the type of database that you intend to use with 
Report Manager (i.e., ORACLE for Oracle, MSSQL for MS-SQL, or PGSQL 
for PostgreSQL). The default database type is Oracle.

• Database Name - specify a database name. The default database name is 
“myora”.

• Database Port - specify the database port number for the database listener. 
The default database port number is 1521.

• Database Server IP Address - specify an IP Address for the database 
server.

• Database Username - specify the authorized database user name. The 
default database username is “Scott”.

• Database Password - specify the password for the authorized database 
user. The default database username is “tiger”.

Note: If you are using a database other than Oracle, you may need to edit the 
Database Username value.

Note: If you are using a database other than Oracle, you may need to edit the 
Database Password value.
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4. Click Next to continue. If you are in Console Mode, press [Enter] to continue. 
The installer checks to ensure that you have entered a valid database type and 
Database Server IP address. If you have incorrectly entered either value, the 
installer will prompt you to re-enter them. If there are no errors, the installer 
prompts you to enter additional information required to run the Historical 
Reports Server.

5. Enter the following information:

• Report Title Image - edit the directory location in which you have stored 
an image file (i.e., company logo) that you wish to appear with the Historical 
Reports Console. This image will appear on any and all historical reports 
generated by NetScreen-Global PRO Historical Reports. The default 
directory location is “...images/yourCompanysLogo.jpg”.

• Report Title URL - edit the URL to specify a link (i.e., your company’s web 
site) for the report title image. When users click on the report title image, 
they will be taken to the link that you have configured in a separate browser 
window. The default path is “www.netscreen.com”

• HTTP Port - enter the HTTP port number for communicating with the 
report server over a non-secure connection. The default port number is 8080. 
Click in the Disable checkbox to disable connections over HTTP.

Note: You can also customize the banner by editing the pro.report.init file.
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• HTTPS Port - enter the HTTPS port number for communicating with the 
report server over a secure connection. The default HTTPS port number is 
8443. Click in the Disable checkbox to disable connections over HTTPS.

• Session Timeout - enter the time that you want the Historical Reports 
Console to time out on your browser. The Console will timeout after 30 
minutes by default. To disable time-out for all sessions, set a value of “-1”. If 
you are in console mode, enter “-1” to disable HTTP, HTTPS and session 
timeout respectively. 

6. Click Next to continue. If you are in Console Mode, press [Enter] to continue. 
The installer prompts you to enter additional information required to run the 
Historical Reports Server.

7. Enter the following information:

• Historical Reports Server IP - enter the IP address of the Master 
Controller running the Report Server.

• SMTP Server IP- enter the IP address for the SMTP server.

• Sender’s Email Address - enter the e-mail address for the scheduler.

Warning: Do not click both Disable checkbox for the HTTP and HTTPS ports. 
This will effectively disable access to the Historical Reports Console.
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• Disk Space for Reports in MB- enter the amount of disk space you would 
like to allot for the scheduler.

8. Click Next to continue. If you are in Console Mode, press [Enter] to continue.

The installer generates the files required to start the services, and then displays 
a screen indicating that the installation is complete.

9. Click Done to exit the installer. If you are in Console Mode, press [Enter] to 
exit.
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Configuring a Secure Connection to the Historical 
Reports Server (Optional)

You can allow your users access to the Historical Reports Server over either a non-secure 
connection (by specifying the HTTP Port during installation) or a secure connection (by 
specifying the HTTPS port during installation). If you have configured the Historical 
Reports Server to support secure connections, the server uses a dummy default certificate.

To replace the certificate:

1. Create a certificate “keystore” by executing the following command:

<INSTALL_DIR>/jre/bin/keytool -genkey -alias tomcat -keyalg 
RSA -keystore ./mykeystore -keypass 'yourPassword' -storepass 
'yourPassword' -dname "cn=reportserver.netscreen.com, ou=eng, 
o=NetScreen, l=Sunnyvale, st=California, c=US"

2. Replace “yourPassword” with a user-defined password.

3. Replace the “distinguish name” (dname) with a user-defined name: 

cn=reportserver.netscreen.com, ou=eng, o=NetScreen, 
l=Sunnyvale, st=California, c=US

4. Create a local Certificate Signing Request (CSR):

<INSTALL_DIR>/jre/bin/keytool -certreq -alias tomcat -keyalg 
RSA -keystore ./mykeystore -file certreq.csr -storepass 
'yourPassword'

5. Apply for a certificate from your certificate authority (CA), using the CSR that 
you generated. This is the “certreq.csr” file.

Installing the Certificate
To install a certificate on the server.

1. Install the certificate reply from the CA.

<INSTALL_DIR>/jre/bin/keytool -import -alias root -keystore ./
mykeystore -trustcacerts -file ./getcacert.cer -storepass 
'yourPassword'

Note: The password to -keypass and -storepass must be the same.

Note: cn refers to the common name that you use to access your report server.

Note: It may take a few days to receive your certificate.
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<INSTALL_DIR>/jre/bin/keytool -import -alias tomcat -keystore 
./mykeystore -trustcacerts -file ./yourcert.cer -storepass 
'yourPassword'

2. Copy the new keystore to the server using the following command:

cp ./mykeystore <INSTALL_DIR>/reportServer/.keystore

3. Update the server to use the password for the keystore by editing the following 
file:

<INSTALL_DIR>/reportServer/conf/server.xml

4. Replace the following line: keystorePass="changeit" with 
keystorePass="yourPassword", where 'yourPassword' is your own 
password to the keystore.

5. Restart the Historical Reports Server for the changes to take effect.

Starting the Historical Reports Server
1. Log into the computer that you want to install the Historical Reports Server as 

the root user.

2. Navigate to the startup subdirectory in the Report Manager installation 
directory:

<install directory>/startup

3. Run the Historical Reports Server start command:

% glproRS start

4. If you want the Historical Reports Server to start automatically when the 
system reboots, enter run_control_rs.sh from the scripts subdirectory in 
the Report Manager installation directory. For example, you would run the 
following commands:

<install directory>/scripts run_control_rs.sh

Testing the Historical Reports Server
Run the test command to verify that the Historical Reports Server is functioning properly.

Note:  The ./getcacert.cer is a chain certificate that you download from your 
certificate authority. You can obtain your certificate by replacing ./
yourcert.cer in the above instructions with the file containing the certificate 
reply from the certificate authority.

Note: You must run this command as a super user.



Installing the Historical Reports Server

NetScreen-Global PRO 67

1. Navigate to the startup subdirectory in the Report Manager installation 
directory

2. Run the glproRS test command:

<install_directory>/startup/glproRS test

If successful, you will receive the following message:

Troubleshooting Failed Tests
A typical error message that you may receive when testing the Historical Reports Server 
is as follows:

Start report server....
Catalina.start: LifecycleException:  null.open:  
java.net.BindException: Address already in use:8080
LifecycleException:  null.open:  java.net.BindException: 
Address already in use:8080
at org.apache.catalina.connector.http.HttpConnector.initialize 
(HttpConnector.java:1130)
at org.apache.catalina.core.StandardService.initialize 
(StandardService.java:454)
at org.apache.catalina.core.StandardServer.initialize 
(StandardServer.java:553)
at org.apache.catalina.startup.Catalina.start 
(Catalina.java:780)
at org.apache.catalina.startup.Catalina.execute 
(Catalina.java:681)
at org.apache.catalina.startup.Catalina.process 
(Catalina.java:179)
at sun.reflect.NativeMethodAccessorImpl.invoke0 (Native 
Method)
at sun.reflect.NativeMethodAccessorImpl.invoke 
(NativeMethodAccessorImpl.java:39)
at sun.reflect.DelegatingMethodAccessorImpl.invoke 
(DelegatingMethodAccessorImpl.java:25)
at java.lang.reflect.Method.invoke(Method.java:324)
at org.apache.catalina.startup.Bootstrap.main 
(Bootstrap.java:243)

Start report server....

Starting service Tomcat-Standalone

Apache Tomcat/4.0.3

Starting service Tomcat-Apache

Apache Tomcat/4.0.3

Report Server Test OK

Shutting down report server...
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----- Root Cause -----
java.net.BindException: Address already in use:8080
at org.apache.catalina.connector.http.HttpConnector.open 
(HttpConnector.java:950)
at org.apache.catalina.connector.http.HttpConnector.initialize 
(HttpConnector.java:1128)
at org.apache.catalina.core.StandardService.initialize 
(StandardService.java:454)
at org.apache.catalina.core.StandardServer.initialize 
(StandardServer.java:553)
at org.apache.catalina.startup.Catalina.start 
(Catalina.java:780)
at org.apache.catalina.startup.Catalina.execute 
(Catalina.java:681)
at org.apache.catalina.startup.Catalina.process 
(Catalina.java:179)
at sun.reflect.NativeMethodAccessorImpl.invoke0(Native Method)
at sun.reflect.NativeMethodAccessorImpl.invoke 
(NativeMethodAccessorImpl.java:39)
at sun.reflect.DelegatingMethodAccessorImpl.invoke 
(DelegatingMethodAccessorImpl.java:25)
at java.lang.reflect.Method.invoke(Method.java:324)
at org.apache.catalina.startup.Bootstrap.main 
(Bootstrap.java:243)
Report Server Test Failed!
Shutting down report server...

If you receive this error message, it is likely because the Historical Reports Server is not 
able to start because the Historical Reports Server was configured with ports currently in 
use by other applications. To troubleshoot this error, it is recommended that you edit the 
port settings in both the server.xml and pro.report.init files.

To edit the server.xml file:

1. Navigate to the server.xml file located in <install_dir>/reportServer/
conf/server.xml.

2. Open the file in any text editor.

3. Edit the port settings for both the non-secure (http) and secure (https) (if 
applicable) ports.

To edit the pro.report.init file:

1. Navigate to the pro.report.init file located in the installation directory.

2. Open the file in any text editor.

3. Edit the port settings values for: server.http.port=<oldHTTPPort> to 
server.http.port=<newHTTPPort>; and 
server.https.port=<oldHTTPSPort> to 
server.https.port=<newHTTPSPort>

After making your changes, run the glproRS -test again to make sure that the 
Historical Reports Server is running properly, then start the Historical Reports Server.
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Installing Multiple Server Components on the Same 
Computer

If you are installing multiple server components on the same computer (i.e., minimal 
configuration), you will follow the same procedures described to run the Report Manager 
installer. When the installer displays the screen prompting you to select which Report 
Manager components you wish to install, use the Feature set pull-down menu and select 
Custom. You can then click on the checkboxes that correspond to the components that 
you want to install.

If you are in Console Mode, enter the numbers that correspond to the components that 
you want to install separated by a comma. For example, if you wanted to install the Data 
Collector (option #2) and the Historical Reports Server (option #3) on the same computer, 
you would enter “2,3”. You will need to press <Enter> to continue.

If you are installing multiple server components and/or the PostgreSQL database on the 
same computer, you must ensure that you are logged on to the server computer using an 
account with the appropriate privileges.

Initialization Files
Installing each server component automatically generates the following initialization files 
for each server component.

Server Component Initialization File

Master Controller pro.mc.init

Data Collector pro.dc.init

Historical Reports Server pro.report.init
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INSTALLING THE REPORT MANAGER CONSOLE
Once you have installed the Report Manager server, you can install and configure the 
Report Manager Console.

Prerequisite Information
Before installing the Report Manager Console, refer to the pre-installation worksheet 
where you have defined information required to install the Console.

Installing the Report Manager Console Software
1. Ensure that you are logged on to the Console computer using an account with 

the appropriate privileges.

2. Launch the Report Manager executable. The Report Manager InstallAnywhere 
wizard will appear to guide you through the installation process.

3. Review the Installation Introduction screen, then click Next to continue. The 
installer displays the Report Manager software License Agreement.

4. Review the License Agreement, and if you accept the terms, click in the 
checkbox indicating that you accept the terms of the License Agreement. Click 
Next to continue. The installer displays a screen with Important Information.

5. Review the information and click Next to continue.

Note: You can expect the process of installing the Report Manager Console to take 
approximately 5 minutes. Note that this is the actual time to complete the task of running 
the installer to install the Report Manager Console. It does not include any other time 
required to prepare or plan your actual deployment of Report Manager.
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The installer displays a screen prompting you to select which Report Manager 
components you wish to install.

6. Click on a button to select the components that you wish to install. You can 
choose to install the Report Manager Console only, Crystal Reports only, or all 
components (Full Install). Click Next to continue.

The installer displays a screen prompting you to specify a folder in which it will 
save the Report Manager Console files. The installer will create a subdirectory 
tree including subdirectories for “NetScreen” and “Report Manager” in the 
Program Files directory on your local C:\ drive by default (i.e., C:\Program 
Files\NetScreen\Report Manager).

7. Select the default location, edit the field and enter a different installation 
location, or click Choose... to browse to a different location. Click Install to 
continue.
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The installer displays a series of informational screens as Report Manager 
installs. You can monitor the progress via the task bar at the bottom of the 
screen. When finished, the installer displays a screen prompting you to enter the 
IP address for the Master Controller, and your Customer Authentication ID.

8. Enter the Master Controller IP address and the Customer Authentication ID 
information. Click Next to continue.

9. Click Done to exit the installer. You will notice that a shortcut to launch Report 
Manager now appears on the desktop.

Testing the Report Manager Console
To verify that the Report Manager Console is operating properly, it is recommended that 
you send a ping to the computer running the Master Controller.

Note: If you chose to perform a Full Install, a window will appear prompting you 
for additional information required to install the NetScreen-Global PRO Crystal 
Reports Component.
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Starting the Report Manager Console
1. After starting the Master Controller, you can start the Report Manager Console 

by double-clicking on the Report Manager application icon. The Report Manager 
Console Login window will appear prompting you to enter your User Name and 
Password and the IP address of the host server running the Master Controller.

2. Enter your User Name and Password, and specify the IP Address of the 
Master Controller to establish communication between the Console and the 
Master Controller.

3. Check the Save User Name and IP Address checkbox to save these settings 
for the next time you log in. Report Manager stores the profile settings for all 
users who log on to Report Manager in a local configuration file.

4. Click on the Login button. If you are logging in for the first time, Report 
Manager will display a window prompting you to change your password.

5. Click OK to proceed. The Report Manager application will launch. If login is 
successful, a dialog box will appear indicating that Report Manager is collecting 
data from the server. When launching Report Manager for the first time, the 
first screen that you will see is the Report Manager Console.

Note: If you are logging in for the first time, you will use the default User Name 
(“netscreen”) and Password (“netscreen”).
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CONFIGURING REPORT MANAGER FOR THE FIRST TIME
Once you have installed Report Manager, you will need to configure it to work properly 
within your specific environment. There are two aspects involved with configuring Report 
Manager:

• Device-Side configuration - this involves enabling each device to work with 
Report Manager;

• Report Manager configuration - this involves adding your Data Collectors and 
devices in the Report Manager system to allow them to establish 
communications.

Configuring Your Device to Work With Report 
Manager

Before you begin to use Report Manager, you must first enable those NetScreen devices 
from which you want to receive information to work with NetScreen Global-PRO. Use the 
Report Settings option in the ScreenOS Configuration menu to enable the device to use 
Global PRO. You must also assign the device to a Primary Data Collector.
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Assigning a Primary and Secondary Data Collector
Enter the IP Address for the primary Data Collector in the Global PRO Server Settings 
section. If you are using a secondary Data Collector (i.e., for failover purposes), you can 
also assign the device to the secondary Data Collector by entering a Secondary IP 
Address/Name. The device is factory set to use port 15400.

Identifying Information to Send to Global-PRO
The device will send all of the following information to its primary Data Collector by 
default:

• Protocol Distribution

• Policy Statistics

• Ethernet Statistics

• Flow Statistics

• Attack Statistics

• Attack Alarms

• Traffic Alarms

• Event Alarms

• Configuration Logs

• Information Logs

• Traffic Logs

• Self Logs

If you do not want the device to send a specific type of information to the Data Collector, 
click to uncheck the appropriate checkbox in the Report Settings section.

Refer to your appropriate NetScreen device documentation for additional information 
describing how to configure your NetScreen device.

Global PRO Agent
Once you have enabled Global PRO on the device, a task on the device called the Global 
PRO Agent starts. The Global PRO agent is responsible for establishing a connection 
between the device and its Primary Data Collector. It will attempt to connect to the 
Primary Data Collector as long as you have configured any non-zero entry for the primary 
or secondary Data Collector IP address.

Note: You can later change these settings in Report Manager. The configuration changes 
you make in Report Manager override any similar settings that you have configured on the 
device.



Chapter 2 Installing Report Manager

76 NetScreen-Global PRO Report Manager User’s Guide

Configuring Report Manager
You must add and configure each Data Collector and device in Report Manager in order to 
enable the Data Collector to receive and monitor information.

Adding Data Collectors
The Data Collector is primarily responsible for gathering real-time performance statistics, 
log data, and other traffic-related information from the devices that you have configured 
in your system.

When a Data Collector starts, it contacts the Master Controller to get a list of the devices 
to which it is assigned. The Master Controller retrieves this configuration data from the 
database. You must provide this information to the database by first adding and 
configuring the Data Collector and device in Report Manager.

Note: You can expect the process of adding a Data Collector and device in Report Manager 
to take approximately 10 minutes. Note that this is the actual time to complete the task of 
adding and configuring one Data Collector and one device in Report Manager. It does not 
include any other time required to prepare or plan your actual deployment of Report 
Manager.
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As the Data Collector receives connect requests from each of its devices, it uses the 
configuration data from the database to first authenticate and then establish 
communications with a device. Once it does this, the Data Collector can receive 
information from that device.

To add a Data Collector:

1. From the Report Manager Console, click on the Data Collectors button in the 
Control pane.

2. Click on the Add button that appears in the Report Manager Console tool bar. 
Alternatively, you can right-click in the List pane and select Add. You can also 
click on the Edit menu and select Add. A new template allowing you to 
configure a new Data Collector appears in the Details pane.

3. Enter a name for the Data Collector.

4. Enter the IP Address for the Data Collector.

5. If the Data Collector resides on a computer behind a firewall, you will need to 
enter the mapped IP address for the Data Collector.

DC DB

2. Data Collector starts, contacts the Master Controller for configuration info.

3. The Master Controller retrieves configuration 
data from the database, and returns it to the Data 
Collector.

MC

Console

6. Data Collector sends real-time 
statistics to the Monitor Console.

5. Data Collector forwards info to the Master Con-
troller for storage on the database.

1. Device attempts to initialize a 
connection with its Primary Data 

4. The Data Collector uses con-
figuration data to authenticate 
and establish a connection with 
the device.
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6. Use the Contact Person pull-down menu to assign a contact person for the Data 
Collector (optional).

7. Click on the Location tab. Enter any applicable information describing the 
location of the Data Collector computer (optional).

8. Click on the Save icon in the Report Manager Console toolbar to save your 
changes. The new Data Collector appears in the List pane. Or click on the Undo 
icon to cancel your changes.

Once you save the Data Collector in the Report Manager system, this information will be 
saved in the database. It is then used to authenticate the Data Collector with the Master 
Controller.

Repeat this process for each Data Collector in your system. You can later configure the 
Data Collector to provide additional functionality including failover, e-mail notification, 
traffic log recording, etc. Refer to Configuring Data Collector Properties in Chapter 4 for 
more information.

Note: The Master Controller IP Address for the Data Collector is configured 
when you install the Data Collector. This information is not configurable when 
you first add the Data Collector to the Report Manager system.
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Adding Devices
1. Click on the Devices button in the Control pane.

2. Click on the Add icon that appears in the toolbar. Alternatively, you can right-
click in the List pane, and select Add. You can also click on the Edit menu and 
select Add. A template allowing you to configure a new device appears in the 
Details pane.

3. From the Information tab, enter the Serial #, User Name, Password, and 
any applicable comments. You will need to provide the serial number and 
password for a device to allow Report Manager to identify and authenticate the 
device.

4. Use the Contact Administrator pull-down menu to specify a Contact 
Administrator (optional).

5. Use the pull-down menu to assign the device to a Primary DC.

6. If you are employing a secondary Data Collector (i.e., for failover purposes), use 
the pull-down menu to assign the device to a Secondary DC (optional).

7. Click on the Save icon that appears in the toolbar to save your changes. The new 
device appears in the List pane. Or, you can click on the Undo icon to cancel your 
changes.

Note: You can obtain the serial number for a device on the bottom of the 
NetScreen device itself, the NetScreen device packing slip, from within Policy 
Manager. You can also issuing a “Get Config” command from the command line 
interface (CLI).
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Repeat this process for each device in your system that you wish to monitor using Report 
Manager. Once you have added your devices, you can assign them to a group. Grouping 
your devices will make it easier for you to manage all the devices in your system. Refer to 
Adding and Configuring Device Groups in Chapter 4 for more information.

Checking Your System Health
After adding your Data Collectors and devices in the Report Manager Console, it is 
recommended that you check on the status of the Master Controller and each Data 
Collector by viewing the System Health window. Click on the System Health button in 
the Report Manager Console Control Pane to launch the System Health view.

Note: Once you have added a device to the Report Manager system, the Monitor Console 
will automatically launch every time you start the Report Manager application.
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UNINSTALLING REPORT MANAGER
You can uninstall the Report Manager Server or Console from your system as follows:

Uninstalling the Report Manager Server Components
1. Navigate to the directory where Report Manager is installed. For example, you 

would enter the following command:

cd <install_directory>/UninstallerData 

2. Run the GlobalPRO uninstall command. For example, you would enter the 
following command:

./GlobalPROUninstall

If you are in Console Mode, you would enter the following command:

./GlobalPROUninstall -i console

The uninstaller will prompt you to confirm the uninstall.

The NetScreen-Global PRO uninstall script launches the InstallAnywhere uninstaller 
script to remove the Report Manager components. This removes all the software 
components but leaves any data that you may created.

Note: The default directory is:/opt/NETSglPRO/UninstallerData.
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Uninstalling the Report Manager Console
1. Use the Uninstall Report Manager Console command from the Start menu 

(i.e., Start>Programs>NetScreen-Global PRO>Report Manager>Uninstall 
Report Manager Console). Alternatively, you can use the Add/Remove Programs 
utility in your Windows Control Panel.

2. Click Uninstall to continue. The uninstaller will proceed to uninstall the Report 
Manager Console software.
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A window will appear indicating the results of the uninstall process.

3. Click Quit to exit the uninstaller.

Note: The uninstall process removes all the Report Manager Console software 
components, but will leave any data that you may created.
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3
Chapter 3

Getting Started
Once you have successfully installed Report Manager, you can get started using Report 
Manager to monitor your devices and generate historical reports.

This chapter provides information describing how you can get up and running with Report 
Manager quickly. Its main sections include:

• Logging In To Report Manager For the First Time

• Using the Monitor Console For the First Time

• Using the Historical Reports Console For the First Time
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LOGGING IN TO REPORT MANAGER FOR THE FIRST TIME
To begin using Report Manager, you will first need to start the application and login using 
a valid User Name and Password. Refer to Starting the Report Manager Console in 
Chapter 2 for more information on starting and logging into Report Manager.

Default Report Manager User
When you first login to Report Manager, you will do so using the User Name and 
Password of the Report Manager default user. Report Manager includes one default user 
and one default group. The default user is called “Netscreen”, and it is assigned to the 
default group called “Admin”.

Default User Privileges
As the default user, you are granted special privileges to perform all administrative tasks 
in Report Manager by default. For security reasons, it is highly recommended that you 
use the default user to create and configure your initial user account only. Once you have 
created a user name and password for yourself, you should logout of Report Manager and 
re-login using your own user account.
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Adding a User
Your first task as the initial Report Manager user is to create a unique User Name and 
Password for yourself in Report Manager. You will use the Report Manager Console to 
create, configure and administer your users, devices, and Data Collectors in Report 
Manager.

To add a user:

1. From the Report Manager Console, click on the Users button in the Control 
pane. Report Manager displays a list of all current users created in the system in 
the List pane.

2. Click on the Add icon that appears in the Report Manager Console tool bar. 
Alternatively, you can right-click in the List pane and select Add. You can also 
click on the Edit menu and select Add. A template allowing you to configure 
details for a new user appears in the Details pane.

3. Enter a user name for the user.

4. Assign the user a password and re-enter it in the Confirmed Password field.

5. Enter any appropriate contact information.

6. Click on the Save icon in the Report Manager Console toolbar to save your 
changes. The user now appears in the List pane. Or, click on the Undo icon to 
cancel your changes.



Chapter 3 Getting Started

88 NetScreen-Global PRO Report Manager User’s Guide

You can later configure additional properties for the user including specific 
administrative or report access privileges and group assignments. Refer to Adding and 
Configuring Users in Chapter 3 for more information.

Logging In as a Different User
Once you have created a unique User Name for yourself, you should logout of Report 
Manager as the default user and log back in using your own user name.

To log into Report Manager as a different user:

1. Click on the Logout icon in the toolbar.

Alternatively, you can use File menu, and select Logout. Report Manager will 
prompt you with a logout confirmation dialog to confirm that you want to logout.

2. Click Yes to confirm that you want to logout. The Report Manager Login window 
will appear prompting you to enter a new User Name, Password, and Master 
Controller IP Address.

3. Enter the new User Name and Password, and specify the IP Address of the 
Master Controller to which you wish to establish a connection.

4. Click the Login button.

You are now ready to begin using Report Manager to proactively monitor your NetScreen 
devices. You can also use Report Manager to generate historical reports allowing you to 
further view and analyze data.
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USING THE MONITOR CONSOLE FOR THE FIRST TIME
Once you have added a device to the Report Manager system, the Monitor Console will 
automatically appear every time you start the Report Manager application. Use the 
Monitor Console to quickly monitor the up/down status of your NetScreen devices in real-
time. You can also use the Monitor Console to monitor Event Summary Status, a 
histogram view of events according to severity levels for selected events/devices.

Event alert icons and color-coded bar graphs notify you of potential issues.

From the Monitor Console, you can also access more detailed information on your devices, 
including active sessions, protocol and policy usage trends, uptime calculations, 
performance baselines, traffic logs, and security events. Refer to Using the Monitor 
Console in Chapter 5 for more information.

Refreshing the Display
Use the View menu and select Refresh to manually refresh the display. Alternatively, 
you can click on the Refresh button that appears in the Report Manager toolbar.
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Getting Help
If you need help using the Report Manager, use the Help menu and select Help Topics. 
Alternatively, you can click on the help button that appears in the Report Manager 
toolbar. The Report Manager online help will appear in a separate window. Click on the 
one of the topics in the table of contents or use the Index to find a specific answer to your 
question.

For more context sensitive help, click on any of the help buttons that appear in the user 
interface.

Click on the Help button to 
access the Report Manager 

online help.
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Checking What Report Manager Version You Are 
Running

To check what version of Report Manager you are running, use the Help menu and select 
About Report Manager Console.

Exiting the Report Manager Console
When you are done using the Report Manager Console, exit Report Manager.

1. From the File menu, select Exit. Report Manager will prompt you with an Exit 
confirmation dialog to confirm that you want to exit.

2. Click Yes to confirm that you want to exit.
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USING THE HISTORICAL REPORTS CONSOLE FOR THE FIRST 
TIME

You can access historical reports from a web browser (Netscape Navigator 6.0 or Internet 
Explorer 6.0 or higher).

1. Launch a web browser.

2. Enter the IP Address and port number for the Historical Reports Server in the 
Address bar of your browser. For example, if the IP Address of the Historical 
Reports Server is 10.150.12.345, and the port number is 8080, you would enter 
the following in your browser address bar:

http://10.150.42.70:8080/reports

This will take you to the Historical Reports login page.
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3. In the Login window, enter your User Name and Password, and click Login. 
This takes you to the Historical Reports (HR) Console page.

Customizing and Generating a Report
Use the Historical Reports Console to customize and generate reports allowing you to 
analyze information about your NetScreen devices.

You can access over 70 reports. These reports are grouped into six categories:

• Alarms

• Network Traffic

• Service Level Agreements

• Resources

• Logs

• Administration

To generate a report:

1. In the Category/Reports pane, use the Category/Reports pull-down menu and 
select a report category. The list of available reports will appear.

2. Click to select a specific report from the reports list (for example, Traffic Alarm 
Summary, Event Alarm Analysis, etc.). 
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3. In the Report Context pane, select the device group(s), device(s), virtual 
system(s), or cluster(s) that you wish to generate a report on.

4. In the Report Parameters pane, enter a specific period of time to and from which 
you wish to generate the report for. Use the date/time format icon to toggle the 
way Report Manager displays the date and time between US and European 
formats. Use the calendar icon to select a date.

5. Enter a sampling duration. You can select to sample either hourly, daily, 
weekly, or monthly.

6. Enter any other parameters that may be applicable for the report (i.e., Alarm 
Type, Interface, etc...).

7. Click on the Report button in the Toolbar. This generates the report and 
displays it.

From the Historical Reports Console, you can also create report templates or profiles to 
generate report(s) automatically. Report Manager will send you an e-mail notifying you 
when reports are available for viewing. Refer to Using the Historical Reports (HR) 
Console in Chapter 6 for more information.

Getting Help
If you need help using the Historical Reports Console, click on the help button that 
appears in the Historical Reports Console toolbar. The Report Manager online help will 
appear in a separate window. 
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4
Chapter 4

Configuring Report Manager
Report Manager provides you the flexibility to configure and manage the system to work 
the way you want. Depending on your own specific business needs, you can add and delete 
users and devices and organize them into groups. You can also add and configure Data 
Collectors to manage the information gathered from each device. You will perform all of 
these administrative tasks from the Report Manager Console.

The Report Manager Console provides you a central location where you can add, configure 
and manage all the users, Data Collectors, and devices in your Report Manager system. 
This chapter provides information that describes the Report Manager Console. It provides 
step-by-step procedures and examples describing how you can use it to configure Report 
Manager.

This chapter includes the following sections:

• Report Manager Configuration Overview

• Using the Report Manager Console

• Adding and Configuring Groups

• Adding and Configuring Users

• Adding and Configuring Data Collectors

• Adding and Configuring Devices

• Adding and Configuring Device Groups
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REPORT MANAGER CONFIGURATION OVERVIEW
You must add and configure all the objects in Report Manager for them to work properly. 
During installation, you needed to add your Data Collectors and devices in Report 
Manager in order to establish communications between them. You can further configure 
your Data Collectors to perform additional functions including sending e-mail 
notifications of alerts or other Report Manager system events, aggregrating messages, 
saving traffic log information, and filtering information to the database. Refer to Adding 
and Configuring Data Collectors for more information on configuring your Data 
Collectors.

You can configure your devices to send specific information to Report Manager. You can 
also adjust the intervals with which information is polled from the device. Refer to Adding 
and Configuring Devices for more information on configuring your devices.

Anyone that wants to use Report Manager must have a valid user name and password in 
the Report Manager system. It is recommended that you begin adding and configuring 
your users in Report Manager by first organizing them into logical groupings. You can 
group your users in any number of ways depending on their department, job function or 
administrator role.

Security Admin

Security NOC Manager

Groups

-Jack
-Bob
-Simon

1st Lvl Support

-Nancy
-Jerry
-Sergei

Escalation

-Steve
-Tan
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You can also organize your devices into logical groupings called Device Groups in a 
similar manner. You can group your devices in any number of ways depending on their 
region, customer relationship, service level, security level).

Asia
Device Group

Europe
Device Group
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USING THE REPORT MANAGER CONSOLE
The Report Manager Console provides you with a central location from which you can 
administer and manage all users, groups, Data Collectors, devices and device groups in 
Report Manager.

The Control pane allows you to create and modify groups, 
users, Data Collectors, devices and device groups in the Re-

port Manager system.

Click to access the System Health and Monitor 
Console.

The List pane displays all exist-
ing groups, users, Data Collec-
tors, devices and device groups.

The Details pane allows you to view and modify 
groups, users, Data Collectors, devices and de-

vice groups.
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About the Report Manager Console
The Report Manager Console has the following main components:

• Control Pane

• List Pane

• Details Pane

In addition, a status bar that appears at the bottom of the Report Manager Console 
displays the currently active user’s status.

Control Pane
Use the Control pane to access the configuration list and details panes allowing you to 
configure groups, users, Data Collectors, devices, and device groups.

List Pane
Use the List pane to select the appropriate groups, users, Data Collectors, devices, and 
device groups you want to configure.

Sorting Names in the List Pane
You can sort the names that appear in the List pane by clicking on the List pane header.

Details Pane
Use the Details pane to fill in configuration details for all objects (users, groups, devices, 
device groups, and Data Collectors) in the Report Manager system.
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ADDING AND CONFIGURING GROUPS
It is recommended that you begin adding and configuring your users in Report Manager 
by first organizing them into logical groupings. To do this, use the Report Manager 
Console to add user groups and then assign your users to them. Assigning your users to 
groups will allow you to more easily view and manage privileges for users in Report 
Manager.

Privileges
Users are allowed to view and manage information in Report Manager based on the 
privileges that they either receive explicitly or inherit as a member of a group.

There are three types of privileges that you may assign to a group or user in Report 
Manager:

• Device Read/Write Privileges

• Report Viewing Privileges

• Administrative Privileges

Device Read/Write Privileges
You must assign a group or user to a specific device in order for that group or user to view 
report information from that device. You can assign read and/or write privileges on a 
device to a group or user:

• Read privileges on a device allow a group or user to view logs/alarms and other 
reporting tables for the device.

• Write privileges on a device allow a group or user to modify the Global PRO 
parameters on the device such as: protocol distribution polling interval, policy 
polling interval, enable/disable specific logs/alarms reports.

You can assign similar read/write privileges to a group or user in Report Manager for 
virtual systems and device groups that you have created.

Report Viewing Privileges
You must also assign a group or user specific report read privileges in order for that group 
or user to create and view historical reports in Report Manager.

Note: Please note that the Report Manager Console does not allow the creation of a virtual 
system, thus, Report Manager users cannot alter the parameters for Global PRO for a 
virtual system through the Report Manager Console.
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Administrative Privileges
Users who are responsible for performing administrative tasks will need additional 
administrative privileges. The following table describes administrative privileges that you 
can assign to a group or user:

Assigning Group Privileges
Once you have added a group in Report Manager, you can assign specific privileges to that 
group. As you assign users to the group, those users will effectively inherit the privileges 
assigned to the group. For example, let’s say you create a group called Engineering and 
assign “Create User/Group” privileges to it; you later assign a user named Jack to that 
group. Jack now effectively inherits the “Create User/Group” privilege.

Users who are assigned to more than one group will inherit the collective privileges of all 
the groups that they are assigned. For example, let’s say you assign “Create User/Group” 
privileges to those users in the Engineering group; and you also assign “Assign Privilege” 
privileges to those users in the Marketing group. If you assign Jack to both the 
Engineering and Marketing groups, he inherits both Create User/Group and Assign 
Privilege privileges.

Privilege Allows a user to...

Administer Database perform tasks on the database. This includes the ability to perform 
database cleanup operations (i.e., archive and purge records). 
Refer to Maintaining the Database in Chapter 11 for more information.

Create User/Group Add, delete or modify users and group profiles. Also allows association 
of users to groups (i.e., adding and deleting users to and from a group.

Assign Privilege Assign privileges to users and groups in Report Manager.

Add/Delete Device/DC Add, delete, or modify a device or Data Collector in Report Manager. 
Also allows a user to create associations between devices and Data 
Collectors.

Marketing

Assign Privilege

Engineering

Create User/Group

Jack

Jack inherits the collective privileges of all the groups that he is assigned.

Assign PrivilegeCreate User/Group
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Adding a Group
Use the Report Manager Console to add a group.

1. Click on the Groups button in the Control pane. Report Manager displays a list 
of all current groups created in the system in the List pane.

2. Click on the Add button. Alternatively, you can right-click in the List pane and 
select Add. You can also click on the Edit menu and select Add. A template 
appears in the Details pane allowing you to configure a group.

3. Enter a name for the group in the Group name field. You can optionally enter a 
description of the group in the Description field.

4. Click on the Save icon in the Report Manager Console toolbar to save your 
changes. The group now appears in the List pane. Or, click on the Undo icon to 
cancel your changes.

Assigning a Group to a Device
You must assign a group or user to a specific device in order for that group or user to view 
information from that device.

1. Click on the Groups button in the Control pane.

2. Select the desired group from the List pane. The group’s profile appears in the 
Details pane.
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3. Select the Devices tab in the Details pane. Report Manager lists the available 
devices with the following device information: Device Name, Serial Number, 
Device Type, Device IP Address.

4. Select a device from the list of Available Devices, and then click Add. The device 
now appears in the list of Selected Devices.

5. Check in the Read checkbox to enable read privileges on the device. Check in 
the Write checkbox to enable write privileges on the device.

6. To remove a device, select it from the list of Selected Devices and click Remove. 
The device now appears in the list of Available Devices.

7. Click on the Save button in the Report Manager Console tool bar to save your 
changes. Or, click the Undo button to cancel your changes.

Assigning a Group to a Virtual System
You must assign a group or user to a specific virtual system in order for that group or user 
to view information from that virtual system. 

1. Click on the Groups button in the Control pane.

2. Select the desired group from the List pane. The group’s profile appears in the 
Details pane.
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3. Select the Virtual System tab in the Details pane. Report Manager lists the 
available virtual systems with the following virtual system information: Device, 
Serial Number, Device Type, Device IP Address, Virtual System.

4. Select a virtual system from the list of Available Virtual Systems, and then click 
Add. The virtual system now appears in the list of Selected Virtual Systems.

5. Check in the Read checkbox to enable read privileges on the virtual system. 
Check in the Write checkbox to enable write privileges on the virtual system.

6. To remove a virtual system, select it from the list of Selected Virtual Systems 
and click Remove. The virtual system now appears in the list of Available 
Virtual Systems.

7. Click on the Save button in the Report Manager Console tool bar to save your 
changes. Or, click the Undo button to cancel your changes.

Assigning a Group to a Device Group
Device Groups are logical groupings of devices allowing you to more easily manage and 
configure multiple devices. You must assign a group or user to a specific device group in 
order for that group or user to view information from that device group.

1. Click on the Groups button in the Control pane.

2. Select the desired group from the List pane. The group’s profile appears in the 
Details pane.

3. Select the Device Groups tab.

4. Select a device group from the list of Available Device Groups and click the Add 
button. The device group now appears in the list of Selected Device Groups.

5. Check in the Read checkbox to enable read privileges on the device group. 
Check in the Write checkbox to enable write privileges on the device group.

6. To remove a Device Group from a group, select it from the list of Selected Device 
Groups and click Remove. The device group now appears in the list of Available 
Device Groups.

7. Click on the Save icon in the Report Manager Console toolbar to save your 
changes. Or, click the Undo button to cancel your changes.

Configuring Report Privileges
You must also assign a group or user specific report read privileges in order for that group 
or user to create and view historical reports in Report Manager.

Note: Virtual Systems are only available with the NetScreen-500, NetScreen-
1000, and NetScreen 5000 series.

Note: The group’s privileges change when adding or removing Device Groups 
with differing privileges associated with them.
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1. Click on the Groups button in the Control pane.

2. Select the desired group from the List pane. The group’s profile appears in the 
Details pane.

3. Select the Privileges tab.

4. From the Report Privileges section, click the + button to expand the report 
category list. A list of the report names for the report category appears with the 
corresponding read privileges.

5. Check the corresponding checkbox(es) to assign read privileges on the selected 
report.

6. Uncheck the corresponding checkbox(es) to deny read privileges on the selected 
report.

7. Click on the Save icon in the Report Manager Console tool bar to save your 
changes. Or, click the Undo button to cancel your changes.
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Configuring Administrative Privileges
1. Click on the Groups button in the Control pane.

2. Select the desired group from the List pane. The group’s profile appears in the 
Details pane.

3. From the Administrative Privileges section, check the corresponding 
checkbox(es) to assign administrative privileges to the group.

4. Uncheck the corresponding checkbox(es) to deny administrative privileges to the 
group.

5. Click on the Save icon in the Report Manager Console tool bar to save your 
changes. Or, click the Undo button to cancel your changes.

Assigning a User to a Group
Once you have created and configured your groups, you can assign users to them. You can 
assign a user to as many groups as you want.

1. Click on the Groups button in the Control pane. Report Manager displays a list 
of all current groups created in the system in the List pane.

2. Select the desired group from the List pane. The group’s profile appears in the 
Details pane.

3. Select the Users tab.
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4. Select the desired user from the list of Available Users and click the Add button. 
The user now appears in the list of Selected Users. 

The user’s privileges change when adding or removing groups with differing 
privileges associated with them.

5. Click on the Save button in the Report Manager Console tool bar to save your 
changes. Or, click the Undo button to cancel your changes.

Removing a User from a Group
The process of removing a user from a group is similar to the procedure described for 
assigning a user to a group. To remove a user from a group, use the Remove button in the 
Users tab to remove the user from the list of Selected Users.

Viewing All Groups
Once you add a group in the Report Manager system, Report Manager stores all the 
information that you have configured for the group in the database. You can view a list of 
all groups in the Report Manager system by generating an All Groups report from the 
Historical Reports Console.

Refer to Using Administration Reports in Chapter 4 for more information on the All 
Groups report.

Note: To select multiple users, use the [Shift] key (to select users appearing together), or 
[Ctrl] key (to select users that do not appear together).
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ADDING AND CONFIGURING USERS
Anyone that wants to use Report Manager must have a valid user name and password in 
the system.

Adding a User
Use the Report Manager Console to add your users. Refer to Adding a User in Chapter 3 
for more information on adding a user.

Configuring User Contact Information
Once you have added a user, you can provide additional contact information describing 
the user. You can add the following contact information:

• First Name, Last Name

• Phone Number

• E-mail Address

• Street, City, State, Zip Code, Country
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Modifying User Privileges
You can assign additional privileges to an individual user account. Individual user 
privileges allow you to extend a specific user’s privileges beyond those privileges the user 
inherits from its membership in a group.

To assign or modify user privileges:

1. Click on the Users button in the Control pane. Report Manager displays a list of 
all current users created in the system in the List pane.

2. Select the desired user from the List pane. The user’s profile appears in the 
Details pane.

3. Check the checkbox corresponding to the privileges that you wish to assign to 
the user in the Administrative section. Similarly, you can uncheck the checkbox 
corresponding to the privileges that you wish to deny the user.

4. From the Report Privileges section, click the + button to expand the report 
category list. A list of the report names for the report category appears with the 
corresponding read privileges. Check the corresponding checkbox(es) to assign 
read privileges on the selected report. Similarly, you can uncheck the 
corresponding checkbox(es) to deny read privileges on the selected report.

5. Click on the Save button in the Report Manager Console tool bar to save your 
changes. Or, click the Undo button to cancel your changes.
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Deleting a User
1. Click on the Users button in the Control pane.

2. Select the desired user from the List pane. The user’s profile appears in the 
Details pane.

3. Click on the Delete button. Alternatively, you can right-click in the List pane 
and select Delete. You can also click on the Edit menu and select Delete. A 
message appears asking you to confirm your choice.

4. Confirm your selection, and then click Yes

5. Click on the Save icon in the Report Manager Console tool bar to save your 
changes. Or, click the Undo button to cancel your changes.

Viewing All Users
Once you add a user in the Report Manager system, Report Manager stores all the 
information that you have configured for the user in the database. You can view a list of 
all users in the Report Manager system by generating an All User report from the 
Historical Reports Console.

Refer to Using Administration Reports in Chapter 4 for more information on the All Users 
report.
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ADDING AND CONFIGURING DATA COLLECTORS
Report Manager uses Data Collectors or DCs to gather real-time performance statistics, 
log data, and other traffic-related information from the devices that you have configured 
in your system. The Data Collector is responsible for sending this information to the 
Report Manager Console with real-time performance statistics and log data. It also 
forwards information to the Master Controller for storage on the database.

You can also configure Data Collectors to perform the following additional functions as 
well:

• E-mail event alerts and global message filtering

• Monitor filtering for consoles on specific events or severity levels

• Message consolidation (de-duplication of repeated events and consolidating 
them)

• SNMP integration (trap forwarding to multiple SNMP managers)

• TelAlert integration (for alarm management)

• Netcool integration (event forwarding to Micromuse's Netcool system)

Depending upon the size of your NetScreen security system, you may install one or more 
Data Collectors to extend your data collecting ability.

Adding Data Collectors
You will need to use the Report Manager Console to add and configure your devices. Refer 
to Adding Data Collectors in Chapter 2 for more information on adding Data Collectors.
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Viewing Data Collectors
You can view each Data Collector in the List pane. Click to select the Data Collector, and 
you can view additional information about it in the Details pane. Click the + icon to 
expand the Data Collector or double-click on the Data Collector to view the devices for 
which the Data Collector serves as either the primary or secondary.
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Associated Device Summary
If you expand a Data Collector in the List pane and select a specific device associated with 
that Data Collector, the Details pane will appear providing information describing the 
device.

The following table describes the information available from the Device Summary.

Item Description
Serial Number Serial number of the NetScreen device.
Firmware Version Version information describing the NetScreen operating system, ScreenOS.
Host Name Device host name.
IP Address IP address of the NetScreen device.
Domain Name Only present if a domain name is configured on the device, for example, 

netscreen.com.
Description A description, for example, firewall and VPN.
Comments Comments that were included when the device was added to Report Manager.
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Configuring Data Collector Properties
Once you have added a Data Collector, you can configure the following additional 
properties:

• Master Controller IP Address

• Failover Settings

• E-mail Settings

• Event Aggregation

• Event Buffer Size

• Database Event Filters

• Recording Traffic Logs

• Device Polling Intervals

• Save Statistics to Database Intervals

• Netcool Integration (optional)

Master Controller IP Address
The first tab that you see when configuring a Data Collector is the Information tab. 
From the Information tab, you can view or modify the IP Address of the primary Master 
Controller. The Master Controller IP Address specifies the location of the Master 
Controller where the Data Collector will forward device information.

To modify a Data Collector’s Master Controller IP Addresses:

1. Click on the Data Collectors button in the Control pane. Report Manager 
displays a list of all current Data Collectors created in the system in the List 
pane.

2. Click on the Data Collector that you wish to configure the Master Controller IP 
Address. The Data Collector profile appears in the Details pane.

Note: The Master Controller IP Address for the primary Master Controller should already 
have been configured when you installed the Data Collector.
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3. From the Information tab, edit the IP address of the primary Master 
Controller in the Master Controller IP Address field provided.

4. Click on the Save icon in the Report Manager Console toolbar to save your 
changes. The new Data Collector appears in the List pane. Or click on the Undo 
icon to cancel your changes.

You will need to stop and then restart the Data Collector to enable your changes on the 
Data Collector.

Failover Settings
The Secondary Master Controller IP Address is used when you want to assign a Data 
Collector to an additional Master Controller for failover purposes. Additional failover 
settings that you can configure include the path and interval that you want to save device 
logs. Refer to Configuring Data Collector Failover Protection in Chapter 11 for more 
information.
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E-mail Settings
You can configure the Data Collector to notify you by e-mail of alerts or other Report 
Manager system events.

To configure e-mail alert notifications:

1. From the Data Collector profile, select the E-mail Settings tab.

2. Click in the Enable Email Alert check box.

3. Enter the following e-mail properties:

• SMTP Server Name - this is the SMTP server address for sending e-mail 
notifications. For example: 172.16.10.212.

• Sender’s Email Address - this is the sender’s e-mail address that Report 
Manager will use to send e-mail alerts.

• Receiver’s Email Address - this is the e-mail address to which Report 
Manager will send e-mail alerts.

• Suppress Duplicate Messages for - this is the time interval, in seconds, 
that Report Manager will suppress duplicated error messages. The default is 
3600 seconds (one hour). This means that Report Manager will not send a 
similar e-mail message within the specified time interval. Report Manager 
does this by comparing the timestamp on duplicate messages. If the 
difference in time is less than the event resend interval, Report Manager will 
suppress the message.
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• Check for Events to be mailed every - this is the time interval, in 
seconds, that Report Manager will flush or send out email messages. The 
default is five seconds.

• Num of Messages Per Minute - this is the maximum number of e-mail 
messages that Report Manager can send per minute. This allows you to set a 
limit on the total number of messages you may receive every minute.

• Num. of Events Per Email Message - this is the number of events that 
Report Manager will group and send in a single email. The default is one. So, 
by default, Report Manager will send an e-mail for every event.

4. Click in the Enable more detailed information checkbox if you want Report 
Manager to include more detailed information in the e-mail message (i.e., host 
name, event severity level, event summary, first and last occurrence of the 
event, and the repeat count).

5. Use the Include events of Severity Level pull-down menu to select the 
severity level of events at which an e-mail is generated. Report Manager will 
send you an e-mail whenever any “critical” event occurs by default.

6. Check the checkbox corresponding to the specific types of alarms that you wish 
to receive an e-mail notification in the And these events field. You can choose 
to receive an e-mail notifying you of a traffic alarm, attack alarm or any other 
misc. alarm. For example, if you check the traffic alarm checkbox, you will 
receive an e-mail notifying you of all traffic alarms in addition to those events 
that match the severity level you set in the Email Severity Level.

Event Aggregation
Report Manager groups or “aggregates” duplicate event messages received within a 24 
hour time period. This helps to reduce the amount of similar information that is sent to 
the Monitor Console and in the database. Report Manager does this by comparing the 
timestamp on duplicate messages. If the difference in time is less than 24 hours, Report 
Manager will suppress the duplicate message.
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Depending on your specific business needs, you may want to consider disabling message 
aggregation to improve performance on the Data Collector. To disable event aggregation, 
uncheck the Enable Collapsing of duplicate messages checkbox in the Event Settings 
tab of the Data Collector profile.

Refer to Disabling Event Message Aggregation in Chapter 7 for more information.

Event Buffer Size
For tuning purposes, you can also decrease the maximum cache size of logs and events 
that the Data Collector will keep for each specific device type. This will decrease the 
amount of information that the Data Collector will need to store temporarily.

To decrease the event buffer size, decrease the Buffer Size field corresponding to the 
Device Type that you wish to adjust from the Event Settings tab.

Note: You can only set the event buffer size for a Data Collector on a per device-type basis.
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Refer to Decreasing the Event Buffer Size in Chapter 7 for more information.

Database Event Filters
Each Data Collector forwards all event information (except traffic logs) to the Master 
Controller for storage on the database by default. For tuning and disk management 
purposes, you may want to disable the storing of select information on the database.

To configure events stored on the database:

1. From the Data Collector profile, select the Event Settings tab.

2. In the DB Logging section, click on the + sign corresponding to the Event Type in 
the DB Logging section that you want to configure. A list of sub types for the 
event type appears.

Note: If you set the maximum cache size on a device type to 1, you are effectively disabling 
message aggregation on the Data Collector. This is because you have set the buffer to hold 
only 1 message in its cache. Once a Data Collector receives a new message, it has no room 
to store it, so it replaces the existing message. This causes the Data Collector to 
automatically forward new messages to its listeners.
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3. Uncheck the Log checkbox corresponding event sub type that you do not want 
stored on the database.

4. Click OK to return to the Data Collector profile window.

Recording Traffic Logs
There are two ways that you can currently record traffic logs (i.e., for auditing purposes). 
You can store them on the database (not recommended) or you can store them in local flat 
files on the Data Collector (highly recommended).

You can store as many traffic log files on the Data Collector as you want as long as you 
have made adequate accommodations for the disk space required. Report Manager 
stores a fixed maximum of 10 MB per traffic log file. You can set the total disk space 
that Report Manager will use to store traffic log files on the Data Collector by configuring 
a limit on the number of traffic log files that Report Manager will create. For example, if 
you configure the maximum number of traffic log files to 50, Report Manager will save 500 
MB of traffic log information (10 MB in 50 log files).

Once the limit is reached, Report Manager will purge the oldest file and re-write that file 
with the most current traffic log information by default. You can change this behavior by 
configuring the Data Collector to stop writing to new logs.

Report Manager will send you an e-mail alert notifying you when the disk space on the 
Data Collector approaches approximately 70% of the maximum disk space limit.

To record traffic logs on the Data Collector:

1. From the Data Collector profile, select the Traffic Log tab.

2. Click in the Enable traffic log storage in DC check box.
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3. Report Manager stores a maximum of 10 MB per traffic log file on the Data 
Collector by default. If you want to edit the maximum number of traffic log files 
stored, use the pull-down menu to select the Number of traffic log files that 
you want to store.

4. Click to select the Rewrite oldest file or Stop saving radio button to specify 
how you want the Data Collector to manage your traffic log files when you have 
reached the number of traffic log files limit. The Data Collector is configured to 
purge the oldest file when the limit is reached by default. If you want to change 
this behavior, click to select the Stop saving radio button. With this set, the Data 
Collector will no longer record traffic logs when it reaches the number of log files 
limit.

The Data Collector will save all fields in the traffic log record as a row in a CSV file. The 
traffic log files are named log.<year>.<month>.<date>.<time>. 

So, for example, if you created a log on September 16th 2002, at 4:54:37AM, the file name 
for the log would be “log.2002.09.16.04.54.37”. 

Traffic log files are stored in the path specified in Path to save Logs field on the Failover 
Settings tab. The default directory for the logs is <DC_Install_Directory>/devlog/
trafficlog.

Note: The values for <year>.<month>.<date>.<time> in the file name are recorded 
according to Greenwich Mean Time (GMT). This is to be consistent with the way time is 
recorded in the "End Time" column in the Traffic Log Report.

Notes on archiving traffic log files: It is highly recommended that you store the logs 
that are collected on each of the Data Collector's to a central RAID system on a daily basis. 
You can do this by writing a script, launched as a cron job nightly, that uploads the logs to 
the central repository. This cron job would run on every Data Collector that stores the 
traffic logs to disk. At the specified time, the script would copy all the files in the "trafficlog" 
directory to the RAID system, except the most recently created file. This file should be 
excluded as it is being currently used. After the archive, delete all the archived files from 
the Data Collector's traffic log directory so they are clean for the next day's files. 

On the central RAID server, the logs collected for that day should be stored under that day. 
For example, logs collected from all Data Collector's on October 30th should be stored 
under the log_10_30_2002 directory. Due to traffic log filename conflicts, the script needs to 
check for the existence of the file before copying to that day's location. If the file already 
exists, it is recommended that you append the data to the existing file. This allows for 
generating of reports across all Data Collectors by specifying a common directory location 
in the Report Manager Console (assuming that the location is reachable from the Data 
Collector that runs the query).
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Recording Traffic Logs On the Database
Previous versions of Report Manager supported the recording of traffic logs on the 
database. Although the option to record traffic logs on the database remains (i.e., on the 
Traffic Log tab), this is not recommended because traffic logs can typically generate an 
inordinate amount of traffic causing a significant performance degradation on the Data 
Collector.

Viewing Traffic Log Reports
Report Manager allows you to view information in each traffic log that is stored on a Data 
Collector. Refer to Viewing Traffic Log Reports in Chapter 5 for more information on 
viewing traffic log reports.

Device Polling Intervals
For tuning purposes, you can also configure the intervals with which each Data Collector 
polls its devices for certain statistics. From the Data Collector profile, select the Device 
Polling tab. Use one of the following pull-down menus to edit the default polling interval:

• Poll Device Statistic every - this is the time interval, in seconds, that the 
Data Collector will poll its devices for device-specific statistics. The default is 
300 seconds.

• Poll VPN Statistics every - this is the time interval, in seconds, that the Data 
Collector will poll its devices for VPN statistics. The default is 300 seconds.

• Poll NSRP Statistics every - this is the time interval, in seconds, that the 
Data Collector will poll its devices for NSRP statistics. The default is 300 
seconds.

Note: If you enable traffic log storage on the DC, this will not have any effect on whether or 
not you have configured the recording of traffic logs to the database. You will need to verify 
that the option to record traffic logs to the database is disabled to acheive higher 
performance.

Note: The option to enable the forwarding of traffic logs to the database will become 
obsolete in future releases of Report Manager.
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• Poll Interface Statistics every - this is the time interval, in seconds, that the 
Data Collector will poll its devices for interface statistics (i.e., Ethernet, Flow, 
and Attack statistics). The default is 60 seconds.

Save Statistics to Database Intervals
Use the following pull-down menus in the Data Collector Database Settings tab to 
configure the intervals with which each Data Collector forwards certain statistics to the 
the database.

• Save Device Statistics to DB every - this is the time interval, in seconds, that 
the Data Collector sends its device statistics to the database. The default is 3600 
seconds.

• Save VPN Statistics to DB every - this is the time interval, in seconds, that 
the Data Collector sends its VPN statistics to the database. The default is 7200 
seconds.

• Save NSRP Statistics to DB every - this is the time interval, in seconds, that 
the Data Collector sends its NSRP statistics to the database. The default is 7200 
seconds.
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You can also configure the intervals with which each Data Collector forwards or “flushes” 
its log and alarm messages to the database by using the Save Events to DB every pull-
down option. This is the time interval, in seconds, that the Data Collector will flush 
buffered log and alarm messages to the Master Controller for storage on the database. 
The default is 60 seconds.

Refer to Increasing Device Polling Intervals and Increasing Save Statistics to Database 
Intervals in Chapter 7 for more information on tuning Report Manager using these 
properties.

Netcool Integration (optional)
If you are using the Data Collector together with the NetScreen-Global PRO Integration 
Module for Netcool, a configuration tab called NetCool will appear in the Data Collector 
profile. Select this tab to configure properties for Netcool integration enabling the 
forwarding of Data Collector events to Netcool's FDF server. You can configure the 
following properties:

• FDF Server IP Address - this provides the FDF server’s IP Address for the 
Data Collector to forward information to Netcool.

• FDF Server Port - this is the communication port that the Data Collector uses 
to connect to the FDF server.

• Enable FDF client Flag - this allows you to enable or disable the forwarding of 
messages to Netcool.

Warning: Do not set the FDF Server IP address property in the tab to "0.0.0.0".   
If you do, the Netcool configuration tab will no longer appear in the Data 
Collector profile. Enabling and disabling of Netcool is allowed only when there is 
a non-zero value for the FDF IP address.
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Deleting a Data Collector
There are occasions in which you might need to delete a Data Collector, for example, if you 
want to “relocate” a Data Collector, or bring down a Data Collector for adding memory or 
backing up a system.

1. Verify that you have stopped Data Collector.

2. Select the Data Collector that you want to delete in the List pane. 

3. Click on the Delete icon in the Report Manager Console tool bar. Alternatively, 
you can also right-click on a Data Collector in the List pane and select Delete. A 
dialog box asks you to confirm the deletion.

4. Verify that you have selected the correct Data Collector, and then click Yes.

Viewing All Data Collectors
Once you add a Data Collector in the Report Manager system, Report Manager stores all 
the information that you have configured for the Data Collector in the database. You can 
view a list of all Data Collectors in the Report Manager system by generating an All DC 
Information report from the Historical Reports Console.

Refer to Using Administration Reports in Chapter 4 for more information on the All DC 
Information report.

Warning: This operation cannot be undone. When you delete a Data Collector, all the 
devices sending data to the Data Collector will stop doing so. You must create new 
associations with another Data Collector before you delete the Data Collector.
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ADDING AND CONFIGURING DEVICES
Use the Report Manager Console control pane to first add, and then configure your 
devices in Report Manager. To add a device you will need to enter basic information 
identifying it (i.e., serial #, user name and password) and the primary and secondary (if 
applicable) Data Collector to which it is assigned.

Importing Devices
If you are using Report Manager together with NetScreen-Global PRO Policy Manager, 
you can import information describing all your devices within a specific domain from a 
device list. A device list is a file that you can export from Policy Manager that contains 
information about your NetScreen devices (i.e., serial number, host name, IP Address 
etc...).

Configuring Mapped IP Addresses
If your Data Collector is located on a computer behind a firewall you will need to provide 
the mapped IP address for the Data Collector. The mapped IP file uses the following 
format:

Original IP Address = Mapped IP Address

For example: 10.150.12.24 = 192.111.23.25

To automatically map a Data Collector’s IP address:

1. From the Import Device List window, click in the Use Mapped IP for Data 
Collector checkbox. The Load Map File button appears active.

2. Click on the Load Map File button. A window will appear allowing you to 
browse to the map file.

3. Browse to the map file and open it. The Import Device List reappears.

4. Click on the Start Import button to import the file.

When the import completes, Report Manager adds the original IP address and the 
mapped IP address to the device, and communicates with the device to import the data 
needed from it. Once it reads the information, it adds the device to Report Manager.

Importing a device list
1. From the File menu, select Import Device List. The Import Device List 

window appears.

2. Click in the Telnet or SCS checkbox to select a method with which to 
communicate with the devices for importing configuration information.

Note: Refer to the NetScreen-Global PRO Policy Manager documentation for additional 
information describing how to export a device list.
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3. Click on the Start Import button. A window will appear allowing you to browse 
to the exported device list file.

4. Browse to the exported device list file and open it. The serial numbers and IP 
addresses of all the devices that were exported in the device list will appear in 
the Devices field with a corresponding import result. The status of the operation, 
for each device imported, is displayed in the Result field. Report Manager 
displays any errors that may have occurred during the import in the Error 
Description field.

5. Click Close when you are done.

Importing Device Information from a Text File
You can also import a device list from a text file. If you are creating a text file to import 
device information into Report Manager, you should enter the following information on a 
single line for each device:

• Serial Number

• Primary Data Collector

• Secondary Data Collector

• IP Address

• User Name

• Password

For example you would create the following entry:

SN=03000203,HN=ns100,PDC=10.150.41.233,SDC=172.16.10.250,IP=1
0.150.41.232,User=netscreen,Password=netscreen

Note that it is not necessary to populate every field. For example, you could create the 
following entries:

IP=10.150.41.232,User=netscreen,Password=netscreen

SN=03000203,HN=,PDC=10.150.41.233,SDC=,IP=,User=,Password=

SN=03000203,HN=ns100,PDC=10.150.41.233,SDC=10.150.41.240,IP= 
10.150.41.232,User=netscreen,Password=netscreen

Adding a Device
You can also manually add the devices that you want to monitor in Report Manager. Refer 
to Adding Devices in Chapter 2 for more information on adding a device.

Configuring Devices
Once you have added a device, you can configure failover and polling attributes 
determining how the device works with Report Manager.

Refer to Implementing Failover Protection in Chapter 11 for more information on 
configuring your Data Collectors for failover.
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Configuring Polling Attributes
The Data Collector polls its devices every 60 seconds for protocol distribution and policy 
table information by default. This polling interval is configurable.

To modify the polling interval:

1. Select a device from the List pane. The device profile appears in the Details 
pane.

2. From the Information tab, click in the Poll Devices every <n> seconds for 
Protocol Distribution field to configure the polling interval used for protocol 
distribution tables.

3. Click in the Poll Devices every <n> seconds for Policy Table field to 
configure the polling interval used for policy tables.

4. Click on the Save icon in the Report Manager Console toolbar to save your 
changes; or click the Undo icon to cancel your changes.

Configuring the Device to Send Specific Information
To improve your overall system performance, you can also control the types information 
that a device will send to Report Manager. Refer to Disabling Information Sent From the 
Device in Chapter 7 for more information on tuning the device.

Note: It is recommended that you not set the polling interval below 60 seconds.
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Read-only Device Attributes
You can not configure the device details and contact information that appear in the Device 
Profile. Device Details and Contact Information are collected from the device 
automatically after the device connects to the Data Collector.

Report Manager Configuration Priority
Report Manager will overwrite any changes that you make to the device configuration 
outside of Report Manager.

Deleting a Device
1. Click on the Devices button in the Control pane. Report Manager displays a list 

of all current devices created in the system in the List pane.

2. Select the device that you want to delete from the List pane.

3. Click on the Delete icon in the Report Manager Console toolbar. Alternatively, 
you can also delete a device by right-clicking in the List pane and selecting 
Delete; or by using the Edit menu and selecting Delete. A message appears 
asking you to confirm your choice.

4. Confirm your selection, and then click Yes.

Exporting a Device List
Exporting a device list allows you to keep a copy of your current device list in case you 
need it later to import.

1. From the File menu, select Export Device List. A window appears allowing 
you to browse to a destination directory where you want to save the export list.

2. Browse to the desired file and click Save.

Viewing All Devices
Once you add a device in the Report Manager system, Report Manager stores all the 
information that you have configured for the device in the database. You can view a list of 
all devices in the Report Manager system by generating an All Device Information report 
from the Historical Reports Console.

Refer to Using Administration Reports in Chapter 4 for more information on the All 
Device Information report.

Note: Deleting a device from Report Manager will not effectively remove the device from 
the Policy Manager configuration or from the database
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ADDING AND CONFIGURING DEVICE GROUPS
Once you have added your devices, you can then map them into logical groupings. This 
will allow you to more easily view and manage your devices in Report Manager. To do 
this, use the Report Manager Console to add device groups and then assign your devices 
to them. For example, you could create a device group for the devices that you have 
implemented for each customer or region. You can later assign privileges to specific users 
allowing them access to their own groups.

Adding a Device Group
1. Click on the Device Groups button in the Control pane. Report Manager 

displays a list of all current Device Groups created in the system in the List 
pane.

2. Click the Add button in the Report Manager Console tool bar. Alternatively, you 
can right-click in the List pane and select Add. You can also click on the Edit 
menu and select Add. A template allowing you to configure a new Device Group 
appears in the Details pane.

3. Enter any applicable information in the Contacts tab.

4. Click on the Save icon in the Report Manager Console toolbar to save your 
changes. The device group now appears in the List pane. Or, click on the Undo 
icon to cancel your changes.

Assigning a Device or Virtual System to a Device 
Group

1. Select a Device Group from the List pane.

2. Click on the Devices tab. Select the devices that you want to add to the Device 
Group from the list of available devices. Click on the Add button to add them. 
The device(s) now appears in the list of Selected Devices.

3. Click on the Virtual Systems tab. Select the virtual systems that you want to 
add to the Device Group from the list of Available Virtual Systems. Click on the 
Add button to add them. The virtual system(s) now appears in the list of 
Selected Virtual Systems.

4. Click on the Save icon in the Report Manager Console toolbar to save your 
changes. The device group now appears in the List pane. Or, click on the Undo 
icon to cancel your changes.
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Removing a Device or Virtual System from a Device 
Group

The process of removing a device or virtual system from a Device Group is similar to the 
procedure described for assigning a device/virtual system to a device group. To remove a 
device/virtual system from a device group, use the Remove button in the Devices or 
Virtual Systems tab to remove the device/virtual system from the list of Selected Devices/
Virtual Systems.

Deleting Device Groups
1. Click on the Device Groups button in the Control pane. Report Manager 

displays a list of all current device groups created in the system in the List pane.

2. Click on the Delete icon in the Report Manager Console tool bar. Alternatively, 
you can also delete a device group by right-clicking in the List pane and selecting 
Delete; or by using the Edit menu and selecting Delete. A message appears 
asking you to confirm your choice.

3. Confirm your selection, and then click Yes.

Warning: Deleting a Device Group will not delete any device history in the database.
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USING HISTORICAL REPORTS TO HELP YOU MANAGE YOUR 
REPORT MANAGER SYSTEM

You can generate many useful reports to help you administer and manage your groups, 
users, Data Collectors, and devices from the Historical Reports Console. For example, you 
can use the HR Console to generate a report listing and providing details of all the users 
that you have added in the Report Manager system.

You can also generate a report listing all the users and groups that have read and write 
privileges on specific devices in your network.

Refer to Using Administration Reports in Chapter 4 for more information on the All 
Device Information report.
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5
Chapter 5

Monitoring Real Time 
Information

Report Manager allows you to proactively monitor the status of your NetScreen security 
system from a central location, the Report Manager Monitor Console. Through the 
Monitor Console, you can monitor real-time information about your NetScreen devices 
including the up/down status of your NetScreen devices, protocol and policy usage trends, 
performance baselines and security events.

This chapter provides information that describes the Monitor Console and how you can 
use it to monitor your NetScreen devices effectively. It describes how you can create and 
modify Display Filters that allow you to monitor event summaries. It also provides 
information describing how you can access more detailed device, event and traffic 
information using other consoles including the Device Monitor and Event Monitor; as well 
as the VPN Monitor and NSRP Monitor where you can monitor the status of any VPN 
and/or NSRP that you may have implemented.

This chapter includes the following sections:

• Using the Monitor Console

• Monitoring Device Status

• Monitoring Additional Device Details

• Monitoring Event Summaries

• Monitoring Event Information

• Monitoring Individual Device Statistics

• Monitoring VPN Status

• Monitoring NSRP Statistics

• Viewing Traffic Log Reports
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USING THE MONITOR CONSOLE
Use the Monitor Console to monitor real-time information about your NetScreen devices 
including the up/down status of your NetScreen devices, protocol and policy usage trends, 
performance baselines and security events. You can also use the Monitor Console to 
monitor an Event Summary, which provides a histogram view of events that are occurring 
on your devices.

Event alert icons and color-coded bar graphs notify you of potential issues. From the 
Monitor Console, you can also access other consoles for more detailed information on your 
devices, the events that are occurring on them, your VPN, and NSRP.

Device Status Summary - displays 
a summary status of each of your 
NetScreen devices.

Control Pane - allows access to other monitoring consoles.

Display Filter - list of display 
filters that you have currently 
configured.

Event Summary - graphical display 
summarizing events categorized by se
verity level as they occur on each devi

Status Bar displays the currently active dis-
play filter.
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About the Monitor Console Panes
The Monitor Console has four main components:

• Device Status Summary

• Event Summary

• Display Filter pane

• Monitor pane

In addition, a status bar that appears at the bottom of the Monitor Console displays the 
currently active display filter and any query that is in progress.

Device Status Summary
Use the Device Status Summary to get an at-a-glance view of the up/down status of each 
of your NetScreen devices in real-time. Devices that are up and running are indicated in 
green; devices that are down are indicated in red. You can also configure event alert icons 
to appear as relevant events occur on each device. Double-click on a specific device to 
launch the Device Monitor where you can view additional details about a device.

Event Summary
Use the Event Summary to get an at-a-glance view of the events that are occurring on 
your NetScreen devices in real-time. Create and apply additional display filters to 
summarize the events you want to see on the devices that you are interested in. Each 
display filter provides a color-coded bar graph making it easy for you to detect events by 
severity level. Double-click on a specific event summary view to launch the Event Monitor 
where you can view additional details about those events.

Display Filter pane
Use the Display Filter pane to view a list of all the display filters that are currently 
configured and applied. The display filter that is currently active appears highlighted.

Monitor pane
Use the Monitor Pane to access more detailed information on devices (Device Monitor), 
events (Event Monitor), VPN (VPN Monitor), and NSRP (NSRP Monitor).
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Customizing the Monitor Console Interface
You can customize the following elements of the Monitor Console interface according to 
your viewing preferences:

• Adding or Removing Columns

• Adjusting Console or Column Borders

• Moving the Toolbar

• Hiding Toolbar Names

Adding or Removing Columns
1. Use the View menu and select Column. The Configure Columns window 

appears.

2. To add a column from the Monitor display, select the column that you want to 
view from the list of Available Columns, then click the Add button. The column 
that you selected will now appear in the list of Selected Columns.

3. To remove a column, select the column that you want to remove from the list of 
Selected Columns, then click the Remove button. The column that you selected 
will now appear in the list of Available Columns.

4. Click OK when you are done.
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Adjusting Console or Column Borders
You can adjust the size of the console and any column by placing your mouse over the 
console or column border. Arrows will appear indicating the direction in which you can 
move the border. Click and drag the console or column border to the length or width that 
you wish.

Moving the Toolbar
You can move the toolbar that appears at the top of the Monitor Console to any part of the 
desktop. Click on the toolbar pane that appears to the left of the toolbar buttons and drag 
the toolbar anywhere on the desktop.

Click and drag on any console or 
column border to the length or 

width that you wish.

Click on the toolbar pane and drag the toolbar to 
your desired location anywhere on the desktop.
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Hiding Toolbar Names
You can also hide the toolbar names that appear at the top of the Monitor Console. From 
the View menu, select Toolbar Names. Notice that the titles no longer appear on the 
Exit and Display Filter buttons.

Sorting All Columns
You can sort any column by manually clicking on the column header. Report Manager 
sorts the column data in ascending order by default. You can customize the Monitor 
Console to sort all tables automatically every time a new record is added. You can also 
choose to sort all tables in descending order.

To change the way Report Manager sorts columns:

1. Use the Tools menu and select Customize. The Customize window appears.

Warning: If you select the Sort-Always option, you may experience some degradation in 
Console performance. It is recommended that you disable the Sort-Always option for 
optimum performance.
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2. If you want Report Manager to sort columns automatically every time a new 
record is added, check the Sort - Always checkbox.

3. If you want Report Manager to sort columns in descending order, uncheck the 
Ascending Order checkbox.

4. Click OK to save your changes; click Cancel to cancel your changes.

Sorting Individual Columns
You can also right-click on any column in the Monitor Console and specify how that 
particular column will sort (i.e., once or always, in ascending or descending order). 
Alternatively, you can use the View menu and select Sort.

Searching for Specific Information
You can also search for any specific text string in the Monitor Console.

1. Use the View menu and select Search. The Search window appears.

2. Click in the Find field and enter the exact text that you are searching for in the 
Find field.

Note: The text string that you enter in the Find What field must be case-sensitive.
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3. Use the Search On pull-down menu if you want to narrow your search to a 
specific information field. If you are unsure which field to search on, select All 
Fields.

4. Click on the Next button to continue. Report Manager will highlight all search 
results in the display. If the search produces no results, a dialog will appear 
indicating that Search cannot find the specified pattern.

5. Click on the Previous button if you wish to view the previous search result.
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MONITORING DEVICE STATUS
Use the Device Status Summary to get an at-a-glance view of the up/down status of your 
NetScreen devices. Devices that are up and running are listed by device name and appear 
by default at the top of the summary pane colored green. Devices that are down are listed 
by the device’s serial number and are colored red.

If you have configured a NetScreen device to act as a virtual system, you will notice that 
they appear below the device in the tree hierarchy and are colored lavender.

Sorting Devices by Status
You can sort all devices according to their status by clicking on the blue arrow that 
appears in the summary header.

Configuring Visual and Audible Event Alerts
You can configure Report Manager to alert you both visually and audibly of certain events 
as they occur on each device. When an event of a specified frequency occurs a set number 
of times, a red exclamation point icon will appear on the device icon in the Device Status 
Summary. You can also configure Report Manager to sound an audible alert when an 
event occurs.

Report Manager totals 
the number of devices 
that are either up and 
running or down and 

displays that total next 
to the corresponding 

status. 

Click on the blue arrow to 
sort all devices according to 

their status.Devices that are up 
and running appear in 
green; devices that are 

down appear in red.
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1. From the Edit menu, select Alert Settings. The Alert Settings window will 
appear.

2. Use the Severity Level pull-down menu to select the severity level of the event 
that you wish to receive an alert.

3. Click in the Number of Events field and enter in the number of occurrences of 
an event that will trigger an event alert.

4. Click in the Audible Alert checkbox to have Report Manager alert you audibly 
whenever an alert event occurs.

5. Click OK to apply your changes; click Cancel to cancel your changes.

Acknowledging an Event Alert
Once you receive an event alert, you can remove it by right-clicking on the device icon and 
selecting Acknowledge. Alternatively, you can also use the Edit menu, and select 
Acknowledge.
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MONITORING ADDITIONAL DEVICE DETAILS
Use the Device Monitor to view additional details on all your devices. Click on the Device 
Monitor button in the Monitor pane to launch the Device Monitor.

Monitoring Device Status
From the Device Monitor, you can view the following details about the status of all the 
NetScreen devices that you have configured in Report Manager:

• key details describing the device (i.e., SN#, type, operation mode)

• up/down status

• time-related statistics (i.e., last connect, reboot etc...)

The following table describes all of the information that is available from the Device 
Monitor:

Item Displays...

Serial No the serial number of the device.

Operation Mode the current operation mode of the device. This can be either NAT, 
Transparent, or Route.

Last Known Connect 
Time

the last time the device connected to the Data Collector. Use this to determine 
how long a device was down.

Last Reboot Time the last times the device was rebooted. Use this to determine how long a 
device was down.
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Report Manager also allows you to view additional information that may help you to 
diagnose and troubleshoot a problem with your NetScreen security system.

For additional statistical information on a device, refer to the section titled Monitoring 
Individual Device Statistics. For additional information on events occurring on your 
devices, refer to the sections titled Monitoring Event Summaries and Monitoring Event 
Information.

Last Known Uptime the last time the device was up-and-running (only if a device is down).

GMT Time Offset 
(hours)

whether or not the device is set to Greenwich Mean Time.

DayLight-Saving whether or not daylight savings time is enabled.

Hostname/IP (Address) set host name and IP Address of the device.

Status whether or not the device is up or down.

Type the type of device.

Firmware Version the firmware version of the device.

Note: If an N/A appears in a column, then that device might have an older ScreenOS 
version.

Item Displays...
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MONITORING EVENT SUMMARIES
Use the Event Summary to get an at-a-glance summary view of events that are occurring 
on your NetScreen devices in real-time. Events are categorized according to their 
perceived severity and displayed in color-coded bar graphs allowing you to easily detect 
and identify event trends.

There are six pre-defined severity levels:

• Critical

• Major

• Minor

• Warning

• Indeterminate

• Clear

Event Aggregation
Report Manager reduces the overall number of events displayed on the Monitor Console 
through a process called aggregation. By aggregating or de-duplicating events, Report 
Manager provides a single error message with a count of how often this type of event 
happened over a given time period. So, for example, instead of documenting all 35 
instances of a Device Memory Low event for a particular device, Report Manager 
documents only the first and last occurrence of an event and the number of entries. This 
data aggregation reduces the total volume of data that must travel over the network, and 
more importantly, that must be processed by the security administrator.

Point your cursor over the bar graph to get a 
count of the messages summarized.
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Each event has an identifier field that Report Manager uses as a key. If an event detects 
an identical key, that event is consolidated (aggregated) to the first occurrence of that key. 
If the event uses a new key, then a new entry is added to the Event Monitor viewer.

Only cached events with the first occurrence sharing the same date are candidates for 
event aggregation. Events with a new date are treated as new events. Refer to Event 
Aggregation in Chapter 7 for more information on event aggregation.

Customizing Event Summary Information
You can customize the look and feel of the Event Summary pane by:

• Configuring Severity Levels

• Adjusting Severity Level Colors

• Setting the Total Number of Event Summary Views

• Adjusting the Time That Events Are Displayed In

Configuring Severity Levels
Report Manager assigns each event type a specific severity level by default. Depending 
upon your specific business requirements, you can change the severity level assigned to 
each event.

1. From the Report Manager Console, select System Options from the Tools 
menu. The System Options window appears.

2. Click on the + icon to expand and view the event sub types for each event type.
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3. Use the Severity Level pull-down menu and select the severity level you wish 
to assign to the event sub-type.

4. Click OK when you are done; Click Cancel to cancel your changes.

5. Report Manager will display a dialog prompting you to restart your Monitor 
Console for your changes to take effect. Click Yes to proceed.

Adjusting Severity Level Colors
Report Manager displays event categories in different colors according to their severity 
level. For example, Report Manager displays Critical events by default in red; Clear 
events by default in green. You can change these color associations to suit your own 
personal preference.

1. From the Tools menu, select Customize. The Customize window will appear.

2. Select the Severity Level - Color tab. The Severity Level - Color window will 
appear.

3. Click on the down arrow that appears to the right of the color and severity level 
that you wish to adjust. The Select Color window will appear.
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4. From the Swatches tab, click on the color that you wish to use. A sample of the 
color that you have chosen will appear in the Preview panel. The Recent section 
displays colors that you have previously sampled. The last color saved is 
displayed in the upper, half of the color bar sample. Click Reset to return to the 
color shown in the color bar sample.

5. If you wish to adjust the hue, saturation, and brightness of the color, click on the 
HSB tab. Click and drag on the sliding scale to adjust the HSB to your 
preference.

6. If you wish to adjust the red, green, and blue attributes of the color, click on the 
RGB tab. Click and drag on the sliding scales to adjust the RGB to your 
preference.

7. Click OK when you are done.

8. Click OK to apply your changes; or click Cancel to cancel your changes.



Monitoring Event Summaries

NetScreen-Global PRO 149

Click on the down arrow that appears 
right of the color and severity level that 

you wish to adjust.

Click on the color that 
you want to use.

Select the HSB 
or RGB tabs to 
fine tune your 
selected color.

For example, if you wanted to adjust the 
color associated with the Clear severity 
level from green to blue, you would set 

the Color Mapping as follows:
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Setting the Total Number of Event Summary Views
The maximum number of active event summary views that you can display in the Event 
Summary is four by default. If you exceed the specified number, you will receive an error 
message. Report Manager allows you to increase or decrease the number of event 
summary views displayed in the Event Summary depending upon your preference.

1. From the Tools menu, select Customize. The Customize window will appear.

2. From the Options tab, click in the Number of Summary Views field and 
enter the number of views you wish to allow.

3. Click OK to apply your changes; or click Cancel to cancel your changes.

Adjusting the Time That Events Are Displayed In
Report Manager also allows you to view the time in which events occur in your local time 
zone or in greenwich mean time (GMT).

1. From the Tools menu, select Customize. The Customize window will appear.

2. From the Options tab, check the Display Time in GMT zone (All Events) 
checkbox.

3. Click OK to apply your changes; or click Cancel to cancel your changes.

For example, if you wanted to increase the number of event summary views from 
4 to 6, you would set the Number of Summary Views as follows:
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MANAGING EVENT SUMMARIES
Depending upon the size and type of your NetScreen security system, your devices can 
generate literally thousands of conditions and events (i.e., alarms, logs, etc.) on a daily 
basis.

Using the Monitor Filter
To help manage the amount of information sent to and viewed on the Monitor Console, 
Report Manager initially applies a Monitor filter to the data that is received from each 
Data Collector. The Monitor Filter allows you to set certain criteria defining which 
information is allowed to pass from the Data Collectors to the Monitor Console.

The Monitor Filter is initially set to allow events for all devices, event types, and severity 
levels. You may want to reconfigure the Monitor Filter to better manage the total amount 
of information received by the Console. Refer to Configuring the Monitor Filter in Chapter 
7 for more information on configuring the Monitor Filter.

Default Event Summary View
Report Manager summarizes the event information from the Monitor Filter in an initial 
event summary view called Default.

Note: You cannot change or delete the Default filter.
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Stopping and Starting the Monitor Filter
If for any reason, you want to stop the Monitor Filter from collecting information, use the 
Monitor Filter menu, and select Stop Receiving Logs. When you want to re-apply the 
Monitor Filter, use the Monitor Filter menu, and select Start Receiving Logs.

Creating Display Filters
If you wish to monitor more specific information about your devices and virtual systems, 
you can create additional display filters. A display filter allows you to further sort and 
summarize events from the set of information already being collected by the Monitor 
Filter.

1. From the Display Filter menu, select New. The Display Filter Definition 
window appears.

2. Click in the Filter Name field and enter a specific name for the filter.
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3. If you wish to view information from a specific time, check the Timestamp 
check box and enter the desired time.

4. Click on the Save button. Alternatively you can use the File menu and select 
Save Filter. A dialog will prompt you to specify a file name for the filter and a 
directory path where you want to save the filter.

Report Manager saves each display filter as an.ndf (NetScreen Display Filter) file. The file 
is saved in a folder called “Display Filter” on your local drive by default.
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Configuring Display Filter Conditions
1. Select the desired display filter from the Display Filter pane.

2. From the Display Filter menu, select Modify. Alternatively, you can also 
right-click on the desired filter, and select Modify. The Display Filter Definition 
window appears.

3. Click on the Add icon. Alternatively, you can use the Edit menu, and select Add 
Condition.

4. Enter the new Condition Name.

5. Select the device(s) that you wish to monitor. Double-click on All Devices to 
view all available devices. Click the + or - icon to expand or collapse the list of 
devices.

6. Select the events or event type that you wish to monitor. Double-click on All 
Events to view all available events. Click the + or - icon to expand or collapse 
the list of events.

7. Use the And/Or drop-down to include events of a certain severity level. Use the 
Severity drop-down to select a specific severity level.

8. Click on the Save button. Alternatively you can use the File menu and select 
Save Filter.
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Applying the Display Filter
Once you have created your display filter, you will need to apply it. Click on the Apply 
button or use the File menu and select Apply Filter. The new display filter appears in 
the Event Summary pane.

Managing Display Filters
Once you have created a display filter, you can later rename, modify, or delete it.

Renaming Display Filters
1. Select the desired display filter from the Display Filter pane.

2. From the Display Filter menu, select Rename. Alternatively you can also 
right-click on the desired filter, and select Rename. A Rename Filter pop-up 
window appears.
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3. Enter a new name for the display filter.

4. Click OK to apply your changes; click Cancel to cancel your changes.

Deleting Display Filters
1. Click to select the desired display filter.

2. From the Display Filter menu, select Delete. Alternatively you can also right-
click on the desired filter, and select Delete. A pop-up window will appear 
prompting you to confirm the deletion.

3. Click Yes to confirm the deletion. Click No to cancel the deletion.
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MONITORING EVENT INFORMATION
If the Event Summary pane indicates a potential issue, you can use the Event Monitor to 
view more specific information about the events summarized in each display filter. To 
launch the Event Monitor for a specific display filter: click to select a display filter from 
the Display Filter pane or Event Summary pane, then click on the Event Monitor button 
to launch the Event Monitor. Alternatively, you can use the View menu, and select Event 
Monitor.

Sorting Events by Count
You can sort all events according to the number of times that they have occurred by 
clicking on the blue arrow that appears in the Count header.

Event-specific Information
From the Event Monitor, you can view the following details about each event that 
matches the criteria you set in your display filter:

• key details describing the device (i.e., host name, IP address)

• type and subtype of the event that occurred

• number of times that the event actually occurred

• time-related information (i.e., first and last occurrence date and time)

Sort events by count by clicking on the blue 
arrow that appears in the Count header.
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The following table describes all of the information that is available from the Event 
Monitor:

Adding Event Information Notes
If you want to add additional information regarding a specific event:

1. Double-click anywhere in an event. The Event Notes window appears.

2. Click in the Additional Information section and enter your information.

3. Click OK to apply your changes; or click Cancel to cancel your changes.

Item Displays...
Hostname/IP the hostname and IP address of the NetScreen device.
Event Type the main type of event that occurred.
Event Sub Type more information on the type of event that occurred.
First Occurrence the date and time that the event first occurred.
Last Occurrence the date and time that the event last occurred.
Severity the severity level of the event.
Summary a description of the event.
Count the number of times that the event has occurred.

Add any additional information that you may have on 
an event here.
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Exporting Event Logs
Report Manager allows you to transfer event information to an Excel file where you can 
further analyze or track the data. To begin the export process, you will need to pause the 
flow of data to the Event Monitor.

1. From the Event Monitor, click on the Pause button. Alternatively, you can use 
the View menu, and select Pause. This temporarily stops the flow of event 
information to the Event Monitor.

2. Click on the Save button. Alternatively, you can use the File menu and select 
Save. A standard Save dialog opens in a default Reports directory.

3. Enter a name for the file and click Save. Report Manager saves the file as a .csv 
file.

Using Quick Filters
While in the Event Monitor, you can automatically create a display filter that matches the 
conditions that produced a specific event. The display filter that you create “on-the-fly” 
from an event is called a quick filter.

Creating a Quick Filter
From the Event Monitor, right-click on an event and select Quick Filter. Alternatively 
you can select an event, use the Edit menu and select Quick Filter. Report Manager 
launches a new Event Monitor view with the events that match the type that you selected 
for all devices, and adds the new display filter to the Event Summary pane.

Configuring a Quick Filter
When you create a quick filter, Report Manager creates a display filter with conditions 
that match the selected event type, severity level, and device specified by default. You can 
change the way that Report Manager creates a quick filter to have it create a display filter 
with conditions that match all events, devices, or severity levels.
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1. From the Monitor Console, use the Tools menu and select Options. The 
Options window appears.

2. Click on the Quick Filter tab.

3. Click in one of the Devices radio buttons to specify that you want to create a 
quick filter for all devices or only the selected device.

4. Click in one of the Events radio buttons to specify that you want to create a 
quick filter for all devices or only the selected device.

5. Use the Selected Severity Level pull-down menu and select the AND option to 
specify that you want to create a quick filter condition that events must also 
match the severity level of the event selected. Select the OR option to specify 
that you want to create a quick filter condition that events do not need to match 
the severity level of the event selected.

6. Click OK when you are done.
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A quick filter automatically launches an event 
monitor view displaying events that match the 

type that you selected for that device by default.

The quick filter also adds a 
display filter in the Event 

Summary pane.
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MONITORING INDIVIDUAL DEVICE STATISTICS
Use the Device Statistics window to access additional information about traffic, interface, 
zone, and system-related statistics on a specific device. To view Device Statistics, 
double-click on an individual device in the Device Status Summary. Alternatively, you can 
right-click on the device, and select Device Statistics.

Note: If you are not running ScreenOS 3.1.0-NSRP or later, some real-time reporting 
features such as NSRP monitoring, enhanced VPN monitoring, delta reports etc. will not 
be available. Check the “Device” row in the Summary view to see a device’s ScreenOS 
version.

The Device Statistics window provides basic information about a device 
including the device type, version, # of events by type etc....

Click to access traffic, interface, zone or system-related information on the device.
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Viewing the Device Summary
From the Device Statistics Summary, you can view the following details about a specific 
device:

• key details describing the device or virtual system (i.e., SN#, IP address)

• summary of events, alarms and logs on the device

• time-related statistics (i.e., last connect, reboot etc...)

The following table describes all of the information that is available from the Device 
Statistics Summary

Item Displays...
Device Device: Displays the name, serial number and IP address of the device. 

Vsys: Displays just the serial number of the device.
Vsys the name of the virtual system (if applicable).
Version the device’s build, model, and operation mode (this is not displayed in the 

Vsys view).
DC IP the IP Address of the Data Collector the device is contacting (this is 

not displayed in the Vsys view).
Critical Events the total number of Critical events that occurred.
Major Events the total number of Major events that occurred.
Minor Events the total number of Minor events that occurred.
Warning Events the total number of Warning events that occurred.
Intermediate Events the total number of Intermediate events that occurred.
Clear Events the total number of Clear events that occurred.
Attack Alarms the number of attack alarms for this device.
Traffic Alarms the number of traffic alarms for this device.
Misc. Alarms the number of misc. alarms for this device.
Configuration Logs the number of configuration logs for this device.
Information Logs the number of information logs for this device.
Traffic Logs the number of traffic logs for this device.
Self Logs the number of self logs for this device.
Interface Information the employed interfaces. For example, Trust, Untrust, and Self.
Vsys Information the virtual systems associated with this device (this is not displayed in the 

Vsys view).
Last Known Connect 
Time

the last time the device connected to the Data Collector (this is not 
displayed in the Vsys view).

Device Status whether the device is currently up or down (this is not displayed in the Vsys 
view).

Last Reboot Time the last time the system was restarted (this is not displayed in the Vsys 
view).



Chapter 5 Monitoring Real Time Information

164 NetScreen-Global PRO Report Manager User’s Guide

Last Known Uptime If device is “down,” this entry lists the last time it was “up.” Used to 
determine how long a device was down (this is not displayed in the Vsys 
view).

GMT Time 
Offset(Hours)

hour the device is set from Greenwich Mean Time (this is not displayed in 
the Vsys view).

Daylight-Savings whether or not daylight-savings time is enabled (this is not displayed in the 
Vsys view).

Item Displays...
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Device-Specific Views
From the Device Statistics window, you can also access additional views allowing you to 
view and monitor key traffic, interface, zone, and system-related information on a specific 
device. You can also use the Troubleshooting view to send get commands directly to the 
device in order to further diagnose and troubleshoot potential issues.

Click to view how the traffic on 
a device is distributed by either 

policy, protocol or VPN. Click to view how traffic is processed on a 
device over a specific interface or Zone.

Click to view VSD or RTO 
statistics related to clusters 
that you have implemented.

Click to view system related information 
including details on Active Sessions. You 
can also use the Troubleshooting feature 
to send “get” commands to the device.
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The following table describes each device-specific view.

View Type View Allows you to...
Traffic Policy Distribution View traffic on the device distributed by policy. Allows you to 

view a chart of the traffic distribution by policy.
Protocol Distribution View traffic on the device distributed by protocol. Allows you 

to view a chart of the traffic distribution by protocol.
VPN Distribution View the up/down status and active statistics of VPNs on the 

device (if applicable). Allows you to view a chart of the VPN 
distribution by VPN tunnel.

Traffic Logs View traffic log information generated when sessions 
terminate on the device.

Interface Ethernet Statistics View device traffic over specific interfaces. Allows you to 
view a chart of the utilization distributed by interface.

Flow Statistics View device traffic on flow counters over specific interfaces. 
Allows you to view a chart of flow statistics distributed by 
interface.

Attack Statistics View all of the attacks that have occurred on a device over 
specific interfaces. Allows you to view a chart of attacks 
distributed by interface.

Zone Ethernet Statistics View device traffic from specific zones. Allows you to view a 
chart of the traffic distributed by zone.

Flow Statistics View device traffic on flow counters over specific zones. 
Allows you to view a chart of flow statistics distributed by 
zone.

Attack Statistics View all of the attacks that have occurred on a device from 
specific zones. Allows you to view a chart of the attacks 
distributed by zone.

System Resource Statistics View CPU utilization and memory allocation statistics on the 
device. Allows you to view CPU, Memory and Session 
Utilization trends.

Active Statistics View administrator and user activities; active VPNs; and 
authenticated users on a device. Also allows you to view a 
snapshot of the ongoing active sessions on the device.

Self Logs View self logs generated on the device.
System Alerts View information related to low memory and high device 

CPU usage generated on the device.
Troubleshooting Send troubleshooting commands over Telnet or SCS to a 

specific device.
HA NSRP Statistics View NSRP statistics related to clusters created on the 

device.
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Managing Multiple Device Views
To view multiple device views at once, you can choose to either to tile or cascade views.

Tiling Multiple Views
To view multiple device views in the Tile view, use the Window menu and select Tile.
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Cascading Multiple Device Views
To view multiple device views in the Cascade view, use the Window menu and select 
Cascade.
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Viewing Device Traffic Distribution
You can view statistics describing the traffic on a specific device including how the traffic 
is distributed (i.e., either by policy, protocol, or virtual system (if applicable)). You can use 
this information to help you identify those policies, protocols and VPN tunnels that are 
most and least frequently being used on a device.

Viewing Traffic Distribution by Policy
Click on the Policy Distribution button to view device traffic that matches the access 
policies configured for a device. Report Manager first displays a bar graph (under the 
Chart tab) depicting the distribution of data by policy. The graph uses a percentage of the 
absolute number of bytes traveling using the top 10 policies by default.
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The following table describes all of the information that is available from the Policy 
Distribution view..

Item Displays...
Policy ID the number assigned to the access policy when the policy was added to 

the NetScreen device.
Policy Name the name of the policy.
Source Zone Zone of the host generating the connection.
Destination Zone Zone of the host receiving the connection.
VPN Name Name of the Virtual Private Network.
Source IP the IP address of the host generating the connection.
Source IP Mask the IP address mask for the host or network generating the connection.
Destination IP the IP address of the host receiving the connection.
Destination IP Mask the IP address mask for the host or network receiving the connection.
Service the application or service associated with the policy. Examples include 

Mail, FTP, SNMP, AOL, Telnet, and LDAP.
Action the activity to be performed, such as Permit, Deny, Tunnel, etc.
Total Connections the total number of data connections.
Connection Rel% the relative percentage of connections.
Delta Connection the total numerical difference between the current connection value and 

the previous connection value.
Total Bytes the total number of data bytes.
Bytes Rel% the relative percentage of bytes.
Delta Bytes the total numerical difference between the current bytes value and the 

previous bytes value.
Total Packets the total number of data packets.
Packets Rel% the relative percentage of packets.
Delta Packets the total numerical difference between the current bytes value and the 

previous packets value.

Note: Some options are not available for devices running older ScreenOS versions. Check 
the “Device” row in the Summary view to see a device’s ScreenOS version.
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Adjusting Data Depicted Graphically
You can adjust all elements depicted in the graph including the policies, data values (i.e., 
absolute or delta), and type of data (bytes in or out, packets in or out, utilization).

To adjust policies depicted graphically:

1. Right-click within the chart and select Configure Policies. A pop-up allowing 
you to select which policies to view appears.

2. Click to uncheck the Default checkbox.

3. Click to select the policies that you wish to view on the graph from the list of 
Available Policies. Click Add to add the policies that you want to the list of 
Selected Policies.

4. Click to select the policies that you no longer wish to view on the graph from the 
list of Selected Policies. Click Remove to remove the policies from the list of 
Selected Policies.

5. Click OK to apply your changes; or click Cancel to cancel your changes.
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To adjust data and data types depicted graphically:

1. Right-click on the Chart view.

2. From the Data option, select either Delta or Absolute.

3. From the Data Type option, select either Connections, Bytes, or Packets.

4. Click OK to apply your changes; or click Cancel to cancel your changes.
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Viewing Traffic Distribution by Protocol
Click on the Protocol Distribution button to view device traffic that matches the access 
protocols configured for a device. Protocols are predefined services (such as, HTTP, 
SNMP, or Telnet) that are enabled for each device. You can view up to ten protocols. 
Report Manager displays a bar graph similar to the one presented for viewing traffic 
according to policy distribution. The graph uses a percentage of the absolute number of 
bytes traveling using the top 10 protocols by default.

The following table describes all of the information that is available from the Protocol 
Distribution view:

Item Displays...
Protocol the name of the predefined service (like HTTP, SNMP, or Telnet) 

operating on the selected interface.
Interface the type of interface under which the protocol is operating.
Bytes In the number of incoming bytes handled by the protocol through the 

NetScreen device.
Bytes In Rel% Relative percentage of all incoming bytes.
Delta Bytes In the total numerical difference between the current bytes in value and the 

previous bytes in value.
Bytes Out the number of outgoing bytes handled by the protocol through the 

NetScreen device.
Bytes Out Rel% Relative percentage of all outgoing bytes.
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Adjusting Data Depicted Graphically
You can adjust the interfaces (i.e., Trust, Untrust, Management, NSRP, and Self) and 
data depicted graphically in the same way that you adjust the Policy Distribution graphs.

Delta Bytes Out the total numerical difference between the current bytes out value and 
the previous bytes out value.

Packets In the number of incoming packets handled by the protocol through the 
NetScreen device.

Packets In Rel% Relative percentage of all incoming packets.
Delta Packets In the total numerical difference between the current packets in value and 

the previous packets in value.
Packets Out the number of outgoing packets handled by the protocol through the 

NetScreen device.
Packets Out Rel% Relative percentage of all outgoing packets.
Delta Packets Out the total numerical difference between the current packets out value and 

the previous packets out value.
Util. (Absolute) the total number of the utilization of the current device.
Util. (Delta) the total numerical difference between the current utilization value and 

the previous utilization value.
Zone the name of the zone associated with the protocol.

Note: Some options are not available for devices running previous versions of ScreenOS. 
Check the “Device” row in the Summary view to identify the version of ScreenOS that the 
device is running.

Note: Additional options allow you to adjust the data types in the Protocol Distribution 
graph by Bytes In, Bytes Out, Packets In, Packets Out, or Utilization, and by Interface.

Item Displays...
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Viewing Traffic Distribution by VPN (if applicable)
If you are using your devices to implement VPNs, Report Manager allows you to view how 
traffic is being distributed across each different VPN tunnel on the device. Report 
Manager first displays a bar graph (under the Chart tab) depicting the distribution of 
data traveling to and from each VPN tunnel. The graph uses a percentage of the absolute 
number of bytes traveling in to the top 10 VPN tunnels by default.

You can adjust all elements depicted in the graph including the VPN tunnels, data values 
(i.e., absolute or delta), and type of data (bytes in or out, packets in or out, utilization).
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Adjusting VPN Tunnels Depicted Graphically
1. Right-click on the Chart view and select Configure VPNs. A pop-up allowing 

you to select VPNs appears.

2. Click to uncheck the Default checkbox.

3. Click to select the VPN tunnel that you wish to view on the graph from the list of 
Available VPN tunnels. Click Add to add the VPN tunnel to the list of Selected 
VPN tunnels.

4. Click to select the VPN tunnel that you no longer wish to view on the graph from 
the list of Selected VPN tunnels. Click Remove to remove the VPN tunnel from 
the list of Selected VPN tunnels.

5. Click OK to apply your changes; or click Cancel to cancel your changes.

Adjusting Data Depicted Graphically
1. Right-click on the Chart view and select Data, and either Delta or Absolute.

2. Right-click on the Chart view and select Data Type, and either Bytes In, Bytes 
Out, Packets In Packets Out, Utilization, Last Session Duration, Avg Latency, 
Availability.

3. Click OK to apply your changes; or click Cancel to cancel your changes.
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Viewing VPN-specific Information
Click on the VPN Monitor Table tab to view specific information about your VPN. 

From the VPN Monitor Table, you can view the following details about a specific VPN:

• key details describing the VPN (i.e., name, Policy IP, group and user 
associations, VPN type)

• Security Association (SA) information

• total number of data traveling through a tunnel (i.e., bytes in/out, packets in/out, 
utilization)

The following table describes all of the information that is available from the VPN 
Monitor Table:

Item Displays...
Name the name of the VPN.
VPN Type Type of tunnel: Site-to-site or dial-up.
SA Id the Security Association (SA) identification for the VPN at both ends of 

the tunnel.
Policy Id--In/Out A unique identifier specified when the policy was configured. 
Tunnel up/down status of the VPN tunnel.
SA Status whether or not the current SA has been established.
Time-SA Status Change time that the SA status last changed
Last SA Session Duration duration of last SA session
Group Group associated with the VPN.
User User associated with the VPN.
DN Name Distinguished Name (DN) of the VPN.
Avg. Latency A rolling average of latency, presented in milliseconds.
Availability Percentage of the time a tunnel is available over the last thirty samples.
Bytes In the number of incoming bytes handled by the protocol through the 

NetScreen device.
Delta Bytes In Total numerical difference between the current bytes in value and the 

previous bytes in value.
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Viewing Active VPN Information
Click on the Active VPN tab to view specific information about your active VPNs. From 
the Active VPN, you can view the following details about your active VPNs:

• key details describing the VPN (i.e., name, Policy IP, local and peer gateway IDs 
and IP addresses)

• security established on the active VPN

• time-related statistics (i.e., lifetime, latency)

The following table describes all of the information that is available from the active VPN:

Bytes Out the number of outgoing bytes handled by the protocol through the 
NetScreen device.

Delta Bytes Out Total numerical difference between the current bytes out value and the 
previous bytes out value.

Packets In the number of incoming packets handled by the protocol through the 
NetScreen device.

Delta Packets In Total numerical difference between the current packets in value and the 
previous packets in value.

Packets Out the number of outgoing packets handled by the protocol through the 
NetScreen device.

Delta Packets Out Total numerical difference between the current packets out value and the 
previous packets out value.

Util. (Absolute) Total number of the utilization of the current device.
Util. (Delta) Total numerical difference between the current utilization value and the 

previous utilization value.

Item Displays...
Name the name of the active VPN.
VPN Type Type of tunnel: Site-to-site or dial-up.
Policy Id--In/Out A unique identifier specified when the policy was configured. 
Tunnel whether the tunnel for the active VPN is UP or Down.
Ave Latency A rolling average of latency, presented in milliseconds.
Last Latency the average of successful ping responses over the last 30 attempts.
Availability Percentage of the time a tunnel is available over the last thirty samples.
Local GW Id the local gateway Id for the active VPN.
Peer GW Id the peer gateway Id address for the active VPN.
Local GW IP the local gateway IP address for the active VPN.
Peer GW IP the peer gateway IP address for the active VPN.
Local Address the local IP address for the device associated to the active VPN.
Peer Address the peer IP address for the device connected to the active VPN.
Monitor whether a monitoring capability for the VPN is ON or OFF.

Item Displays...
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IPSec the IPSec (IP security) protocol for the active VPN; for example, AH 
(Authentication Header) or ESP (Encapsulating Security Payload).

SPI In the SPI (Security Parameter Index) key into the active VPN. This is an 
encryption method.

SPI Out the SPI (Security Parameter Index) key out of the active VPN. This is an 
encryption method.

Encryption Algorithm used when a user encrypts communication between the 
NetScreen device and the server. Listed as either SDI or DES.

Authentication A second algorithm used when a user encrypted communication 
between the NetScreen device and the server.

Key Type of key associated with the VPN: Auto IKE (Internet Key Exchange) 
or manual key.

Lifetime P1 Time listed in seconds before re-keying.
Lifetime P2 Time reported in remaining bytes before re-keying. Independent from 

Lifetime P1.
Life Size the predefined duration of the tunnel.
P1 Status whether the P1 (phase 1) status for tunnel negotiation is enabled/

disabled.
P2 Status whether the P2 (phase 2) status for tunnel negotiation is enabled/

disabled.
P1 Auth Associated with Auto IKE. This column displays the P1 (phase 1) 

authentication for the active VPN.

Item Displays...
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Viewing Traffic Logs
Click on the Traffic Logs button to view specific traffic information that appears in the 
log messages generated for a device.

You can enable logging for any defined policy. Whenever a connection is completed using 
that policy, a log message is generated. The following table describes all of the 
information that is available from the Traffic Logs view:

Item Displays...
Time Time the event occurred.
Source IP: Port IP address of the sending node of the connection being logged.
Destination IP: Port IP address of the receiving node of the connection being logged.
Translated IP:Port Translated IP Port.
Duration (sec) Length in seconds of the connection session.
Application the name of the application to which the traffic log belongs. The 

application is determined by the protocol, source port, and destination 
port.

Policy ID A unique identifier specified when the policy was configured. None 
means no name was specified during policy configuration.

Policy Service the types of service allowed by the policy; for example, FTP, HTTP, and 
Telnet

ICMP Type the type of ICMP protocol.



Monitoring Individual Device Statistics

NetScreen-Global PRO 181

Bytes In the total number of bytes sent in.
Bytes Out the total number of bytes sent out.
Total Packets the total number of packets sent.
Count the number of times this event has occurred.

Item Displays...
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Viewing Interface Statistics
You can also view traffic information as it is processed by a device over a specific 
interface.

Viewing Ethernet Statistics
Click on the Ethernet Statistics button to view traffic information as it is processed by a 
specific physical interface on a device. Depending upon the specific NetScreen device, the 
following interfaces will apply:

• Trust and Untrust interfaces on all NetScreen devices.

• DMZ interface on NetScreen-10, NetScreen-25, NetScreen-50, NetScreen-100 and 
NetScreen-500 devices; the NetScreen-5, NetScreen-5XP, and NetScreen-1000 
devices have no DMZ interface.

• HA interface and the management interface on NetScreen-100, NetScreen-500, 
and NetScreen-1000 devices.

Ethernet Statistics apply only to devices, and not to virtual systems. 

Note: Some options are not available for devices running previous versions of ScreenOS. 
Check the “Device” row in the Summary view to identify the version of ScreenOS that the 
device is running.
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Report Manager displays a bar graph similar to the one presented for viewing device 
traffic to depict utilization across each physical interface. Right-click within the chart to 
select a desired Interface (i.e., Ethernet or HA). The active interface is listed below the 
graph. The graph will also provide the total errors in a graphical form. You can view up to 
12 samples in the chart.

The following table describes all of the information that is available from the Ethernet 
Statistics view:

Note: The save and pause functions are not available in a summary view.

Item Displays...
Interface the data for each interface.
Bytes In the number of bytes of incoming traffic processed through the 

NetScreen device over the selected interface.
Delta Bytes In the total numerical difference between the current bytes in value and 

the previous bytes in value.
Bytes Out the number of outgoing bytes handled by the protocol through the 

NetScreen device.
Delta Bytes Out the total numerical difference between the current bytes out value and 

the previous bytes out value.
Packets In the number of incoming packets handled by the protocol through the 

NetScreen device.
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Delta Packets In the total numerical difference between the current packets in value and 
the previous packets in value.

Packets Out the number of outgoing packets handled by the protocol through the 
NetScreen device.

Delta Packets Out the total numerical difference between the current packets out value 
and the previous packets out value.

Broadcast the number of broadcast-type packets processed through the 
NetScreen device over the selected interface.

CRC Errors the number of packets generating a cyclic redundancy code error 
processed through the NetScreen device over the selected interface.

Alignment Errors the number of Frame Checksum (FCS) errors.
ShortFrame the number of frames that are not of the correct length.
RXCollision the number of times that two packets collide, resulting in damage to 

both. This indicates that the network is overloaded.
Speed (Mbps) This is useful in calculating the interface utilization.
Status whether the device is currently Up or Down.
Direction whether the device is in half/full duplex mode.
Zone the name of the zone associated with the interface.

Item Displays...



Monitoring Individual Device Statistics

NetScreen-Global PRO 185

Viewing Flow Statistics
Click on the Flow Statistics button to view data on the flow counter for a specific device 
or virtual interface. For each device, Report Manager separates the data and statistics by 
all available interfaces.

The following table describes all of the information that is available from the Flow 
Statistics view:

Note: Some options are not available for devices running older ScreenOS versions. Check 
the “Device” row in the Summary view to see a device’s ScreenOS version.

Item Displays...
Interface the name of the virtual interface.
Bytes In the number of bytes of incoming traffic processed through the NetScreen 

device over the selected interface.
Bytes Out the number of bytes of outgoing traffic processed through the NetScreen 

device over the selected interface.
Packets In the number of incoming packets processed through the NetScreen 

device over the selected interface.
Packets Out the number of outgoing packets processed through the NetScreen 

device over the selected interface.
VLAN In the number of VLAN packets received through the NetScreen device; 

applies to virtual systems.
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Viewing Attack Statistics
Click on the Attack Statistics button to view all of the attacks that have occurred on a 
specific device. The report separates the data and statistics by all available interfaces.

VLAN Out the number of VLAN packets sent through the NetScreen device; applies 
to virtual systems.

Connections the number of connections that occurred for a given Vsys interface.
Packets Dropped the number of incoming packets dropped by a given Vsys interface.
Packets Denied the number of incoming packets denied on the virtual interface by the 

policy.
Authentication Failed the number of packets dropped because of an authentication failure.
URL Blocking Dropped the number of packets dropped because of URL blocking.
IPSec Dropped the number of packets dropped because of an IPSec encryption failure.
Zone the name of the zone associated with the interface.

Note: Some options are not available for devices running older ScreenOS versions. Check 
the “Device” row in the Summary view to see a device’s ScreenOS version.

Item Displays...
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The following table describes all of the information that is available from the Attack 
Statistics view:

Item Displays...
Interface Name of the interface.
SYN Attack SYN packets overwhelm a network by initiating so many connection attempts or 

information requests that the network can no longer process legitimate 
connection requests, resulting in a Denial of Service.

Tear Drop When the first and second parts of a fragmented packet overlap, the server 
attempting to reassemble the packet can crash. If the NetScreen device sees 
this discrepancy in a fragmented packet, it drops the packet.

Source Route This option applies in an IP header and allows an attacker to enter a network 
with a false IP address and have data sent back to the attacker’s real address.

Ping of Death Intentionally oversized or irregular ICMP packets can trigger a Denial of Service 
condition, freezing, or other adverse system reactions. You can configure a 
NetScreen device to detect and reject oversized or irregular packet sizes.

Address Spoofing You can enable a NetScreen device to guard against spoofing attacks by 
checking its own route table. If the IP address is not in the route table, traffic 
through the NetScreen device is not allowed.

Land Attack Combining a SYN attack with IP spoofing, a Land attack occurs when an 
attacker sends spoofed SYN packets containing the IP address of the victim as 
both the destination and source IP address. This creates an empty connection. 
Flooding a system with such empty connections can overwhelm the system, 
causing a Denial of Service. NetScreen devices automatically blocks any 
attempt of this nature and records such attempts as a Land attack.

ICMP Flood ICMP pings can be so numerous that they overload a system with so many 
echo requests that the system expends all its resources responding until it can 
no longer process valid network traffic. If you set a threshold to invoke ICMP 
flood attack protection when exceeded, ICMP flood attacks are recorded as 
statistics.

UDP Flood Similar to the ICMP flood, UDP flooding occurs when UDP packets are sent 
with the purpose of slowing down the system to the point that it can no longer 
handle valid connections. After enabling the UDP flood protection feature, you 
can set a threshold that once exceeded invokes the UDP flood attack protection 
feature. (The default threshold value is 1000 packets per second.) If the 
threshold is exceeded, the NetScreen device ignores further UDP packets for 
the remainder of that second.

WinNuke WinNuke can cause any computer on the Internet running Windows to crash. 
WinNuke introduces a NetBIOS anomaly that forces Windows to restart. 
NetScreen devices can scan any incoming Microsoft NetBIOS Session Service 
packets, modify them, and record the event as a WinNuke attack.

Port Scan Port scan attacks occur when packets are sent with different port numbers with 
the purpose of scanning the available services in hopes that one port will 
respond. The NetScreen device internally logs the number of different ports 
scanned from one remote source. If a remote host scans 10 ports in 0.3 
seconds, NetScreen flags this as a port scan attack, and rejects further packets 
from the remote source.
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IP Sweep This is the same as an address sweep attack, and similar to a port scan attack. 
It occurs when an attacker sends ICMP echo requests (or pings) to different 
destination addresses hoping that one will reply, thus uncovering an address to 
a target. If a remote host pings 10 addresses in 0.3 seconds, the NetScreen 
device flags this as an address sweep attack and drops the connection.

Block Java/ActX Malicious Java or ActiveX components can be hidden in Web pages. When 
downloaded, these applets install a Trojan horse on your computer. Similarly, 
Trojan horses can be hidden in compressed files such as .zip, .gzip, and .tar, 
and executable (.exe) files.

SYN Frag A SYN fragment attack floods the target host with SYN packet fragments. The 
host catches the fragments, waiting for the remaining packets to arrive so it can 
reassemble them. By flooding a server or host with connections that cannot be 
completed, the host's memory buffer eventually fills. No further connections are 
possible, and damage to the host's operating system can occur. The NetScreen 
device drops ICMP packets when the protocol field indicates ICMP packets, 
and the fragment flag is set to 1 or an offset is indicated.

TCP no Flag TCP packet that does not have any bits set in the flags.
Unknown Prot The NetScreen device drops packets where the protocol field is set to 101 or 

greater. These protocol types are reserved and undefined at this time.
Bad IP Opt Triggered when the list of IP options in the IP datagram header is incomplete or 

malformed.
IP Rec Route The NetScreen device blocks packets where the IP option is 7 (Record Route). 

This option is used to record the route of a packet. A recorded route is 
composed of a series of internet addresses, which an outsider can analyze to 
learn details about your network's addressing scheme and topology.

IP Timestamp The NetScreen device blocks packets where the IP option list includes option 4 
(Internet Timestamp).

IP Security This option provides a way for hosts to send security, compartmentation, TCC 
(closed user group) parameters, and Handling Restriction Codes compatible 
with DOD requirements.

IP Loose Src The NetScreen device blocks packets where the IP option is 3 (Loose Source 
Routing). This option provides a means for the source of a packet to supply 
routing information to be used by the gateways in forwarding the packet to the 
destination. This option is a loose source route because the gateway or host IP 
is allowed to use any route of any number of other intermediate gateways to 
reach the next address in the route.

IP Strict Src The NetScreen device blocks packets where the IP option is 9 (Strict Source 
Routing). This option provides a means for the source of a packet to supply 
routing information to be used by the gateways in forwarding the packet to the 
destination. This option is a strict source route because the gateway or host IP 
must send the datagram directly to the next address in the source route, and 
only through the directly connected network indicated in the next address to 
reach the next gateway or host specified in the route.

IP Stream The NetScreen device blocks packets where the IP option is 8 (Stream ID). This 
option provides a way for the 16-bit SATNET stream identifier to be carried 
through networks that do not support the stream concept.

Item Displays...
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ICMP Frag When the protocol field indicates ICMP packets, and the fragment flag is set to 
1 or an offset is indicated.

Large ICMP An ICMP packet with a length greater than 1024.
SYN n FIN Both the SYN and FIN flags are not normally set in the same packet. However, 

an attacker can send a packet with both flags set to see what kind of system 
reply is returned and thereby determine what kind of system is on the receiving 
end. The attacker can then use any known system vulnerabilities for further 
attacks. Enable this option to have the NetScreen device drop packets that 
have both the SYN and FIN bits set in the flags field.

FIN no ACK TCP packet with a FIN set but no ACK set in the flags field.
Mal URL When you enable Malicious URL Detection, the NetScreen device monitors 

each HTTP packet and detects any URL that matches any of several user-
defined patterns. The device automatically drops any such packet.

Limit Session NetScreen devices can limit the number of sessions that can be established by 
a single IP address. For example, session resources on a Web server can be 
exhausted if there are many requests from the same client. This option defines 
the maximum number of sessions the NetScreen device can establish per 
second for a single IP address. (The default threshold is 128 sessions per 
second per IP address.)

SYN-ACK-ACK N/A
Block Frag As packets traverse different networks, it is sometimes necessary to break a 

packet into smaller pieces (fragments) based upon the network's maximum 
transmission unit (MTU). IP fragments may carry an attacker's attempt to exploit 
the vulnerabilities in the packet reassembly code of specific IP stack 
implementations. When the target system receives these packets, the results 
range from not processing the packets correctly to crashing the entire system. 
When you enable the NetScreen device to deny IP fragments on a security 
zone, the device blocks all IP packet fragments that it receives at interfaces 
bound to that zone.

Zone the name of the zone associated with the attack.

Item Displays...
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Viewing Zone Statistics
Report Manager allows you to view traffic information as it is processed by a device over 
specific zones.

You can view ethernet statistics, flow statistics and attack statistics in the same manner 
that you viewed them in the Interface reports according to zone.

Viewing System Statistics
You can also view system-related information for a device.

Viewing Resource Statistics (if applicable)
Click on the Resource Statistics button to view the resources for a device. The following 
table describes all of the information that is available from the Resource Statistics view:

Item Displays...
Avg. CPU Utilization the average CPU usage of the device.
Memory Allocated the current memory allocation to device.
Memory Left the remaining usable memory.
No. of Fragment Blocks a percentage of blocks that are fragmented.
Active Sessions the number of active sessions.
Allocated Sessions the number of allocated sessions.
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Viewing Active Statistics
Click on the Active Statistics button to view administrator and user activities for a 
device. The Administrators tab displays information about the administrators including, 
when, where and how they logged in to the system. The following table describes all of the 
information that is available from the Administrators view:

The following table describes all of information that is available from the Authenticated 
Users view:

You can also access VPN information from the Active VPN view, and Active Session 
information from the Active Sessions view. Refer to Viewing Active VPN Information for 
more information that is available from the Active VPN view. Refer to Viewing Active 
Sessions for more information on Active Sessions.

Viewing Self Logs
Self logs contain NetScreen device-specific logs. Click on the Self Logs button to view 
information related to identical traffic to the device itself; for example, who logged in and 
from where. The following table describes all of the information that is available from the 
Authenticated Users view:

Max. Sessions Allowed the maximum sessions allowed.
Failed Sessions the number of sessions that failed.

Item Displays...
Administrator ID the administrator’s logon ID.
IP Address the administrator’s IP address.
Service Used the type of service, for example, Console, Web, or Telnet.
Time the time that the administrator logged on.

Item Displays...
User ID User log in ID.
Source IP Address Source IP address.
Time Time that the user logged on.

Item Displays...
Time the date and time the event occurred.
Source IP:Port the IP address of the device transmitting the traffic.
Destination IP:Port the IP address of the device receiving the traffic.
Duration (sec) the length in seconds of the connection session.

Item Displays...
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Viewing System Alerts
Click on the System Alerts button to view information related to low memory and high 
device CPU usage. The following table describes all of the information that is available 
from the System Alerts view

Troubleshooting
Report Manager allows you to communicate using Telnet or a Secure Command Shell to 
query on the status of a device. You can use this capability to issue a “get” Telnet 
command to a NetScreen device or a NetScreen CLI command to the SCS (Secure 
Command Shell) on the device to troubleshoot problems.

Refer to Troubleshooting the Device in Chapter 5 for more information.

Application the name of the application to which the traffic log belongs. The application 
is determined by the protocol, source port, and destination port.

Count the number of times this event has occurred.

Item Displays...
Event Type the type of alert or system alarm.
Event Sub Type the type of alert or system alarm.
First Occurrence the first occurrence of this event.
Last Occurrence the most recent occurrence of this event.
Severity the severity of the event; that is, from critical to clear.
Summary a brief synopsis of the event.
Count the number of times this event has occurred.

Item Displays...
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Viewing Active Sessions
A new feature in Report Manager is the ability to view a snapshot of ongoing active 
sessions on the device. You can view active sessions from the System: Active Statistics 
view.

When you click on the Active Sessions tab, Report Manager provides you with a short 
form view of the active sessions allowing you to monitor basic information (i.e., source IP, 
destination IP, translated IP (if applicable), source port, destination port, translated port 
(if applicable), policy ID, time the session starts, and protocol type) about the active 
sessions on the device by default. You can also view extended information about the 
session (i.e., session id, icmp type (if applicable), total incoming bytes, total outgoing 
bytes, total packets count, how long the session has been active).

The following table describes all of the information that is available from the Active 
Sessions view:

Item Displays...
Session ID A unique identifier specified with the active session.
Source IP IP address of the sending node of the connection.
Source Port Port number of the sending node of the connection.
Destination IP IP address of the receiving node of the connection.
Destination Port Port number of the receiving node of the connection.
Translated IP Translated IP address.
Translated Port Translated port number.
Duration (sec) Length in seconds of the connection session.
Policy ID A unique identifier specified when the policy was configured. None 

means no name was specified during policy configuration.
Protocol ID A unique identifier specified when the protocol was configured. 
ICMP Type the type of ICMP protocol.
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Using the Session Filter
You can control the information that is provided in the Active Sessions view by 
configuring a session filter. The Session Filter allows you to fetch specific sessions on a 
device that match specific criteria that you set. Like the Monitor Filter for the Event 
Summary View, there is only one Session Filter and it defines the overall data set that 
you can view from the Active Sessions view. Once you have configured and applied the 
Session Filter, you can then configure additional session display filters to view more 
specific session information.

Bytes In the total number of bytes sent in.
Bytes Out the total number of bytes sent out.
Total Packets the total number of packets sent.
Duration the length in seconds of the connection session.
Start Time the time that the session started.

Item Displays...
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Configuring the Session Filter
1. Use the Options menu, and select Session Filter. The Session Filter Dialog 

will appear.

2. Click in the Long Form checkbox to display additional information about the 
Active Session.

3. Click in the Maximum number of sessions to retrieve checkbox and enter 
the total number of sessions you want the Session Filter to retrieve.

4. Specify criteria for the sessions that you would like to view. You can specify an 
active session according to the following:

• Source, Destination, and Translated IP (IP Address, Net Mask, and Port 
Range)

• Session Duration

• Session Start Date and Time

• Policy ID

• Session Type

• Protocol ID
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• Policy with Logging

5. Click on the More button to view additional criteria.

6. Click on the Reset to Default button to reset all criteria back to their default 
settings.

7. Click OK when you are done.

8. Click on the Refresh button to apply the criteria to the active session table 
view.

Configuring a Session Display Filter
Once you have defined the Session Filter, you can apply a session display filter to view 
only specific active sessions.

1. Use the Options menu, and select Session Display Filter. The Session Filter 
Dialog will appear.

2. From the Source tab, you can specify the sessions that you want to view 
according to the Source IP Address and Port number, or Port Range.

3. Click in the Destination tab to specify the sessions that you want to view 
according to Destination IP Address and Port number, or Port Range.

4. Click in the Translated tab to specify the sessions that you want to view 
according to Translated IP Address and Port number, or Port Range.
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5. Click in the Protocol tab specify the sessions that you want to view according to 
protocol.

6. Click in the Other tab specify the sessions that you want to view according to 
Session Duration, Session Start Time or Policy ID.

7. Click OK when you are done.

8. Click on the Refresh button to apply the Session Display criteria to the active 
session table view.

Viewing High Availability (HA) Statistics (if applicable)
You can view NSRP Statistics related to clusters (this view only appears if a virtual 
system is associated with the device). The following table describes all of the information 
that is available from the NSRP Statistics view:

Item Displays...
VSD Group ID the group ID that is associated with the VSD (or RTO).
Number of Units the number of units associated with the VSD (or RTO).
State Change Counter the number of times a device changes operational states.
Init Counter the transient state of a VSD (or RTO) group member while it was in the 

process of joining the VSD (or RTO) group.
Master the number of Master devices.
Primary BackUp the number of primary backup devices.
BackUp the total number of backup devices.
Ineligible Notes that an administrator purposefully assigned a device so that it 

cannot participate in the selecting a new master device.
InOperable Notes that a VSD (or RTO) group device has an internal problem.
Master Conflict the number of conflicts that occurred on the master device.
Primary Backup Conflict the number of conflicts that occurred on the primary backups device.
Tx Heartbeat the number of transmitted heartbeats on the devices.
Rx Heartbeat the number of received heartbeats on the devices.
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MONITORING VPN STATUS
If you have implemented a virtual private network or VPN, you can use the VPN Monitor 
to get an at-a-glance status of the up/down status of every VPN tunnel as well as other 
statistics relevant to your VPN. To launch the VPN Monitor, click on the VPN Monitor 
button.

Viewing the VPN Status Summary
The VPN Monitor lists a summary of all the VPN tunnels that have been implemented in 
your system. It includes visual indicators that depict whether an existing VPN tunnel is 
either Up, Down, or Not Monitored. VPN tunnels that are up are colored green; down are 
colored in red; and those not configured for monitoring in orange. The Summary also 
includes information describing the VPN name, VPN type, Source, Destination, Security 
Parameter Index., IP Address, and Protocol.
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About VPN Tunnels
The VPN Monitor displays a variety of information about a virtual private network 
(VPN), including the type of “tunnels” deployed. By definition, VPN tunnels are used to 
manage and provide security for a virtual system, and to allow remote users the ability to 
connect to a virtual system. You can use tunnels to manage and provide security for a 
virtual system. Tunnels also allow remote users the ability to connect to the virtual 
system. There are two distinct types of VPN tunnels:

• Site-to-site: Also known as a LAN-to-LAN connection, site-to-site VPNs are 
further characterized as:

– Static site-to-site VPN, Manual Key tunnel.

– Static site-to-site VPN, AutoKey IKE tunnel.

– Dynamic site-to-site VPN, AutoKey IKE tunnel.

• Dial-up: Other VPNs are deployed as a simple dial-up connection, with either a 
static IP address to secure an IPSec tunnel with a NetScreen-Remote client, or 
with another NetScreen device using a dynamic IP address acting as a DHCP or 
PPPoE client.

Controlling VPN Information
You can control the information that is provided in the VPN Monitor by configuring a 
VPN display filter. The display filter works exactly like the display filter used to manage 
event summary information. 
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Configuring a VPN Display Filter
1. Use the Options menu, and select Display Filter. The VPN Filter Dialog will 

appear.

2. If you know the type of VPN you want to view, click either the Site to Site or 
Dialup type radio button.

3. If you know the status of the VPN tunnel you want to view, click either the Up, 
Down or Not Monitored status radio button.

4. If you know the device or virtual system associated with the VPN tunnel, click to 
add the device/vsys from the list of Available Devices/(Vsys) and click on the Add 
button. The device/vsys will appear in the list of Selected Devices/(Vsys). Click to 
remove the device/vsys from the list of Selected Devices/(Vsys) and click on the 
Remove button. The device/vsys will appear in the list of Available Devices/
(Vsys). Click in the Include all selected Devices radio button to include the 
devices selected. Click in the Exclude all selected Devices to exclude the devices 
selected.

5. Click OK when you are done.

6. Click on the Refresh button to apply the Session Display criteria to the active 
session table view.
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Viewing Active VPN Details
To view the details on the active VPN, click to select the VPN, use the View menu and 
select Active VPN Details (alternatively, you can also right-click on the VPN tunnel and 
select Active VPN Details).

Refer to Viewing Active VPN Information for more information on the Active VPN Details 
table.
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Viewing Device-Specific VPN Information
Right-click on the VPN tunnel and select Monitor Data, and then the device to view 
device-specific information about your VPN. A Monitor info window appears where you 
can access the VPN Monitor table, Active VPN table, and a chart allowing you to view the 
distribution of VPN tunnels on the device.
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Viewing VPN Events
To view the events on a VPN, click to select the VPN, use the View menu and select VPN 
Events (alternatively, you can also right-click on the VPN tunnel and select Events).

The following table describes all of the information that is available from the VPN Events 
window:

Item Displays...
Hostname/IP the hostname and IP address of the NetScreen device.
Vsys the name of the virtual system (if applicable).
Event Type the type of the event.
Event Sub Type the sub-type of the event.
First Occurrence a timestamp of the first occurrence of this event.
Last Occurrence a timestamp of the most recent occurrence of this event.
Severity the severity of the event; that is, from critical to clear.
Summary a brief synopsis of the event.
Count the number of times this event has occurred.
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MONITORING NSRP STATISTICS
If you have implemented NetScreen Redundancy Protocol (NSRP) for the purpose of 
deploying clusters in your NetScreen security system, you can use the Report Manager 
NSRP Monitor to get an at-a-glance status of your NetScreen systems that are in 
“clusters.” These systems include both the NetScreen-500 and the NetScreen-1000. To 
launch the NSRP Monitor, click on the NSRP Monitor button.
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About Clusters
Traffic flow on a network must remain uninterrupted and moving, even in the event of a 
network failure. Clusters solve the problem of network failure. Clusters represent a 
logical grouping of devices. In a cluster, devices are linked together to form a redundant 
group; one device acts as the master, while the others act as a backup. This guarantees 
that your network is running at all times. NSRP is the protocol that is used to implement 
and manage clusters.

Viewing NSRP Summary Information
Double-click on an NSRP device to view a summary of the top-level information on the 
selected cluster. From the NSRP Summary, you can view the following details about a 
specific cluster:

• key details describing the cluster (i.e., ID, # of VSDs, # of RTOs)

• security details

• the total number and type of events

The following table describes all of the information that is available from the NSRP 
summary:

Note: ScreenOS 3.1.0-NSRP is available for NetScreen-500 platforms, only. If you are not 
running ScreenOS 3.1.0-NSRP or later, the enhanced VPN monitoring feature is not 
available. Check the “Device” row in the Summary view to verify a device’s ScreenOS 
version.

Item Displays...

Cluster ID of this cluster.

No of VSD’s the total number of Virtual Security Devices (VSD) that are attached to this 
cluster.

No of RTO’s the total number of Run Time Objects (RTO) that are attached to this cluster.

Encryption whether or not encryption has been enabled/disabled.

Authentication whether or not authentication has been enabled/disabled.

No. of Gratuitous arps the number of gratuitous arps.

Critical Events the total number of Critical events that occurred.

Major Events the total number of Major events that occurred.

Minor Events the total number of Minor events that occurred.

Warning Events the total number of Warning events that occurred.

Intermediate Events the total number of Intermediate events that occurred.

Clear Events the total number of Clear events that occurred.
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Viewing NSRP Details
Right-click the top-level cluster to view additional NSRP details.

From the NSRP Details view, you can view information that you would commonly see in 
the Event Monitor:

• key details describing the cluster (i.e., host name, IP address)

• type and subtype of events that have occurred

• number of times that an event has occurred

• time-related information (i.e., first and last occurrence date and time)

The following table describes all of the information that is available from the NSRP 
Details view:

Item Displays...

Hostname/IP the name and IP address of the devices associated with the cluster.

Vsys the virtual systems associated with this cluster.

Event Type the type of event.

Event Sub Type the type of event.

First Occurrence a timestamp of the first occurrence of this event.

Last Occurrence a timestamp of the most recent occurrence of this event.

Severity the severity of the event; that is, from critical to clear.
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Viewing VSD/RTO Information
Double-click on the cluster device icon or click on the + icon that corresponds to the cluster 
device icon to view the virtual security devices (VSD) and run-time objects (RTO) that 
have been attached to this cluster.

Click on the VSD or RTO icon and Report Manager to display summary information 
describing the object. The following table describes all of the information that is available 
from the VSD/RTO summary:

Viewing VSD/RTO-specific Details
For more information on a VSD device, click to select the device, then click on the Details 
icon. Alternatively, you can use the View menu, and select Details; or right-click on the 
icon and select Details. The Cluster Details view appears. Report Manager again 
displays summary information for the VSD/RTO.

Summary a brief synopsis of the event.

Count the number of times this event has occurred.

Item Displays...

Cluster ID the cluster ID associated with this VSD.

VSD(RTO) ID the ID of this VSD (or RTO).

No of Devices the total number of devices that are associated with this VSD.

Init Hold Time (sec) the initial hold time state (in seconds) of the VSD.

Heartbeat Interval (ms) the time interval (in milliseconds) between each heartbeat.

Heartbeat Lost Threshold (ms) threshold level required to change over to the backup device.

Master the Master NetScreen System.

Primary Backup the primary NetScreen System.

Critical Events the total number of Critical events that occurred.

Major Events the total number of Major events that occurred.

Minor Events the total number of Minor events that occurred.

Warning Events the total number of Warning events that occurred.

Intermediate Events the total number of Intermediate events that occurred.

Clear Events the total number of Clear events that occurred.

Item Displays...
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Viewing VSD/RTO Configuration Details
Click on the Configuration tab to view specific information about your VSD configuration. 
From the Configuration tab, you can view the following details about a specific VSD:

• key details describing the VSD (i.e., SN#, member ID)

• status information (i.e., whether the VSD is the master or primary device)

The following table describes all of the information that is available from the VSD/RTO 
configuration view:

Viewing VSD Counter Details
Click on the Counters tab to view specific information about your VSD counters. The 
following table describes all of the information that is available from the VSD counters 
view:

Item Displays...
Device the serial number associated with this VSD (or RTO).
Member ID the member identification associated with this VSD (or RTO).
Status (N/A for RTO) the whether the device is the master or primary device
Priority (N/A for RTO) the list priority for this device.
Preempt (N/A for RTO) whether the device is set to the preempt mode.

Item Displays...
Device the device(s) that are associated with the VSD (or RTO).
Number of Units the number of units associated with the VSD (or RTO).
State Change Counter the number of times a device changes operational states.
Init Counter the transient state of a VSD (or RTO) group member while it was in the 

process of joining the VSD (or RTO) group.
Master the number of Master devices.
Primary BackUp the number of primary backup devices.
BackUp the total number of backup devices.
Ineligible Notes that an administrator purposefully assigned a device so that it 

cannot participate in the selecting a new master device.
InOperable Notes that a VSD (or RTO) group device has an internal problem.
Master Conflict the number of conflicts that occurred on the master device.
Primary Backup Conflict the number of conflicts that occurred on the primary backups device.
Tx Heartbeat the number of transmitted heartbeats on the devices.
Rx Heartbeat the number of received heartbeats on the devices.
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Viewing RTO Counter Details
Click on the Counters tab to view specific information about your RTO counters. The 
following table describes all of the information that is available from the RTO counters 
view:

Viewing VSD/RTO Events
From the VSD/RTO events view, you can view information that you would commonly see 
in the Event Monitor:

• key details describing the VSD/RTO (i.e., host name, IP address)

• type and subtype of events that have occurred

• number of times that an event has occurred

• time-related information (i.e., first and last occurrence date and time)

The following table describes all of information that is available from the VSD/RTO 
events view:

Item Displays...
Device the device(s) that are associated with the RTO.
Member ID the member identification associated with this RTO
Status the current status of the RTO: Active or Down.
Direction the direction of the RTO: In or Out.
Lost Heartbeat the number of heartbeats not received from the RTOs peers.
Counter to Active the number of times that the RTO was placed to “active”
Counter to Set the number of times that the RTO was placed to “set”
Counter to Lost Peer the number of times that the RTO was placed to Lost Peer.
Counter to Group 
Detach

the number of times that the RTO was placed to Group Detach.

Item Displays...

Hostname/IP the name and IP address of the devices associated with the VSD or RTO.

Vsys the virtual systems associated with this cluster.

Event Type the type of event.

Event Sub Type the type of event.

First Occurrence a timestamp of the first occurrence of this event.

Last Occurrence a timestamp of the most recent occurrence of this event.

Severity the severity of the event; that is, from critical to clear.

Summary a brief synopsis of the event.

Count the number of times this event has occurred.
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VIEWING TRAFFIC LOG REPORTS
Report Manager allows you to view the information in each traffic log file. To view traffic 
logs, use the View menu and select Traffic Log Report. The Traffic Log Report window 
appears along with the Traffic Log Query Configuration window.
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Configuring a Traffic Log Query
As there could be many traffic logs to view, you will want to setup an initial query to 
specify only those traffic logs that you are interested in. From the Traffic Log Query 
Configuration window, you can query for traffic logs that match a specific host or virtual 
system, IP address (source, destination or translated), port (source, destination, or 
translated), byte or packet size, policy ID, ICMP type, start or end time, or Data Collector.

The Traffic Log Query Configuration window appears automatically with the Traffic Log 
Report. You can also use the Options menu and select Query Configuration to access 
the Traffic Log Query Configuration window. The Data Collector Parameters tab is the 
first screen that appears.

To configure a Traffic Log Query:

1. From the Traffic Log Query Configuration window Data Collector Parameters 
tab, use the Send query to DC pull-down menu to specify the Data Collector 
where the traffic log files that you want to view are stored. Click in the Stop 
query after checkbox to specify a maximum number of traffic logs that you 
want to view. Click in the Perform query in this directory checkbox and 
enter a directory path to specify where on the Data Collector computer you want 
to search for traffic logs.

2. Click on the Query Pattern tab to specify general criteria for the traffic logs 
that you want to view. Criteria that you can search for includes:

• Serial number

• Host name

• Vsys name

• Device IP

• Source IP

• Destination IP

• Translated IP

• Source Port

• Destination Port

• Translated Port

• Total Bytes

• Total Packets

Note: You must have installed Perl on the Data Collector computer for the Data Collector 
to run traffic log queries.
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• Policy ID

Refer to Viewing Traffic Logs in Chapter 5 for more information on these traffic 
log values. 

Query Rules: For each field, you can specify a specific value or range. Use 
brackets with values separated by a dash to specify a range (i.e., [start - end] ). 
Separate each value or range by a comma. For example, to query for all traffic 
logs from devices with hostnames 1234Host and 1235Host, and the source port 
is either 156 or within the range of 1056 to 1076, you would enter the following 
query pattern: “hn=1234Host, 1235Host and src_port=156, [1056-1076]”.

You can also add a wildcard, such as an asterisk (*) to your query string to 
return anything that either precedes or follows your query. For example, if you 
enter an asterisk alone, your query will return all files - this is the same effect as 
leaving the field blank; “abcd*” will return anything that begins with “abcd”; 
“*111” will return anything that ends with “111”.

You can also construct more complex patterns by including an "and" condition. 
For example, to query for all traffic logs from device with serial number 
12345678, and total bytes is 1234, you would enter the following query pattern: 
“sn=12345678 and num_bytes=1234”

Note also that you must type all keywords in lowercase; and that keyword 
values are case-sensitive.
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Click Save to save your changes.

3. If you know the protocol ID of the traffic log that you wish to view, click on the 
Protocol ID tab, and verify or add that protocol ID to the list of Selected 
Protocol IDs. You can add a protocol ID to the list of Selected protocol IDs by 
clicking on the protocol ID from the list of Available Protocol IDs, then clicking 
on the Add button. The protocol ID now appears in the list of Selected Protocol 
IDs.

If the protocol ID that you want is not in the list of Available Protocol IDs, you 
can add it by entering it in the ID field and clicking on the Add to Selected 
Protocol button. Use the ID Range fields to enter multiple protocol IDs, then 
click on the Add to Selected Protocol button.

Click Save to save your changes.
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4. If you know the ICMP type of the traffic log that you want to view, click on the 
ICMP Type tab and verify or add that ICMP type to the list of Selected ICMP 
Types. Click Save to save your changes.
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5. If you know the time range of the traffic log that you want to view, click on the 
Timestamp tab.

In the Start Time Range section of the screen, click in the Select in the Range 
checkbox to specify a range when the traffic log originated. Use the date pull-
down menu to select a date. Use the up and down arrows to select a time.

In the End Time Range section of the screen, click in the Select in the Range 
checkbox to specify a range when the traffic log ended. Use the date pull-down 
menu to select a date. Use the up and down arrows to select a time. 

Click Save to save your changes.

6. Click on the Submit Query button when you are done configuring your 
query.The results of the query will appear in the Traffic Log Report.

Viewing the Traffic Log Report
The results of your query appear in the Traffic Log Report viewer. By default, the first 50 
lines of each traffic log appear as a page in the report. You can change the number of lines 
per page that appear by editing the value in the Lines Per Page field, and clicking on the 
Set button. You can also navigate to other pages in the report by using the forward and 
back arrows provided in the top left hand portion of the Traffic Log Report viewer or by 
entering a specific page number in the field provided.



Chapter 5 Monitoring Real Time Information

216 NetScreen-Global PRO Report Manager User’s Guide



NetScreen-Global PRO Report Manager User’s Guide 217

6
Chapter 6

Generating Historical Reports
Report Manager stores all relevant information about your NetScreen security system in 
a relational database. You can generate reports using this information from a web 
browser using the Historical Reports (HR) Console. From the Historical Reports Console, 
you can choose from a selection of over 70 reports to view and analyze alarms, network 
traffic, device and VPN statistics, system resources, logs, and other administrative 
information.

This chapter provides information that describes the Historical Reports Console and how 
you can use it to generate historical reports allowing you to view and analyze data about 
your NetScreen devices and virtual systems. It describes how conceptually the historical 
reporting mechanism works. Finally, it provides step-by-step instructions describing how 
you can generate and customize many of the reports that are available to you.

This chapter includes the following sections:

• Historical Reporting Information Flow

• Accessing the Historical Reports Server

• Using the Historical Reports (HR) Console

• Report Categories

• Generating Reports

• Generating Reports Automatically

• Viewing Reports

• Exporting Reports
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HISTORICAL REPORTING INFORMATION FLOW
All of the device information (i.e., attack alarms, configuration logs, traffic alarms, 
miscellaneous alarms, self logs, and information logs) that is collected by a Data Collector 
gets forwarded by default to a Master Controller, which in turn, forwards the data to a 
database for storage.

You can create and generate reports from this data by using the Historical Reports 
Console.

Historical Reports Console Overview
The Historical Reports Console is a web-based interface that allows you to generate 
reports from data that is stored in the relational database that you are using with Report 
Manager. You can use a web browser (Netscape Navigator 6.0 or higher or Internet 
Explorer 6.0 or higher) to access the Historical Reports Console. Use the Historical 
Reports Console to customize and generate reports related to traffic statistics, alarms, 
service level agreements, device resource statistics and logs.

Historical Reports Server Overview
The Historical Reports Server is based on Tomcat technology which embeds a web server 
that allows you to access and view data on the main database from any web browser.

You can generate a report by making a request from the Historical Reports Console. A 
Tomcat web server receives the request and dispatches the tasks to the Historical Reports 
Server (HRS). The HRS sends the report query to the database. The HRS processes the 
query results and generates the report. It then sends the generated report pages back to 
the Historical Reports Console.

Report Manager uses HTTP/HTTPS to transfer data to and from the Historical Reports 
Console and the Historical Reports Server. In addition, Report Manager uses HTTP/
HTTPS to transfer data to and from the Historical Reports Console and the Historical 
Reports Server.

Note: If there is certain information that you do not need to store on the database, you can 
configure a Data Collector to not “log” or forward that specific information type. Refer to 
Database Event Filters in Chapter 4 for more information.
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ACCESSING THE HISTORICAL REPORTS SERVER
1. Launch a web browser. It is required that you use Netscape Navigator 6.0 or 

higher, or Internet Explorer 6.0 or higher.

2. Enter the address and port number for the Historical Reports Server in the 
Address bar of your browser. Depending on the port selected, enter the following 
address: http://<IP address:Port>/reports/ or https://<IP address:HTPPSPort>/
reports/where <IP address:Port> is the machine IP address/Port number of the 
report server, and Reports is the virtual directory. An HTTPS port provides 
secure access.

For example, if the IP Address of the Historical Reports Server is 10.150.12.345, 
and the port number is 8080, you would enter the following in your browser 
address bar:

http://10.150.42.70:8080/reports

A window will appear prompting you for your username and password.

3. In the Login window, enter your User Name and Password, and click Login.

After you have successfully logged in, you will be taken to the Historical Reports 
(HR) Console page.

Note: You will need to have created a user in Report Manager prior to logging in. 
If you do not already have a user in Report Manager, contact your system 
administrator to create one for you.



Using the Historical Reports (HR) Console

NetScreen-Global PRO 221

USING THE HISTORICAL REPORTS (HR) CONSOLE
Use the Historical Reports Console to create reports detailing information about your 
NetScreen devices and virtual systems.

Use the Category/Reports pane to 
select the type of report that you 
wish to view.

Click to select the device(s) or virtual 
system(s) or other applicable parameter 
(i.e., VPN, cluster, VSD) that you wish 
to generate a report on.

Configure date, time, sampling and other parameters 
for your report in the Report parameters pane.

Click on the Report icon to 
generate your report.

Click on the Scheduler icon to access the Historical Reports 
Scheduler page. From the HR Scheduler page, you can create 
a profile allowing you to save report configuration settings 

and schedule a report to generate automatically.
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About the HR Console Panes
The HR Console has three main components:

• Category/Reports Pane

• Report Context Pane

• Report Parameters Pane

In addition, a status bar that appears at the bottom of the Monitor Console displays the 
active user’s status and program version information.

Category/Reports Pane
Use the Category/Reports pane to access the report selection drop-down list. Click on the 
green “down” arrow to select the report category. From the selected category reports list, 
click on the specific report that you want to generate.Each menu item in the Category/
Reports pane lists several individual reports to select from:

Report Context Pane
Use the Report Context pane to select the device(s), device group(s), virtual system(s), or 
cluster(s) that you wish to generate a report on. Click the plus/minus sign to expand or 
collapse the hierarchy or tree. You can select multiple devices or multiple groups in a 
cluster by clicking each object.

Report Parameters Pane
Use the Report Parameters pane to configure the date, time, sampling duration and any 
other parameters for your report. The Report Parameters pane offers a variety of options 
you can use to generate your reports. These options vary depending on the type of report 
that you select. Note that the dates and hours feature varies according to the type of 
report you choose to generate.

The Sampling Duration choices allow you to view reports for a specified time period. You 
can select hourly, daily, weekly, or monthly intervals. You also have the option of 
sampling the entire duration by selecting All. For example, if you generate a report for the 
last two months, you can select to view information within those two months either by 
month, by week, by day, or by hour.
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REPORT CATEGORIES
You can access 70 reports from the Historical Reports Console. The reports are arranged 
in the following order:

Report Category Reports

Alarms(8) Attack Alarm Summary
Event Alarm Summary
Traffic Alarm Summary
All Alarms Summary
Attack Alarm Analysis
Event Alarm Analysis
Traffic Alarm Analysis
All Alarms By Severity Level

Network Traffic(12) Ethernet Statistics Summary
Flow Statistics Summary
All Defenses Statistics Summary
All Anomalies Statistics Summary
Policy Statistics Summary
Protocol Statistics Summary
Traffic Log Summary
Traffic Log Analysis
Cluster Ethernet Statistics Summary
Cluster Flow Statistics Summary
Cluster Attack Statistics Summary
Cluster Traffic Log Summary
Cluster Traffic Log Analysis

Service Level 
Agreement(14)

Device Uptime/Downtime Statistics
VPN Uptime/Downtime Statistics
VPN Availability Statistics
VPN Average Latency Statistics
VPN Total Uptime/Downtime Statistics
VPN Total Number Of Users
VPN Total Throughput Statistics
VPN Total Throughput By User
VPN Total Throughput By Type
VPN Total Throughput By Group
Cluster /VSD Group Uptime/Downtime Statistics
VSD Group Uptime/Downtime Statistics By Cluster
VSD Counter Statistics By Cluster
Packet Forwarding Counter Statistics By Cluster
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Resources(8) Ethernet Interface Utilization
Device CPU Utilization Statistics
Device Memory Allocation Statistics
Device Session Statistics
Cluster Ethernet Interface Utilization
Cluster Device CPU Utilization Statistics
Cluster Member Memory Allocation Statistics
Cluster Member Session Statistics

Logs(13) Configuration Log Summary
Information Log Summary
Self Log Summary
All Logs Summary
Configuration Log Analysis
Information Log Analysis
Self Log Analysis
All Logs By Severity Level
Cluster Alarm Log Summary
Cluster Configuration Log Summary
Cluster Information Log Summary
All Events By Cluster
All Events For Clusters By Severity

Administration(15) All Groups
All Users
Users And Groups Managing A Device
Users And Groups Managing A Device Group
All Events Grouped By Severity
Device Inventory By User and Configuration
All Device Information
All Device / Vsys/ Interface Summary
All DC Information
All MC Information
User Cluster Information Summary
Cluster VSD Group Information Summary
Cluster RTO Group Information Summary
Device Event Distribution Overview
Event Distribution Overview

Report Category Reports
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Using Alarm Reports
Alarm Reports allow you to summarize and analyze alarm statistics for a particular 
device or groups of devices. You can generate reports for the following alarm types: Attack 
Alarms, Traffic Alarms, and Event Alarms. You have the option of generating either a 
summary or an analysis for each type of alarm.

The following table lists and describes the Alarm reports that you can generate:

Using Network Traffic Reports
Network Traffic Reports allow you to summarize and analyze the type of network traffic 
for a device, group of devices, cluster of devices, or clusters in a group. This category 
contains all traffic-related reports. You can generate summary reports on the following 
Network Traffic types: Ethernet Statistics, Flow Statistics, Attack Statistics, Policy 
Statistics, Protocol Statistics, Traffic Log Summary.

The following table lists and describes the Network Traffic reports that you can generate:

Category Description
Attack Alarm Summary Displays an overview and the severity of the type of attack alarms 

registered against a device or devices over a period of time. 
Event Alarm Summary Displays an overview and the severity of the type of event alarms 

registered against a device(s) over a period of time. 
Traffic Alarm Summary Displays an overview and the severity of the type of traffic alarms 

registered against a device(s) over a period of time. 
All Alarms Summary Displays an overview and the severity of the all alarms registered 

against a device(s) over a period of time. 
Attack Alarm Analysis Displays a more detailed evaluation as well as the severity of the 

attack alarms registered against a device(s) over a specific period of 
time.

Event Alarm Analysis Displays a detailed evaluation and the severity of the event alarms 
registered against a device(s) over a period of time.

Traffic Alarm Analysis Displays a detailed evaluation and the severity of the traffic alarms 
registered against a device(s) over a period of time.

All Alarms by Severity Level Displays a detailed evaluation and the severity of the all alarms 
registered against a device(s) over a period of time.

Category Description

Ethernet Statistics 
Summary

Displays a synopsis of the Ethernet network traffic running on your network. 
Data includes, Bytes In/Out, Collisions, etc.

Flow Statistics 
Summary

Displays a synopsis of the flow network traffic running on your network. Data 
includes, VLAN In/Out, Packets sent, etc.

All Defenses 
Statistics Summary

Displays a synopsis of the defenses that occurred on your network. Data may 
include defenses against Flood, Web./MS-Windows, Scan/Spoof/Sweep or 
DoS attacks.
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Using Service Level Agreement Reports
Service Level Agreement (SLA) reports allow you to summarize and analyze data related 
to VPN and device uptime/downtime. Additionally, it provides reports for VPN 
throughput analysis, latency, availability and remote user distribution as well as reports 
for High Availability.

The following table lists and describes the Service Level Agreement reports that you can 
generate:

All Anomalies 
Statistics Summary

Displays a synopsis of IP Option or TCP/IP Anomalies that have occurred on 
your network.

Policy Statistics 
Summary

Displays a synopsis of the policy-based network traffic running on your 
network. Data may include, Bytes, Packets, and Collisions.

Protocol Statistics 
Summary

Displays a synopsis of the protocol-based network traffic running on your 
network. Data may include, Bytes, Packets, and Collisions.

Traffic Log Summary Displays a synopsis of all the network traffic logs registered on your network. 
Data may include, Bytes and Packets.

Traffic Log Analysis Displays a detailed view of all the network traffic logs registered on your 
network. Data may include, Bytes and Packets.

Cluster Ethernet 
Statistics Summary

Displays a synopsis of the Ethernet traffic running on clusters and their device 
members. 

Cluster Flow 
Statistics Summary

Displays a synopsis of the flow traffic running on clusters and their device 
members. 

Cluster Attack 
Statistics Summary

Displays a synopsis of the attacks that occurred on clusters and their device 
members. 

Cluster Traffic Log 
Summary

Displays a synopsis of all the network traffic logs registered on clusters and 
their device members.

Cluster Traffic Log 
Analysis

Displays a more detailed view of all the network traffic logs registered on 
clusters and their device members.

Category Description

Device Uptime/Downtime 
Statistics

Displays a statistical summary of the uptime/downtime of the 
device(s).

VPN Uptime/Downtime 
Statistics

Displays a statistical summary of the uptime/downtime on VPNs 
associated with specific devices.

VPN Availability Statistics Displays a statistical summary of the availability of VPNs associated 
with specific devices.

VPN Average Latency Statistics Displays a statistical summary of the latency on VPNs associated 
with specific devices.

VPN Total Uptime/Downtime 
Statistics

Displays a statistical summary of the total uptime/downtime of a 
selected VPN.

Category Description
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Using Resource Reports
Resource reports allow you to review the resources used on a network. All device side 
statistics are available in this category. You can generate a Resource report on either a 
per device(s), per device group, or per cluster(s) basis.

The following table displays the Resource reports that you can generate:

VPN Total Number Of Users Displays data on the total user count for a selected VPN.

VPN Total Throughput Statistics Displays a statistical summary of the total throughput (both user and 
type) for a selected VPN.

VPN Total Throughput By User Displays a statistical summary of the user throughput (only) for a 
selected VPN.

VPN Total Throughput By Type Displays a statistical summary of the type throughput (only) for a 
selected VPN.

VPN Total Throughput By Group Displays a statistical summary of the throughput sorted by group for a 
selected VPN.

Cluster/VSD Group Uptime/
Downtime Statistics

Displays a statistical uptime/downtime summary for clusters or VSDs 
(virtual security devices)

VSD Group Uptime/Downtime 
Statistics By Cluster

Displays the total uptime/downtime for clusters or VSDs.

VSD Counter Statistics By 
Cluster

Displays a statistical counter for clusters.

Packet Forwarding Counter 
Statistics By Cluster

Displays a statistical counter of the packets forwarded for clusters.

Category Description
Ethernet Interface Utilization Displays the average Ethernet usage for a device or 

a device group. Data appears in percentages.
Device CPU Utilization Statistics Displays a statistical summary of the average CPU 

utilization for a device or a device group. 
Device Memory Allocation Statistics Displays a statistical summary of the memory 

allocation for a device or a device group. 
Device Session Statistics Displays a statistical summary of the session 

statistics of a device or a device group. 
Cluster Ethernet Interface Utilization Displays the average Ethernet usage for a cluster. 

Data appears in percentages.
Cluster Device CPU Utilization Statistics Displays a statistical summary of the average CPU 

utilization for a cluster.
Cluster Member Memory Allocation Statistics Displays a statistical summary of the memory 

allocation for a cluster.
Cluster Member Session Statistics Displays a statistical summary of the session 

statistics for members of a cluster.

Category Description
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Using Log Reports
Log reports allow you to review the alarm or event alarms that were generated on a given 
network. These reports are related to logs generated by the device. You can also generate 
reports for Config/Info/Self log analysis.

The following table displays the Log reports that you can generate:

Category Description
Configuration Log Summary Displays a statistical summary of the configuration logs 

registered to a device or device group.
Information Log Summary Displays a statistical summary of the information logs 

registered to a device or device group.
Self Log Summary Displays a statistical summary of the self logs registered to 

a device or device group.
All Logs Summary Displays a statistical summary for all logs registered to a 

device or device group.
Configuration Log Analysis Displays details on the configuration logs registered to a 

device or device group.
Information Log Analysis Displays details on the information logs registered to a 

device or device group.
Self Log Analysis Displays details on the self logs registered to a device or 

device group.
All Logs By Severity Level Displays and sorts by severity all logs registered to a 

device or device group.
Cluster Alarm Log Summary Displays a statistical summary of the alarms registered to a 

cluster.
Cluster Configuration Log Summary Displays a statistical summary of the configuration logs 

registered to a cluster.
Cluster Information Log Summary Displays a statistical summary of the information logs 

registered to a cluster.
All Events By Cluster Displays and sorts logs by events registered to a cluster.
All Events For Cluster By Severity Displays and sorts by severity all logs registered to a 

cluster.
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Using Administration Reports
You can generate Administration reports to help you view and manage all the groups, 
users, Data Collectors, Master Controllers, clusters and devices in your Report Manager 
system.

The following table displays the Administration reports that you can generate.

Warning: Access to the data (i.e., All Groups, Users, DC/MC information etc...) that you 
can view on the Administration Reports is not restricted to a user’s role-based privileges in 
Report Manager. So, for example, if a user can access the Administration Reports, he or she 
can generate a report and view data configured in the Report Manager system regardless of 
whether they are an administrator or not. To control access to the data in the 
Administration Reports, it is recommended that you disable read privileges to the 
Administration Reports to all users except for your authorized administrators. Refer to 
Configuring Report Privileges for more information.

Category Description

All Groups Displays information on all groups within a given network.

All Users Displays information on all users within a given network.

Users And Groups Managing a 
Device

Displays information on the users and groups managing a given 
device.

Users and Groups Managing a 
Device Group

Displays information on the users and groups managing a given 
device group.

All Events Grouped By Severity Displays information on events grouped by severity. Severity levels 
range from: Critical, Major, Minor, Warning, Intermediate, and 
Clear.

Device Inventory By User And 
Device Group

Displays a device inventory by user and device group.

All Device Information Displays all the data on all devices in a given network.

All Device/Vsys/Interface 
Summary

Displays a summary of the devices, Vsys, and interfaces in a given 
network.

All DC Information Displays information on all Data Collectors in a given network.

All MC Information Displays information on all master controllers in a given network.

User Cluster Information Summary Displays a summary of all user cluster information.

Cluster VSD Group Information 
Summary

Displays a summary of cluster information network for a VSD 
(Virtual Security Device).

Cluster RTO Group Information 
Summary

Displays a summary of cluster information network for a RTO (Run 
Time Object).

Device Event Distribution 
Overview

Displays total number of events occurring on each NetScreen 
device.

Event Distribution Overview Displays the total number of event types occurring on all devices.
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GENERATING REPORTS
You can configure and generate any report by choosing the report you want from the 
Category/Reports pull-down menu.

1. In the Category/Reports pane, use the Category/Reports pull-down menu and 
select a report category. The list of available report categories will appear.

2. Click to select a report category. The report list for that category will appear.

3. Click to select a report type. The Report Context and Report Parameters panes 
will change according to the report type selected.

4. In the Report Context pane, select the device group(s), device(s), virtual 
system(s), or cluster(s) on which you wish to generate a report.

Click to collapse the entire list.

Click to expand the entire list.
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5. In the Report Parameters pane, enter a specific period of time to and from which 
you wish to generate the report for. Use the date/time format icon to toggle the 
way Report Manager displays the date and time between US and European 
formats. Use the calendar icon to select a date.

6. Enter any other parameters that may be applicable for the report (i.e., Alarm 
Type, Interface, etc...).

7. Click on the Report icon in the toolbar. This takes you to the report page.

Click to select a date from the calendar.

Click to change the date/time format.
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GENERATING REPORTS AUTOMATICALLY
You can also create a report template or profile to generate a report(s) automatically. A 
report profile allows you to save all of the parameters that you have specified to generate 
a report. You can also schedule reports to be generated on a recurring basis. Report 
Manager will send you an e-mail notifying you when reports are available for viewing. 
You can later add, edit, or delete any of the tasks that you have defined in a profile.

Creating a Report Profile
1. Click on the Scheduler icon in the Historical Reports Console toolbar. This 

takes you to the Historical Reports Scheduler page.

2. Click on the Create Profile icon in the Historical Reports Scheduler toolbar. 
This takes you to the Task Profile - Create page.

3. Edit the Profile Name that appears in the Profile Name field to give your 
profile a name that you will remember easily.
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4. Use the Reporting Window to specify the length of time that you want the 
report to cover. You can specify to generate a report for data occurring during 
the last n day(s), week(s), month(s), or quarter(s).

5. Specify a date and time when you want to start generating the report. 

6. Specify a date and time when you want to end generating the report.

7. Use the Category/Reports, Report Context, and Report Parameters panes to 
configure the report that you wish to generate.

8. Click on the Save icon in the Historical Reports Scheduler toolbar. A Create 
Profile Confirmation dialog appears indicating that Report Manager has saved 
your profile in the database.

The Report Profile now appears in the Historical Reports Scheduler page.

Scheduling a Report to Generate on a Recurring Basis
Use the Task Recurrence pull-down menu to select how often you would like to generate 
the report. You can choose to generate the report once only, hourly, daily, weekly, 
monthly, or quarterly.

Enabling E-Mail Notification
Click the ON radio button if you want Report Manager to send you an e-mail indicating 
when the report has been generated.

Click the OFF radio button if you do not want Report Manager to send you an e-mail.

Editing a Report Profile
1. Click on the Edit icon corresponding to the profile name that you wish to edit. 

This takes you to the Task Profile - Edit page.

2. Edit any of the parameters that you previously configured for the profile.

Note: You may need to wait at least 30 seconds before tasks that you have 
configured in your profile begin.

Note: For e-mail notification to work properly, you must have configured e-mail properties 
(i.e., SMTP Server, Sender’s E-Mail Address) on the Historical Reports Server; and for the 
user as well.
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3. Click on the Save icon in the Historical Reports Scheduler toolbar. A Create 
Profile Confirmation dialog appears indicating that Report Manager has 
updated your profile in the database.

Deleting a Report Profile
1. Click on the Delete icon corresponding to the profile name that you wish to 

delete. A dialog appears asking you whether you want to delete the profile or the 
selected task only.

2. Click to select the Profile radio button. If you select the Task radio button, 
Report Manager will delete only that specific task.

3. Click OK to confirm the deletion. A dialog appears confirming that you have 
deleted the profile and its associated tasks. The Profile and its associated tasks 
no longer appear in the Historical Reports Scheduler page.

Deleting a Report Task
To delete a specific report task, follow the same procedures to delete a report profile, but 
select the Task radio button when prompted.

Saving Report Data
Report Manager stores the generated report data files under a subdirectory in the 
installation directory on the Historical Reports Server (e.g. <installDir>/
reportServer/webapps/reports/data).

If you would like to maintain a large history of generated reports, it is recommended that 
you change the location where the data is stored to a directory on a computer which can 
provide additional storage.
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Viewing the Status of Report Tasks
To view the status of those tasks that you have configured in your report profiles, click on 
the Task Status icon in the Historical Reports Scheduler toolbar.

Use the Filter Pane that appears on the left side of the page to specify which tasks you 
wish to view. In the Tasks Pane, each task is listed by Profile Name, Scheduled Time, and 
Status. The status of each task is described as either Created, Running, or Completed.

Viewing Report Profile Tasks by Date
Use the calendar tool or enter a date in the Date field provided to view the status of report 
tasks scheduled on a specific date.

Specify which tasks you want 
to view in the Filter Pane.

Tasks are listed by Profile Name, 
Scheduled Time, and Status.

Click to Edit or Delete 
the Profile.

Click the Refresh icon to 
refresh the display.Click on the Profile Name or Scheduled 

Time header to sort the tasks in ascending 
or descending order.
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Viewing Report Status by Period
Use the Period pull-down menu to view the status of those tasks scheduled during a 
specific past or future time period. You can view the status of all tasks or only those tasks 
scheduled during the last or next day, week, month, or quarter.

Viewing Report Status by Completion Status
Use the Status pull-down menu to view created, running or completed tasks.

Viewing Report Status by Profile Name
Use the Profile pull-down menu to view those tasks related to a specific report profile.

Refreshing the Display
Click on the Refresh icon in the Historical Reports Scheduler toolbar to refresh the 
display.
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VIEWING REPORTS
When Report Manager has completed generating your report, the Status on the profile 
will change to “Completed”. Click on the Completed link to view the report.

Report Manager displays historical report data in a tabular format by default.

Report Manager displays a summary indicating the total number of pages in the report, 
the current page that you are viewing, and the total rows that are displayed per page.

Report Manager also includes a Report Setting section displaying general information 
about the report including:

• Admin: Displays name and contact information of the user who generated the 
report.

• Device Group (if applicable): Displays associated device group.

• Device (if applicable): Displays general device information, including IP 
address and serial number.

• Report Hour Start/End (time): Displays the designated start/end time for the 
report.

Specifying the Number of Rows Displayed
You can specify the number of rows displayed per page by entering the number in the 
Rows Per Pages field and pressing Enter.
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Using the Report Index
The Report Index allows you quick access to pages in your report that are specific to a 
node (i.e., device, user) by default. Double click on the plus or minus icons to move up and 
down through the nested nodes. A red arrow will appear on the left of the node that is 
currently displayed.

You can customize the Report Index to allow you quick access to any page in your report 
according to your own preference. For example, if you were only interested in accessing 
pages in your report that displayed data according to a specific date, you could customize 
the Report Index to display only date entries.

Customizing the Report Index
1. Click on the Customize icon in the Historical Reports Console toolbar. Select 

Report Index. This takes you to the Customize Report Index page.

2. To add a specific node in the Report Index, click to select one of the nodes listed 
in the Available Nodes field and click on the right arrow. The selected node 
appears in the list of Selected Nodes.

3. To remove a specific node in the Report Index, click to select one of the nodes 
listed in the Selected Nodes field and click on the left arrow. The selected node 
appears in the list of Available Nodes.

4. To change the order in which a specific node appears in the Report Index, click to 
select the node in the Selected Nodes field and click on the down or up arrow.
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5. Click on the Set button when you are done. This takes you back to the Historical 
Reports page.

Hiding the Report Index
You can remove the Report Index Pane from the Report page by clicking on the Hide icon 
in the Historical Reports Console toolbar.

You can bring the Report Index Pane back by clicking on the Show icon in the Historical 
Reports Console toolbar.

Sorting Report Data
You can sort the data appearing in any column by clicking in the header of that column. 
Once you click on a column header, an arrow appears indicating the sort order.

You may also be able to sort the report data using different criteria depending on the 
specific report that you have generated.

Customizing Report Columns
You can also remove and then add back any column that appears in a report.
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1. Click on the Customize icon in the Historical Reports Console toolbar. Select 
Table Details. This takes you to the Customize Table Details page.

2. To remove a specific column from the report, click to uncheck the checkbox 
corresponding to the display column that you want to remove.

3. To add a specific column from the report, click to check the checkbox 
corresponding to the display column that you want to remove.

4. Click on the Set button when you are done. This takes you back to the Historical 
Reports page.

Viewing Report Data Graphically
Report Manager also allows several graphical views of the data including:

• Bar chart

• 2D or 3D Bar - allowing you to view data in a 2- or 3-dimensional bar chart (only 
available with bar charts).

• Stacked Bar (only available with bar charts).

• Plot Chart

• Pie Chart
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Use the Historical Reports toolbar to select the graphical view that you want.

Click to view the data table.

Click to change graphical rendering as bar chart, 2 
or 3 dimensional, stacked bar, line graph, or pie chart.

Click to zoom in 
or out.

Click to view the next index page.

Refresh report.
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Viewing More Details
You can click on most of the data depicted graphically to drill-down and view the report in 
more detail.

Click on the bar chart to 
drill down and view device-

specific data.
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EXPORTING REPORTS
You can export reports to either an Adobe Acrobat (.pdf) or Microsoft Excel (.csv) file. 
When exporting to a .PDF file, only the current view is exported.

1. Click on the Export icon in the Historical Reports Console toolbar.

2. Select either PDF or CSV to specify the type of file you would like to export the 
data to. A dialog will appear prompting you to select either Open, Save, Cancel, 
More Information.

3. Click Save to export the file. Browse to the directory where you want the 
exported file saved. Report Manager will generate the file and save it in the 
directory you specified. A dialog will appear indicating that the file download 
was complete.

Note: Exporting a tabular report to a .PDF may take several minutes.
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7
Chapter 7

Performance Tuning
Depending upon your specific reporting needs, Report Manager provides you with the 
flexibility to control and manage the flow of information from your devices to Data 
Collectors and from Data Collectors to your Monitor Console allowing you to improve your 
overall system performance.

This chapter provides recommendations that describe how you can tune Report Manager 
for better performance. It includes the following sections:

• Performance Tuning the Data Collector

• Disabling Information Sent From the Device

• Performance Tuning the Monitor Console
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PERFORMANCE TUNING THE DATA COLLECTOR
There are several methods that you can use to optimize the performance of Report 
Manager. The most effective of these methods involves restricting the amount of 
information that the Data Collector must process. You can accomplish this in several 
ways:

• Disabling Traffic Log Recording in the Database

• Disabling Other Log Recording in the Database

• Disabling Event Message Aggregation

• Decreasing the Event Buffer Size

• Increasing Device Polling Intervals

• Increasing Save Statistics to Database Intervals

Disabling Traffic Log Recording in the Database
The most effective way that you can improve the performance of Report 
Manager is to verify that you are not recording traffic logs in the database.

Your NetScreen devices are capable of generating a large volume of traffic logs. If you 
have a large number of NetScreen devices in your system, the number of logs created can 
quickly become unmanageable. As traffic log updates are received, the Data Collector 
must devote more and more of its processing capability to forward the information to the 
database. This may result in a degradation of the Data Collector’s ability to perform its 
other functions. For this main reason, the option to record traffic logs in the database is 
disabled by default.

Another good reason why you do not want to record traffic logs in the database, is that 
this information is typically not very useful since it is generated only after a session has 
ended.

If there is a need to store traffic logs in the database (for example, for auditing purposes if 
you have a contractual obligation to save all traffic logs to verify whether specific traffic 
sessions have been established in the past), it is highly recommended that you record 
traffic logs in local files on the Data Collector. Refer to Recording Traffic Logs in Chapter 
4 for more information.

Disabling Other Log Recording in the Database
Depending upon your specific business needs, you can also disable the recording of other 
event information in the database. Decreasing the amount of information that needs to be 
recorded in the database will help your overall system performance. For example, if you 
are not interested in configuration information, you could disable the recording of 
Configuration logs in the database.

Refer to Database Event Filters in Chapter 4 for more information.
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Disabling Event Message Aggregation
One of the more powerful features of Report Manager is its ability to aggregate duplicate 
event messages. After an event message is transformed, the Data Collector performs a 
lookup on its internal hash tables for the incoming message ID. When it identifies a 
duplicate message, it aggregates the two messages into one and sends this to the Monitor 
Console. This helps to reduce the amount of similar information viewable on the Monitor 
Console.

Aggregating messages will however, have an adverse affect on the performance of the 
Data Collector. Depending on your specific business needs, you may want to consider 
disabling message aggregation to further reduce the processing overhead on the Data 
Collector.

Refer to Event Aggregation in Chapter 4 for more information on disabling message 
aggregation.

Decreasing the Event Buffer Size
Another way to improve the performance of the Data Collector is to decrease the number 
of events that a Data Collector must store in its cache or event buffer. You can do this by 
decreasing the size of the Data Collector’s event buffer. Refer to Event Buffer Size in 
Chapter 4 for more information on disabling message aggregation.

Increasing Device Polling Intervals
Another way that you can reduce the overall traffic on the Data Collector is to limit the 
amount of times that it must poll its devices. Remember that each Data Collector polls its 
devices for certain data (protocol distribution, policy table, attack statistics, ethernet and 
flow statistics, NSRP and VPN statistics), which it then must forward to each console and 
a Master Controller (for later storing in the database). If your need for polled data is not 
immediate, you can improve performance on the Data Collector by increasing or 
“stretching” the interval with which it polls its devices.

To configure the device polling interval:

Note: If you do disable message aggregation, you will see more messages in the Monitor 
Console.

Note: The device polling interval applies to all devices.

Warning: It is recommended that you set the Interface table polling interval to no more 
than 120 seconds (or 2 minutes) to avoid these counters from rolling-over. In some cases, it 
is possible for interface counters (i.e., ethernet stats) to roll-over. For example, if you have a 
32 bit counter on a device with a 1 Gb interface, you can quickly fill out the counter with 
data coming in at a sustained rate of 1000 MB/sec. This can cause the counter to restart at 
0 or “roll-over”, resulting in a loss of data.
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1. From the Report Manager Console, click on the Data Collector button in the 
Control pane.

2. Select a Data Collector from the List pane. The profile for the Data Collector 
appears in the Details pane.

3. From the Data Collector profile, click on the Device Polling tab.

4. Use the pull-down menus to increase the interval (in seconds) with which the 
Data Collector will poll its devices for Device, VPN, NSRP and Interface 
statistics.

5. Click on the Save button in the Report Manager Console toolbar to save your 
changes; or click the Undo button to cancel your changes.

Increasing the Interval That the Data Collector Saves 
Device State Information

If you are not configuring your Data Collectors to provide failover protection, you will not 
need to have the Data Collector flush device state information to its device log. In this 
case, it is highly recommended that you increase the interval that the Data Collector will 
save device data to disk to its highest setting (7200 seconds). This will improve the 
overall performance of the Data Collector as it saves device state information to its device 
log less frequently.

Increasing Save Statistics to Database Intervals
Each Data Collector is configured to send or “flush” statistics to the database according to 
the following intervals by default:

• device statistics every 3600 seconds (or 1 hour)

• VPN and NSRP statistics every 7200 seconds (or 2 hours)

• logs and alarms every 60 seconds (or 1 minute)

If your need for pushed statistics is not immediate, you can improve performance on the 
Data Collector by increasing or “stretching” the interval with which it sends this 
information to the database.

To configure the time intervals that the Data Collector saves statistics to the database:

1. From the Report Manager Console, click on the Data Collector button in the 
Control pane.

2. Select a Data Collector from the List pane. The profile for the Data Collector 
appears in the Details pane.

3. Click on the Database Settings tab.

4. Use the pull-down menus to increase the intervals with which the Data Collector 
sends Device, VPN, NSRP, and Interface Statistics to the database.

Note: You cannot disable the Data Collector from saving device data to disk.



Performance Tuning the Data Collector

NetScreen-Global PRO 249

5. Click on the Save button in the Report Manager Console toolbar to save your 
changes; or click the Undo button to cancel your changes.
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DISABLING INFORMATION SENT FROM THE DEVICE
Another good way to improve your overall system performance is to reduce the overall 
amount of information that is sent from each device to its Data Collector. For example, 
you may want to consider disabling configuration logs on a specific device. This is because 
Policy Manager keeps this information at a higher level than does the device. This makes 
it difficult to correlate the two.

Although you may use ScreenOS to configure each device to initially send specific types of 
information to Global-PRO, you will want to use the Report Manager Console anytime you 
want to reconfigure these settings. The settings that you configure in Report 
Manager will overwrite any previous settings on the device.

To disable information sent from a device:

1. From the Report Manager Console, click on the Devices button in the Control 
pane.

2. Select a device from the List pane. The profile for the device appears in the 
Details pane.

3. Click to select the Device Settings tab.

4. Uncheck the checkbox corresponding to the message type that you want to 
disable in the Enable the Following Tables section. Click the Clear All button to 
disable all message types; click the Select All button to enable all message 
types.

5. Click on the Save button in the Report Manager Console toolbar to save your 
changes; or click the Undo button to cancel your changes.
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PERFORMANCE TUNING THE MONITOR CONSOLE
Report Manager also allows you to control and manage the flow of information to the 
Monitor Console. You can accomplish this in the following ways:

• Configuring the Monitor Filter

• Limiting Table Sorting

• Limiting the Amount of Traffic/Self Logs

• Increasing the Device Statistics Polling Interval

• Decreasing the Event Viewer Cache Size

Configuring the Monitor Filter
The Monitor Filter allows you to set certain criteria defining which information is allowed 
to pass from the Data Collectors to the Monitor Console. To optimize the performance of 
the Monitor Console, you can configure the monitor filter to limit the flow of information 
to the Monitor Console. For example, if you were only interested in information from 1 
device group, you could configure the Monitor Filter to pass only this information to the 
Monitor Console.

To configure the Monitor Filter:
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1. From the Monitor Filter menu, select New. The Monitor Filter Definition 
window appears.

2. Click in the Filter Name field and enter a specific name for the filter. You cannot 
reconfigure or delete the default filter.

3. If you wish to view information from a specific time, check the Timestamp 
check box and enter the desired time.

4. Click in the Condition Name field and enter a specific name for the Condition. 
Naming a condition will make it easier for you to configure multiple conditions 
in a display filter. You cannot reconfigure or delete the default condition.

5. Select the device(s) that you wish to monitor. Double-click on All Devices to 
view all available devices. Click the + or - icon to expand or collapse the list of 
devices.

6. Select the event type(s) or event(s) that you wish to monitor. Double-click on All 
Events to view all available events. Click the + or - icon to expand or collapse 
the list of events.

7. Use the And/Or drop-down to include events of a certain severity level. Use the 
Severity drop-down to select a specific severity level.

8. Click on the Update icon when finished.

Report Manager saves the Monitor Filter as a .nmf (NetScreen Monitor Filter) file. The 
file is saved in a folder called “Monitor Filter” on your local drive by default.
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Applying the Monitor Filter
Saving the Monitor filter does not automatically apply the filter to the data. Click on the 
Apply icon to apply the Monitor filter to the device data. After clicking Apply, the Filter 
becomes “Active” and is displayed in the Display Filter and Event Summary panes.

Limiting Table Sorting
Report Manager sorts the data in all its tables every time a new record is added by 
default. To improve performance on the Console, you can configure Report Manager to 
sort tables only when you click on the column header.

To limit table sorting:

1. From the Monitor Console, use the Tools menu and select Customize. The 
Customize window will appear.

2. From the Options tab, uncheck the Sort - Always checkbox.

3. Click OK to apply your changes; click Cancel to cancel your changes.

Limiting the Amount of Traffic/Self Logs
Report Manager also allows you to limit the total number of traffic and self logs that will 
appear on the Monitor Console.

To limit the amount of traffic/self logs:
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1. From the Monitor Console, use the Tools menu and select Options. The 
Options window will appear.

2. From the Preferences tab, click in the Number of Traffic/Self Logs section, and 
decrease the number of traffic/self logs that Report Manager caches. The default 
maximum logs kept is 2000.

3. Click OK to apply your changes; click Cancel to cancel your changes.

Increasing the Device Statistics Polling Interval
If your need for device statistics is not immediate, you can further improve the 
performance of the Monitor Console by increasing the interval time with which the 
console polls devices for device statistics.

To increase the device statistics polling interval:

1. From the Monitor Console, use the Tools menu and select Options. The 
Options window will appear.

2. From the Preferences tab, click in the Device Statistics Polling Interval 
section, and increase the number of seconds with which Report Manager polls all 
devices. The default interval is 120 seconds (or 2 minutes).

3. Click OK to apply your changes; click Cancel to cancel your changes.

Decreasing the Event Viewer Cache Size
Much in the same way that you can improve the performance of a Data Collector by 
decreasing the number of events that it must store in cache, you can similarly improve the 
performance of the Monitor Console by decreasing the size of its cache.

To decrease the event viewer cache size:
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1. From the Monitor Console, use the Tools menu and select Options. The 
Options window will appear.

2. Select the Event tab.

3. Click in the Number of Records checkbox, and decrease the maximum number 
of records that Report Manager caches. The default number of records is 10,000.

4. Click in the Memory Usage checkbox, and decrease the size of the cache 
memory used by Report Manager. The default memory usage is 5 MB.

5. Click OK to apply your changes; click Cancel to cancel your changes.
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8
Chapter 8

Troubleshooting
Report Manager provides several tools that will help you to diagnose and troubleshoot 
common errors that you may experience while using Report Manager. This chapter 
describes these tools and how you can use them to troubleshoot problems with Report 
Manager.

Its main sections include:

• Troubleshooting Report Manager

• Checking System Health

• Using Report Manager Log Files

• Using Report Manager Initialization Files

• Troubleshooting the Device
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TROUBLESHOOTING REPORT MANAGER
Report Manager provides you with several tools to help you diagnose and troubleshoot 
common problems.

Use the System Health view to check on the overall health of the Data Collectors and 
Master Controllers. Refer to Checking System Health for more information on using the 
System Health view.

Report Manager also generates log files describing events as they occur on each server 
component. Refer to Using Report Manager Log Files for more information on using the 
server log files to diagnose and troubleshoot common errors.

Using Device Debug Information
You can also configure the device to produce debug information. Refer to the ScreenOS 
documentation for more information on enabling debug information on the device.
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CHECKING SYSTEM HEALTH
From the Report Manager Console, you can access the System Health Console. The 
System Health Console is a read-only view indicating the status of the Data Collectors 
and Master Controllers configured in your Report Manager system. It also provides the 
status of any database cleanup operations performed by the Master Controller. Click on 
the System Health button in the Report Manager Console to launch the System Health 
Console.

The System Health Console provides the following information:

Item Identifies...

Name Name of the component when added to the system.

IP IP Address of the component.

Type the Report Manager server component as a Data Collector or Master 
Controller.

Last Heartbeat Most recently recorded heartbeat for the Data Collector and Master Controller.

Interval (in seconds) Length of time between the current time and the last heartbeat. If the current 
time is greater than the specified interval, it displays the server as down.

CPU Load (%) the percentage CPU utilization by the server component.

You can also view the status of the last database cleanup operation 
performed by your Master Controllers.
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JVM Free Mem. (%) (Java Virtual Machine) Remaining percentage of allotted memory still free.

Item Identifies...
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USING REPORT MANAGER LOG FILES
Report Manager produces detailed sequences of statements describing events on each 
server component as they are executed. This information is generated in separate log files 
for the Master Controller and Data Collector. You can use the Master Controller and Data 
Collector log files to view the context in which errors are occurring on your Report 
Manager components which may help you to diagnose and troubleshoot common 
problems.

Log files are stored in a subdirectory called “logStatus” in the installation directory of 
each Report Manager server component. They are listed sequentially in the order that 
Report Manager writes to them (i.e., log01, log02 etc...). Report Manager allocates 10 
MB of disk space for each component log file by default. When the maximum is reached, 
Report Manager overwrites the oldest log file.

To access the Report Manager log files, navigate to the logStatus directory in the Report 
Manager installation directory (i.e., <INSTALL_DIR>/logStatus directory) of the 
component that you are attempting to debug.

Configuring Log Files
You can configure each component log file to provide more or less information as 
necessary by editing the parameter in the log configuration file.

1. Navigate to the logStatus directory in the Report Manager installation directory 
(i.e., <INSTALL_DIR>/logStatus).

2. Edit the parameter for the appropriate component.

Common Error Messages
The following table describes several common error messages that you may find in the 
Report Manager log files:

Error May indicate the following 
problem: Troubleshooting Tip:

Db Connection 
creation failed: 

The Oracle database has 
reached its pre-set upper limit of 
processes.

1. Increase the database “processes” 
limit (i.e., $ORACLE_HOME/dbs/
init<ORACLE_SID>.ora.

2. Run SQLPlus from the database 
machine.

3. Run a glproMC -test command for 
additional information.

writeExternal:..
.

The installation directory on the 
server might be running out of 
disk space.

Check the remaining disk space left.
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... 
writeDCProps:...

The current user does not have 
the correct permissions to use the 
application.

Verify that the current user starting Report 
Manager has write permission to the 
following files:
<INSTALL_DIR>/pro.mc.init
<INSTALL_DIR>/pro.dc.init

Unable to 
determine the IP 
address of the 
local host. Make 
sure the system 
host name is 
correctly set

The host name defined in /etc/
hosts is not the same as the host 
running the Solaris system.

Verify that the host name defined in /etc/
hosts is the same as the host running the 
Solaris system.

... 
insertDbRecord:

The database disk file used by 
Report Manager is full. 

Verify the available disk space on the 
database disk file used by Report Manager.

Authentication 
to device failed

The “Device Login ID”/“Device 
Login Password” in the database 
doesn't match that in the device. 

Update the “Device Login ID”/“Device Login 
Password” in Report Manager.

DC to MC's 
authentication 
failed

The Data Collector has not been 
created in the database (via the 
Report Manager Console), or the 
“Customer Authentication Id” 
used during the Data Collector 
installation doesn't match that in 
the Master Controller installation.

Verify that you have created the Data 
Collector in Report Manager.
Verify that the “Customer Authentication Id” 
used for the Data Collector matches the ID 
configured for the Master Controller.

Data Collector 
at:..., is not 
connecting to a 
Master 
Controller 
running a 
compatible 
version

The Master Controller is not 
running the same version as the 
Data Collector.

Verify that both the Master Controller and 
Data Collectors are running the same 
version:
<INSTALL_DIR>/glproMC -
version

<INSTALL_DIR>/glproDC -
version 

If they are not, you must upgrade the Master 
Controller and/or Data Collector 
accordingly.

Re-connect to MC 
failed

Either the Master Controller is not 
running, or that the network 
connection to it is dead. 

Run the following diagnosis for more 
information:
<INSTALL_DIR>/glproDC -test

 
flushEmailNotifi
cation

System is having problems 
connecting/communicating with 
the SMTP server.

Verify if the SMTP server IP-address is 
correctly set in the database (via the Report 
Manager Console). Also, verify that the 
SMTP server is running.

Error May indicate the following 
problem: Troubleshooting Tip:
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Database version 
not match: 
please upgrade 
the DB version

Database schema version does 
not match that of the Master 
Controller. 

Verify that you have updated the database 
schema to match the version running on the 
Master Controller.

not associated 
with a valid SQL 
server 
connection

The Master Controller is having 
trouble connecting to the 
database.

Go to the database you created at the SQL 
server group level when you installed MS-
SQL and under Properties->Security-
>Authentication verify that SQL Server & 
Windows is set.

Error May indicate the following 
problem: Troubleshooting Tip:
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USING REPORT MANAGER INITIALIZATION FILES
Installing each server component automatically generates the following property files for 
each server component. You may use these scripts to edit the initialization parameters 
before starting each service.

Generating Server Logs
On occasion, you may need to generate log files on each server component to share with 
Technical Support.

To generate server log files:

1. Open the pro.dc.init and pro.mc.init files in the installation directory of 
the component in any text editor.

2. Edit the following properties:

• dc.smedc.init.debug.on=true (in the pro.dc.init file)

• mc.smemc.init.debug.on=true (in the pro.mc.init file)

3. Stop the Master Controller and Data Collectors.

4. Restart the Master Controller and Data Collectors.

5. After the condition occurs, mail the log files located under <install directory>/
logStatus to Technical Support.

Server Component Initialization File

Master Controller pro.mc.init

Data Collector pro.dc.init

Historical Reports Server pro.report.init
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TROUBLESHOOTING THE DEVICE
Report Manager allows you to communicate using Telnet or a Secure Command Shell to 
query on the status of a device. You can use this capability to issue a “get” Telnet 
command to a NetScreen device or a NetScreen CLI command to the SCS (Secure 
Command Shell) on the device to troubleshoot problems.

Issuing Commands To a Device
1. From the Monitor Console, use the View menu and select Device Statistics for 

the device that you want to query.

2. Click on the Troubleshooting view.

3. Click in the Telnet or SCS radio button to specify how you want to 
communicate with the device.

4. Enter a command in the Get Command field. Alternatively, you can click on 
any of the available shortcuts from the list of Shortcuts.

5. Click on the Execute Command button. Information from the query appears in 
the display field. The command is logged in the History field.

6. Click on the Add to Shortcut to add the command to the Shortcuts field

Note: Refer to NetScreen CLI Reference Guide for more information on CLI commands.
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9
Chapter 9

Upgrading Report Manager
This chapter provides information that describes how to upgrade your existing version of 
NetScreen-Global PRO Report Manager 3.x to version 4.0.

It includes the following sections:

• Upgrading from 3.x to 4.0

• Upgrading Server Components

• Upgrading the Database

• Upgrading the Report Manager Console

• Recovering From a Failed Upgrade
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UPGRADING FROM 3.X TO 4.0
This section contains procedures for upgrading your existing version of NetScreen-Global 
PRO Report Manager 3.x to version 4.0.

Migration Path
To upgrade to 4.0, you must be running Report Manager 3.1.1 r2. If you are running a 
previous version of Report Manager, you must follow the migration path that leads to 
Report Manager 3.1.1.r2 before proceeding to upgrade to 4.0.

Refer to the NetScreen Global-PRO Report Manager v3.0 Installer’s Guide and the release 
notes for all later versions of Report Manager 3.x for more information on how to upgrade 
previous versions of Report Manager to Report Manager 3.1.1 r2.

Upgrade Process
The process of upgrading your existing installation of Report Manager to 4.0 is as follows:

• Backing Up Your Previous Installation

• Upgrading Server Components

• Upgrading the Database

• Upgrading the Report Manager Console

Backing Up Your Previous Installation
It is very important that you make a backup copy of your existing Report Manager server 
and console data before proceeding to upgrade. This is to ensure that you will not lose any 
data saved should any problems occur during the upgrade procedure.

Before you begin, you will want to first verify that you have stopped all Report Manager 
services and that you have sufficient disk space available on the partition on which you 
plan to save your backup files.

Backing Up the Server
1. Stop all Report Manager services (i.e., Data Collector, Master Controller, and 

Historical Reports Server).

2. Make a backup copy of the currently installed version of each Report Manager 
server component (i.e., Data Collector, Master Controller and Historical Reports 
Server). Do not save the backup files in the installation directory. For example, 
to change directories to the default installation directory and issue the tar 
command to backup your files, you would enter the following commands:

% cd /opt/NETSglPRO

% tar cvf <tar file 1>
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3. Backup your database files. For example, if you were using an Oracle database, 
you would enter the following commands to change directories to the default 
database installation directory, and export the files to a backup file called 
“scott.dmp”:

% cd $ORACLE_HOME/bin

% exp scott/tiger file=scott.dmp owner=scott grants=Y rows=Y 
compress=Y

Backing Up the Console
1. Navigate to the Report Manager installation directory (i.e., C:\Program 

Files\NetScreen\Report Manager).

2. Copy all the contents of the Report Manager folder.

Note to Oracle 9i database users: You may receive the following error 
message when you are exporting the data, if you do not have the proper privileges:

“identifier 'SYS.LT_EXPORT_PKG' must be declared”

If this occurs, you can execute a “Grant Execute On” command specifying the 
SYS.LT_EXPORT_PKG package to your database user name. To do this, connect 
as the sys user to Oracle and grant the privilege, for example:

% sqlplus 
Enter user-name: sys as sysdba
Enter password: change_on_install
SQL> GRANT EXECUTE ON sys.lt_export_pkg TO scott;
SQL> quit

Note that "change_on_install" is the default password of the sys user.

After granting the privilege, the export should run without errors.
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UPGRADING SERVER COMPONENTS
Once you have successfully made a backup copy of your server and console data, you can 
proceed to upgrade your server components.

1. Ensure that you are logged on to the server computer using an account with the 
appropriate privileges.

2. Insert the NetScreen-Global PRO Report Manager installation CD.

3. Click Install.

If mounting manually, enter the following command:

./PROupgrade.bin

If you are in Console Mode, enter the following command at the prompt:

./PROupgrade.bin -i console

The Report Manager installer will appear to guide you through the upgrade 
process.
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UPGRADING THE DATABASE
As part of the 4.0 upgrade, you must run the SQL scripts generated when you upgraded 
the Master Controller to upgrade the 3.x schema.

1. Copy the upgrade.orcl.4.0.sh file and the SQL scripts located in the 
scripts subdirectory in the Report Manager installation directory to the 
computer where the database is installed.

2. On the database computer, verify that sqlplus is in your PATH.

3. Run the Oracle upgrade script to upgrade the database schema. You will need to 
specify the password of the Oracle system user. For example, if “manager” was 
the password for the Oracle system user, you would enter the following 
command:

upgrade.orcl.4.0.sh manager
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UPGRADING THE REPORT MANAGER CONSOLE
1. Ensure that you are logged on to the console computer using an account with the 

appropriate privileges.

2. Launch the Report Manager 4.0 client executable. The Report Manager 
InstallAnywhere wizard will appear to guide you through the upgrade process. 
Refer to Installing the Report Manager Console in Chapter 2 for more 
information on running the Report Manager 4.0 client installer. The installer 
will detect previous versions of the Report Manager client application installed 
on your computer and prompt you if you wish to proceed with the upgrade.

3. Click on the Install button to uninstall the previous version and upgrade to the 
newer client application version. The installer displays a screen indicating that 
the installation is complete.

4. Click Done to exit the installer.
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RECOVERING FROM A FAILED UPGRADE
If for any reason you suspect that the upgrade has failed, it is possible for you to restore 
your previous version of Report Manager, including all server and console data.

Recovering Server Data
These instructions assume that you have not changed the default installation directory 
for NetScreen-Global PRO Report Manager (e.g., /opt/NETSglPRO). If you have changed 
the installation directory, substitute the default directory name with your installation 
directory in the procedure.

1. Stop all Report Manager services (i.e., Master Controller, Data Collector, and 
Historical Reports Server).

2. For Master Controller installation only. Copy 
glpro_orcl_drop_table.sql from /opt/NETSglPRO/scripts/oracle to 
another location.

3. Enter the following commands: 

• % cd /opt/NETSglPRO

• % rm -rf *

• % tar xvf <tar file 1>

4. Restore the database (customize these commands to suit your needs):

– % cd $ORACLE_HOME/bin

– % sqlplus -s scott/tiger < glpro_orcl_drop_table.sql (copied before)

– imp scott/tiger touser=scott file=scott.dmp

5. Restart the services.

6. If the upgrade is successful, you can delete the <tar file 1> and <scott.dmp> files.

Recovering Console Data
1. Navigate to the NetScreen subdirectory where your Report Manager Console 

files are stored in Program Files (i.e., <drive>\Program Files\NetScreen\).

2. Locate the Report Manager subdirectory and delete it.

3. Restore the Report Manager subdirectory with the backup copy.

4. Start the Report Manager Console.

5. From the Help menu, select About Report Manager Console. Report 
Manager displays a popup describing the existing Report Manager Console 
version.

6. Confirm that you are running the latest 3.x version of Report Manager.

Warning: Do not save the tar files in the installation directory.
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Chapter 10

Integration
You can extend the functionality of Report Manager by integrating it with third-party 
applications including: Micromuse Netcool, HP OpenView, and TelAlert.

This chapter provides information that describes how you can install, configure and use 
Report Manager with third-party applications. Its main sections include:

• Extending Report Manager

• Micromuse Netcool

• HP OpenView

• TelAlert
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EXTENDING REPORT MANAGER
You can integrate and use Report Manager with the following third party applications:

• Micromuse Netcool

• HP OpenView

• TelAlert

Micromuse Netcool
Netcool is an event management system from Micromuse. It includes a component called 
Netcool/OMNIbus™, which allows you to consolidate and view MSP/enterprise wide events 
and status information generated across all types of devices in your enterprise.

The NetScreen-Global PRO Integration Module for Netcool (IMN) is an optional 
component of the Global PRO system that allows you to integrate events and logs 
collected by your Data Collectors with the Netcool/OMNIbus system. Refer to the 
NetScreen-Global PRO Integration Module for NetCool User’s Guide for more information 
describing how to integrate, configure and use NetCool with Report Manager.

HP OpenView
HP OpenView is a Simple Network Management Protocol (SNMP) management 
application that allows you to view SNMP Management Information Base (MIB) II data 
and receive SNMP traps or notifications from either trusted or untrusted interfaces.

HP OpenView must be installed on the same machine/system as Report Manager.

Running HP OpenView
1. Start the HP OpenView Integration application.

2. Open the NetScreen Integration Dialog Box to run the HP Lookfind Integration 
Utility. The dialog box provides a field that contains HPOpenView. A second 
field is for the directory path (“Look in”).

3. Click Find to begin the search. Refine the search by browsing to the correct 
directory. Once the HP OpenView file is found, the following dialog appears.
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4. Follow the instructions provided.

The next time you open HP OpenView, the Report Manager Icon appears in the tool bar.

Configuring SNMP
If you are integrating Report Manager with SNMP management applications like HP 
OpenView, you will need to enable and configure it on a specific Data Collector.

To enable and configure SNMP on the Data Collector:
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1. From the Report Manager Console, use the Tools menu and select the System 
Properties. The System Properties dialog appears. The SNMP tab is the first 
tab that appears.

2. Select the Enable SNMP checkbox.

3. Click in the SNMP Community 1 field and specify the hosts for your primary 
SNMP community.

4. Click in the SNMP Community 2 field and specify the hosts for a secondary (if 
applicable) SNMP community.

5. Click in the SNMP Community 3 field and specify the hosts for a third (if 
applicable) SNMP community.

6. Click in the SNMP Trap Port field and specify the port number for SNMP. The 
Data Collector will use port 162 by default.

7. Click OK to save your changes; click Cancel to cancel your changes.

Downloading MIB Definitions
After you have configured SNMP in Report Manager, you will also need to update your 
existing ns-traps.mib file with the current OS4.0.0 MIB definitions. The OS4.0.0 MIB 
definitions are available on the NetScreen corporate Support web site located at the 
following URL:

http://www.netscreen.com/support/updates.asp
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TelAlert
TelAlert from Vytek is a distributed alert management system that you can use with 
Report Manager to notify you of critical events as they occur on your NetScreen security 
system. TelAlert is capable of receiving alerts from a variety of data sources. It filters the 
alerts and then forwards them to a wide array of destinations and media interfaces 
including e-mail, paging, and modem. By integrating TelAlert with Report Manager, you 
can:

• Receive an electronic page automatically whenever an alert occurs.

• Send messages/alerts by voice, e-mail, etc.

• Forward an alert as an SNMP trap.

• Integrate with help-desk systems for problem management.

• Forward and escalate urgent alerts to the appropriate person or group 
responsible for resolving the problem. TelAlert will continue to forward alerts 
until the problem is resolved.

Refer to the documentation included with Vytek Wireless for more information on how the 
TelAlert system works as well as administrating the system using TelAdmin.

Configuring TelAlert to Work With Report Manager
The TelAlert system has both a client and server component. When implementing with 
Report Manager, the Data Collector acts as the client to the TelAlert Urgent Messaging 
System or UMS server. The TelAlert server processes incoming messages from the Data 
Collector and then forwards them to specified destinations.

To use Report Manager with TelAlert, you will need to first define where you want the 
TelAlert server to send alert information. This is configurable through the following 
attribute in the property file:

ns_destination = _ns_telalert_ 

You will then need to run a TelAlert init command to reinitialize the TelAlert server to 
allow the configuration change to take effect.

1. Open a DOS command prompt.

2. Specify the destination. For example, you would type the following command:

_ns_telalert_

3. Run the TelAlert init command to reinitialize the TelAlert server. For example, 
you would type the following command:

telalert -init

Note: Refer to the documentation included with TelAlert for more information on 
installing and configuring TelAlert.
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Configuring Report Manager to Work With TelAlert
You will also need to enable Report Manager to use TelAlert. You can do this by editing 
the TelAlert properties in the Data Collector initialization file (i.e., pro.dc.init or 
pro.dc.reinit if the Data Collector is up-and-running).

1. Open the Data Collector initialization file in any text editor.

2. Edit the following properties:

• ta.ip.pri.addr - enter the primary IP address to the UMS server. The 
default is 127.0.0.1.

• ta.ip.sec.addr - enter the secondary IP address to the UMS server. The 
default is 127.0.0.1.

• ta.client.flag - set to “true”. The default is set to false.

• ta.ip.port - set the port number that will receive messages on TelAlert 
server. The default port number is set to 25378.

3. Save and close the file.



Extending Report Manager

NetScreen-Global PRO 281

4. Stop and then restart the Data Collector for the configuration changes to take 
effect.

When the Data Collector starts, it will begin to send alerts to the recently created 
_ns_telalert_ destination.

Verifying That TelAlert Is Working Properly
To verify that the Data Collector is sending its messages, check the Data Collector log for 
“sendTelAlertMessage” logs.

To verify that the TelAlert server is receiving messages properly, open the 
TelAlert.trail file to see if it has received alerts from the Data Collector. In addition, 
if you have setup “group memberships” or “filters” for _ns_telalert_, TelAlert will 
begin to send alerts to your specified administrators via e-mail or pager.

Note: Logs will only appear if you have enabled “DEBUG” on the Data Collector.
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Chapter 11

Concepts and Examples
This chapter provides additional information describing key Report Manager concepts. 
This includes an overview of the underlying processes enabling Report Manager to 
monitor device status and collect data. It also includes a more detailed description of how 
Report Manager facilitates managing security-related events that occur on your 
NetScreen devices. This chapter also provides use cases and examples to help illustrate 
how these concepts apply in the day-to-day use of Report Manager.

Finally, this chapter provides information describing how to implement some of Report 
Manager’s more advanced features. This includes step-by-step procedures describing how 
to configure Report Manager for failover protection, and how to perform database cleanup 
operations.

It includes the following sections:

• Understanding Device Status

• Understanding How the Data Collector Collects Data

• Understanding How Device Information is Stored

• Understanding How Report Manager Components Communicate

• Understanding Event Status

• Implementing Failover Protection

• Maintaining the Database
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UNDERSTANDING DEVICE STATUS
One of Report Manager’s primary features is real-time monitoring of the up/down status 
of each NetScreen device. By using Report Manager, system and network administrators 
can verify the status of their devices at-a-glance, and receive immediate notification if and 
when their devices become disconnected. This allows administrators to respond to issues 
as they occur on the device in a timely manner.

As you continue to work with Report Manager, and use it to monitor your network 
security infrastructure, it will help to understand the underlying processes that enable 
Report Manager to establish communications with each NetScreen device, exchange 
information, and determine its up/down status.

Device Authentication and Connection
At installation, we described how you must enable Global PRO on the device and then add 
your devices and Data Collectors in the Report Manager system. Refer to Configuring 
Report Manager For the First Time in Chapter 2 for more information.

Once started, a Data Collector will receive connect requests from each device and attempt 
to authenticate it. Authentication between the Data Collector and device occurs in two-
phases.

Phase 1 Authentication
Initially, a NetScreen device will send a request called a “getInitConnection” to the Data 
Collector. This getInitConnection request will include information that identifies the 
device (i.e., Serial Number, IP address, Master Controller address, connection type, 
encryption type) to the Data Collector.

The Data Collector receives the getInitConnection request and checks to see if that 
particular device is assigned to it. The Data Collector will check configuration data that it 
received from the Master Controller when it first started. If the configuration data shows 
that the device is assigned to the Data Collector, the Data Collector will then accept the 
getInitConnection request. The Data Collector checks for any pre-existing connections 
(i.e., connection already exists). If no pre-existing connections exist, the Data Collector 
sends an initconnection accept message to the device.

If the device is not assigned to the Data Collector, the Data Collector will first send a 
setsNspShutdown message to close the connection; then logs the event in its log file. The 
error message will indicate that an unknown device (including the device’s SN#) is trying 
to connect.
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Phase 2 Authentication
If the Phase 1 authentication succeeds, the Data Collector must next authenticate itself 
with the device. Upon receiving the initconnection accept message, the device in turn, 
sends a setHandshakeComplete message to the Data Collector in an attempt to 
authenticate it. The Data Collector authenticates with the device by sending a 
getAuthenticate message including the device’s login id and password. The device 
acknowledges the getAuthenticate message by sending a setAuthenticate() [1- success, 0 -
failure] message to the Data Collector.

Once these messages are completed, a connection is established.

How the Data Collector and Device Maintain a 
Connection
The device and Data Collector will send messages called “keepalive” messages to each 
other every 30 seconds. Keep alives maintain the connection status as “up” even if no data 
is sent.

When Devices Become Disconnected
If a keep-alive message is not received, the Data Collector will retry 4 times (2 minutes) 
before giving up on the connection. If this occurs, the device will appear as disconnected.

Note that if a keep-alive message is not received and the device appears as disconnected, 
this does not necessarily mean that the device is down. A device disconnection event can 
also indicate a network or other issue preventing the keep-alive message from being 
received.

Note: This is done to prevent a “man in the middle” type attack (i.e., if someone fakes the 
messages sent from a Data Collector, it cannot access the device without authentication 
information).

Note: For this reason, it may take at a minimum 2 minutes from the actual time that the 
device becomes disconnected, before the device is indicated as “down” in the Monitor 
Console.
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Client/Device Server/Data Collector

Sends a getInitConnection 
request to Data Collector.

If device is configured in 
Report Manager for that Data 
Collector, the connect request 
is allowed.

Sends setHandshakeComplete 
message to Data Collector.

Sends getAuthenticate request 
with device login ID and password.

Sends setAuthenticate 
message (1=success, 0=fail)

3

4

5

2

1

Keepalive messages are sent 
every 30 seconds to verify 
connection.

6
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Device Is Connected
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Use Case: Report Manager Indicates That the Device 
is Disconnected

Connections to a device are dropped when for example, the device is shutdown or is 
rebooted or if the network connection goes down. In the event that you receive an 
indication that the device has disconnected, you should check the event log for a device 
disconnection event message.

If the event log indicates that the device has disconnected, it still may be possible that the 
device is up and running. This can occur if for example something in the middle (i.e., a 
router or switch) went down. The event message simply indicates that the device can no 
longer communicate with the Data Collector.

In the event that you receive an indicator that the device has gone done, it is 
recommended that you monitor the events that led to the device going down. Check for 
any suspicious activities. Check if the device reconnects the next time (i.e., new 
information will include last reboot time, and will indicate if the device rebooted itself 
rather than if a network failure occurred).

Network outages will likely affect the status of many devices. Intermittent outages will 
indicate device outages. Although rare, devices going down will typically come back up in 
4-5 minutes.
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UNDERSTANDING HOW THE DATA COLLECTOR COLLECTS 
DATA

Once a connection is established between the device and Data Collector, the Data 
Collector will poll each device periodically to obtain device statistics, such as protocol 
distribution and policy statistics. The Data Collector polls its devices every 300 seconds or 
5 minutes by default. If you do not need the polled data that frequently, you can lengthen 
the time the Data Collector will poll its devices by configuring the Device Poll parameters.

Client/Device Server/Data Collector

Data Collector polls the 
device every 5 mins for 
data.

The device returns polled data 
including device statistics, 
protocol distribution and policy 
statistics

2

1

You can configure the intervals with which the 
Data Collector polls its devices for certain data 

from the Data Collector profile.
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The Data Collector will also receive information that is pushed to it from each device 
whenever such information becomes available.

Viewing Device Information
Users can access real-time device data from the Monitor Console. The Monitor Console 
communicates with a Data Collector to access real-time performance statistics, log, and 
fault data. Refer to Chapter 5 for more information.

Users can also generate and create reports based on historical data from the Historical 
Reports Console. The Historical Reports Console is a web-based interface that allows you 
to access Report Manager data that is stored on the main database. You can use a web 
browser (Netscape Navigator 6.0 or higher or Internet Explorer 6.0 or higher) to access 
the Historical Reports Console. Refer to Chapter 6 for more information.

Client/Device Server/Data Collector

The Data Collector also 
receives data that is pushed 
from the device. This 
includes traffic logs, 
attacks, configuration 
logs, information logs and 
self logs.

1
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UNDERSTANDING HOW DEVICE INFORMATION IS STORED
The Data Collector summarizes the data, and then sends the information to the Master 
Controller. The Data Collector sends device statistics to the Master Controller every 3600 
seconds (or 60 minutes), VPN and NSRP statistics every 7200 seconds (or 120 minutes). If 
you want to change the time interval that the Data Collector sends its data to the Master 
Controller, you can do so from the Data Collector profile. Refer to Save Statistics to 
Database Intervals in Chapter 4 for more information

The Master Controller in turn, forwards the information to the database where it is stored 
for future retrieval.

DC MC/DB HRS

Report Manager Server

NetScreen Devices
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UNDERSTANDING HOW REPORT MANAGER COMPONENTS 
COMMUNICATE

All of the following ports and protocols are used in a Report Manager implementation. All 
ports except FDF server are fixed.

Note that the Data Collector acts as a server for both devices and the Monitor Console. It 
listens on port 15400 for devices, and on port 15404 for the Monitor Console. The Data 
Collector also acts as a client to the Master Controller on port 15402. If you are 
implementing third party applications such as NetCool, the Data Collector acts as a 
Foreign Data Feed (or FDF) client on port 9999.

The Master Controller and Historical Reports Server communicate with the database 
using a JDBC session on port 1521.

For standard web access to the Historical Reports Server, the Historical Reports client 
uses port 8080. For secure access, the Historical Reports client uses port 8443.

Connection Description Protocol Port

NetScreen Device to Data Collector Device session with Data Collector TCP 15400

Data Collector to Master Controller Data Collector to Master Controller 
session

TCP 15402

Monitor Console to Master Controller Console to Master Controller 
session

TCP 15403

Monitor Console to Data Collector Console to Data Collector session TCP 15404

Monitor Console to NetScreen Device SSH/Telnet session for “get” 
commands

TCP 22/23

Master Controller to Database (Oracle) JDBC session for database writes TCP 1521

Master Controller to Database (MS-SQL) JDBC session for database writes TCP 1433

Master Controller to Database (PG-SQL) JDBC session for database writes TCP 5432

Historical Reports Server to Database 
(Oracle)

JDBC session for historical data TCP 1521

Data Collector to NetCool FDF Server TCP connection for NetCool-Global 
PRO integration

TCP 9999

Historical Reports client to Historical 
Reports Server

HTTP access to historical reports TCP 80/8080

Historical Reports client to Historical 
Reports Server

HTTPS access to historical reports TCP 443/8443
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The following diagram illustrates communication between Report Manager components.

NetScreen Devices

DC MC/DB HRS

Console HRS Console

Report Manager Server

Report Manager User Interface

NSP/IP Sec

NSP/IP Sec

NSP/IP Sec

HTTP/HTTPS

TCP:15400

TCP:15404 TCP:15403

TCP:15402
TCP:1521 (JDBC)

TCP:80/8080
TCP:443/8443

TCP:23 (Telnet)
TCP:22 (SCS)

TCP:1521 (JDBC)
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UNDERSTANDING EVENT STATUS
There are numerous events that can occur on a device. In Report Manager, there are six 
major event types:

• Attack Alarms

• Configuration Logs

• Traffic Alarms

• Miscellaneous Alarms

• Information Logs

• Traffic Logs

Attack Alarms
The following table lists all the events related to Attack Alarms.

Event

SYN Attack

ICMP Flood Attack

UDP Flood Attack

Tear Drop Attack

Ping of Death Attack

Multiple Authentication Failed

Winnuke Attack

IP Spoof Attack

IP Route Attack

Land Attack

Port Scan Attack

Address Sweep Attack

Policy Denied

Unregistered Source IP trying to connect to Global Manager port

Unregistered Source IP trying to connect to Global PRO port

Microsoft IIS server vulnerability

Session Threshold Exceeded

Block IP fragment traffic

VPN Replay Detected

IDS Component

IDS ICMP Flood
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IDS UDP Flood

IDS Win Nuke

IDS Port Scan

IDS Address Sweep

IDS Tear Drop

IDS SYN Attack

IDS IP Spoofing

IDS Ping of Death

IDS Source Route

IDS Land

IDS SYN Fragment

IDS No Flag

IDS unknown port

IDS Bad Options

IDS Option record route

IDS Option timestamp

IDS Option Security

IDS Option LSRR

IDS Option SSRR

IDS Option Stream ID

IDS ICMP Echo reply

IDS ICMP Host Unreachable

IDS ICMP Source quench

IDS ICMP Redirect

IDS ICMP Echo request

IDS ICMP Time exceeded

IDS ICMP Parameter problem

IDS ICMP Timestamp request

IDS ICMP Timestamp reply

IDS ICMP Info request

IDS ICMP Info reply

IDS ICMP Address mask request

IDS ICMP Address mask reply

IDS ICMP Fragment
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Configuration Logs
The following table lists all the events related to Configuration Logs.

IDS ICMP too large

IDS ICMP SYN FIN

Event

Global PRO configuration

Miscellaneous configuration

Console configuration

DNS configuration

Firewall configuration

Hostname configuration

NSRP configuration

Clock configuration

Interface configuration

MIP configuration

Route configuration

Service configuration

URL configuration

Authentication configuration

VIP configuration

VPN configuration

Policy configuration

Syslog configuration

Schedule configuration

DIP configuration

Global Manager configuration

Erased configuration

DHCP Opt configuration

DHCP IP configuration

SSH configuration

DHCP configuration

Traffic shaping configuration

DNS report configuration
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Traffic Alarms
Traffic alarms are generated based on preset thresholds.

Miscellaneous Alarms
The following table lists all the events related to Miscellaneous Alarms.

PKI configuration

SNMP configuration

Address configuration

Administrator configuration

Virtual system configuration

PPPoE configuration

SSL configuration

Softkeys configuration

Zone configuration

OSPF configuration

BGP configuration

IDS configuration

Session configuration

Route map configuration

PPP configuration

IP classification configuration

Event

Miscellaneous Alarm

Unspecified Hardware Failure (Fan/Power Supply)

URL Blocking server connection

DNS Host is unreachable

Device log overflow

VPN/IKE related Alarm

HSA Status Alarm

Load Balance Server Down

Administrator related alarm

Netscreen Device is Dead
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Self Logs
Self logs contain NetScreen device-specific logs.

Device Memory Low

Device CPU Usage High

X.509 certificate related Alarm

DHCP

IP Conflict

VPN Up

VPN Down

NSRP RTO self unit status Up

NSRP RTO self unit status Down

NSRP RTO track IP succeeded

NSRP RTO track IP failed

NSRP Inconsistent configuration

NSRP VSD group changed to elect

NSRP VSD group changed to master

NSRP VSD group changed to primary backup

NSRP VSD group changed to backup

NSRP VSD group changed to ineligible

NSRP VSD group changed to inoperable

NSRP VSD request heartbeat from 2nd HA path

NSRP VSD reply to 2nd path request

NSRP duplicated RTO group found

NSRP duplicate VSD group master

Maximum routing entry exceeded for the system

Maximum routing entry for Virtual router exceeded

SCS failure

Session utilization approaches the system capacity

OSPF Hello packet threshold succeeded

OSPF LSA packet threshold succeeded
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Information Logs
The following table lists all the events related to Information Logs.

Event

Link status information

Miscellaneous information

Load balance server status information

User login/logout information

Password change information

Username change information

User authentication failure information

User authentication success information

System status information

NSRP status information

URL blocking information

SNMP information

User authentication status change information

Net user status information

DHCP server information

SSH information

DNS information

DHCP information

Clock information

Ping information

Load balance server up information

Cleared log information

PKI information

VPN/IKE information

Generic information

Device connected information

Device disconnected information

Device missing heartbeat information

PPPoE information

PPP information

SSL information
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Traffic Logs
The following table lists all the events related to Traffic Logs.

Event Lifecycle
Information about an event is sent to Data Collector as it occurs on the device. User 
receives e-mail alert, page, or any other 3rd party application (NetCool or TelAlert).

Use Case: Managing Events
Each organization has their own process for dealing with critical network events. When 
an event occurs, security administrators responsible for tracking and resolving network 
events may monitor the situation using Report Manager.They can also use third party 
applications to create trouble ticket, and depending upon the severity of the event, assign 
the ticket to a staff resource to further diagnose and resolve.

In Report Manager, the Data Collector will forward all event information to the Master 
Controller where it is later stored on the database. If you are interested in tracking 
specific event types, you can use the Historical Reports Console to customize and generate 
a report to further analyze events over time.

Global PRO information

OPSF information

Event

Traffic Logs

Traffic Logs (Extended)
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IMPLEMENTING FAILOVER PROTECTION
Another key benefit of using Report Manager is its ability to provide fault management 
across multiple devices. The Report Manager architecture allows you to configure Data 
Collectors for failover protection by installing a separate Data Collector on a separate 
computer to manage the same set of devices. You can designate one Data Collector as the 
primary Data Collector and another as the secondary Data Collector for each device. If the 
primary Data Collector fails after two unsuccessful attempts, the device will switch its 
functions over to the secondary Data Collector.

Configuring Data Collector Failover Protection
1. Install a Data Collector on a separate stand-alone computer. Refer to Installing 

the Data Collector in Chapter 2 for more information.

2. Add the Data Collector in the Report Manager system. Refer to Adding Data 
Collectors in Chapter 2 for more information. Note how the Data Collector is 
listed as a Secondary DC in the Data Collector List pane.
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3. Configure your device to use the Data Collector that you just installed on a 
separate computer as the secondary Data Collector. You can do this from the 
Information tab in the Device configuration screen.

4. Click on the Save button to save your device configuration changes.

If the primary Data Collector fails after two unsuccessful attempts, the device will switch 
its functions over to the secondary Data Collector. In the background, the device will keep 
trying to communicate with its primary Data Collector. If the primary Data Collector 
becomes available, the device will switch back over.

Saving Device State Information
Each Data Collector saves information indicating the current state of each device. In the 
event that the device becomes disconnected, this information is forwarded to the 
secondary Data Collector (if one is configured) to take over where the primary Data 
Collector has left off.

Device state information is stored with traffic log files on the Data Collector computer in a 
directory called devlog (i.e., /opt/NETSglPRO/devlog/) by default. If you wish to 
change the directory path, you can edit the path that is specified in the Path to save 
Logs field.

The Data Collector will update the device state information every 3600 seconds (or 60 
minutes) by default. If you wish to change this behavior, you can reconfigure the interval 
by entering a time in seconds in the field provided.
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Note that the device log is only used for failover protection. If you are not configuring your 
Data Collectors to provide failover protection, it is highly recommended that you increase 
the time interval to Save Device data to disk.

Refer to Increasing Device Polling Intervals in Chapter 7 for more information on tuning 
the Data Collector.

If you are not implementing your Data Collectors to provide 
failover protection, setting the Save Device Data to disk every x 
seconds to a larger time interval will optimize your Data Collector 
performance.
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Configuring Master Controller Failover Protection
You can also configure Master Controllers for failover protection.

1. Install a Master Controller on a separate stand-alone computer. Refer to 
Installing the Master Controller in Chapter 2 for more information.

2. Configure your Data Collector to use the Master Controller that you just 
installed on a separate computer as the secondary Master Controller.

3. Click OK to exit the Data Collector Properties window; click Cancel to cancel 
your changes.

4. Click on the Save button to save your device configuration changes.

If the primary Master Controller fails after two unsuccessful attempts, the Data Collector 
will switch its functions over to the secondary Master Controller.
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Message Archiving
Report Manager allows you to archive event messages that may not have been forwarded 
due to a communications failure (or otherwise) in a temporary cache. During failover 
scenarios, Report Manager will flush or send messages in its temporary cache from a Data 
Collector to the Master Controller or from the Master Controller to the database when it 
becomes available. This prevents any events from being lost during periods when the 
Data Collector and Master Controller or the Master Controller and database become 
disconnected.

Configuring Event Archiving
1. From the Report Manager Console, use the Tools menu and select System 

Properties. The System Properties window appears.

2. Click on the Failover Settings tab.

3. Click in the Enable Archiving checkbox to enable message archiving.

Note: Message archiving when the device and Data Collector become disconnected is not 
available in this release.
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4. Click in the Archived Events Limit field and enter the number of events you 
want to archive. Report Manager archives 10,000 events by default.

5. Click OK to save your changes; click Cancel to cancel your changes.

Note: If you are not interested in failover protection, you can effectively disable 
message archiving by setting the Archived Events Limit to zero.
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MAINTAINING THE DATABASE
Report Manager allows you to maintain the size of your database by configuring a Master 
Controller to purge records automatically when the number of records per table reaches a 
certain specified limit. You can also configure the Master Controller to archive the data 
that is purged.

Performance Considerations
The Report Manager database maintenance features perform best when applied to a 
small to medium-sized database. If your database requires daily maintenance of more 
than a million records per day, using the database cleanup features is not recommended.

For example, if you are using a standard Oracle database server (on a Dell Poweredge 
4600 with 8 disks), and a Ultra 10 as the computer where you are running the Master 
Controller, you can expect a routine archiving operation of 950k records to take 
approximately 35 minutes; you can also expect a purging operation of 950k records to take 
approximately 10 minutes. Note that the total time required to purge data is not linearly 
proportional to the number of database records (e.g. archiving of 15M records takes > 12 
hrs).

During archiving, you can also expect CPU usage on the Master Controller computer to 
reach over 90%. If the response time on the Master Controller computer during the 
archiving period is not acceptable, it is recommended that you dedicate a Master 
Controller on a separate stand-alone computer to perform the database cleanup operation.

Database Cleanup Alternatives
If you have never performed a database cleanup operation on your database, it is likely 
that you will have accumulated a large amount of data on the database. If this is the case, 
you should follow these recommendations:

• Run the purge database scripts to cut down the tables to a more manageable 
size.

• Set the Number of records per table after clean-up to a number larger than the 
number of records in the database tables.

Note: You will need administrative privileges to “Administer Database” to perform 
database cleanup operations.
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Configuring a Master Controller to Clean-up the 
Database

1. From the Report Manager Console, use the Tools menu and select DB 
Management. The DB Management window appears.

2. Enter the IP address of the Master Controller that you wish to perform the 
database clean-up operation.

3. Use the Clean-up database every pull-down menus to select the interval 
number of days and time that you want the Master Controller to purge the 
database. The database purging interval is set to 1 day by default. For example, 
if you set the database purging interval to 2 days, the Master Controller will 
purge the database every other day.

The database purging time is set to 1 by default. Note that you will need to enter 
the time in military format (i.e., 1 would be 0100 hours or 1:00AM, 13 would be 
1300 hours or 1:00PM). It is recommended that you configure the Master 
Controller to perform the purging operation after working hours (for example, 20 
or 2000 hours or 8:00PM).
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4. Click in the Number of records per table after clean-up field and enter the 
number of records per table that you want after the purging operation. The 
number of records per table after purging is set to 1,000,000 by default. For 
example, if you did not want the database to exceed 500,000 records per table, 
you would set the number of records per table after purging to 500000. When the 
number of records per table exceeded this limit, the Master Controller will 
perform the purging operation.

5. Click OK to save your changes; click Cancel to cancel your changes.

Archiving Data Before Cleanup Operations
1. Follow the same steps that you used to get to the DB Management window.

2. Click in the Archive records before clean-up checkbox.

3. Click in the Directory on Master Controller to archive records field and 
enter the path to the directory where you want to archive those records that are 
being removed from the database.

4. Click OK to save your changes; click Cancel to cancel your changes.

Note: Use the Event Distribution Overview Report from the Historical Reports 
Console to view the current number of records per table in your database.

Warning: Be extremely careful when setting the number of records per table after 
purging. If you set this value to zero, you will instruct the Master Controller to 
purge all records from your database.

Note: You cannot cancel a purging operation once it has begun.

Note: To ensure that you do not lose any new data inserted after archiving, the 
Master Controller will not purge any data from the current date, even if the 
current date's data is over the limit configured. 
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Viewing the Status of the Last Database Cleanup 
Operation

To check the status of the last database cleanup operation, check the bottom pane of the 
System Health view. The data and time of the last operation will appear with the number 
of records removed. The same information appears on the DB Management screen.
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PURGING THE DATABASE
In the unlikely event that you need to restart the initialization of the database schema 
(for example, the Master Controller is unable to connect to the database during 
installation), you can run the following scripts to purge and reinitialize the database.

For Oracle:

glpro_orcl_drop_table.sql

For MS-SQL

glpro_mssql_drop_table.sql

For PostgreSQL:

glpro_pg_drop_table.sql
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A
Appendix A

Database Schema
This appendix provides reference information that describes the underlying database 
table structures, field names, and data types for Report Manager. Each table is listed 
according to the functionality they provide.

Its main sections include:

• Database Tables Supporting Role-Based Administration

• Database Tables Related to Customer

• Logs, Alarms, Table Counters

• Scheduled Data Collector Tasks

• Scheduled HRS Tasks

• Versioning

• Device / Virtual system / Sub-Interface

• Failover

• Device and Server Heartbeats

• Static Information

• Database Tables Related To Clusters

• Database Tables Related to VPN
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UNDERSTANDING THE DATABASE SCHEMA
Report Manager uses a relational database for the central storage of device fault data and 
performance-summary data. This relational database also stores control information to 
support normal Report Manager operations.

Database Tables Supporting Role-Based 
Administration

Report Manager provides role-based administration functionality. The tables in the 
database that support this functionality include:

• person

• groups

• privilege_type

• mtm_groups_person

• mtm_privilege_groups_sme

• mtm_privilege_groups_customer

• mtm_customer_device

• mtm_privilege_groups_report

Each Report Manager user has a set of associated groups. Each group grants the user a 
set of permissions and privileges when accessing a particular device. For example, “user 
A” might have the privilege to perform configuration changes in a particular NetScreen-
1000 virtual-system x and y, and also the privilege to read all the configuration and 
performance logs from the same device. The tables person, groups, and 
mtm_groups_person support the associations of various groups to a particular user. A 
user can belong to many groups, and various users can share the same group. 

The table privilege_type defines various combinations of read and write privileges to 
perform configurations and access logs.

The table mtm_privilege_groups_customer stores the privilege information for each 
group in the device management. It specifically defines which group has which privileges 
for which device. Together with the table mtm_groups_person, it supports the definition 
of multiple privileges for any person at all devices belonging to a device group. Even 
though the same flexibility is not currently supported in the devices, as long as any access 
is performed via Report Manager, Report Manager can still enforce role-based-
administration.

The table mtm_privilege_groups_report stores the privilege information for each 
group in accessing reports via the HRS. It specifically defines the group privilege for 
accessing a report.

Note: In the database schema, the prefix “mtm_” is used for storing many-to-many 
relations. Also, foreign keys are defined using names of the form 
“link2<table_name>”. For example, “link2person”, “link2groups.”
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The table mtm_customer_device stores the associations of device groups and devices, 
that is, which devices belong to which customer.

The table mtm_privilege_groups_sme (similar to mtm_privilege_groups_device) 
stores the privilege information for each group in Report Manager management.

Example
As an example, suppose we want to describe the following administrator privileges:

Device group1 (C1) owns device1 (D1)’s virtual-systems (V1 & V2) and we want to give the 
administrators (A1 & A2) the privileges configurations for this device group the tables 
would have the following data:

Table person would contain a record for A1 and another record for A2
Table groups would have a record, G1
Table mtm_groups_person would have two records:

Record 1: link2groups = G1, link2person = A1
Record 2: link2groups = G1, link2person = A2

Table customer would have a record for C1
Table privilege_type would have a record P1, such that read_dev = yes, 

write_dev = yes
Table device would have a record D1
Table device_vsys would have two records, V1 & V2, such that the field 

link2device point to D1
Table mtm_customer_device would have 2 records:

Record 1: link2customer=C1, link2device= D1, link2device_vsys = V1
Record 2: link2customer=C1, link2device= D1, link2device_vsys = V2

Table mtm_privilege_groups_customer would have 1 record:
Record 1: link2customer=C1, link2groups = G1,
link2privilege_type = P1 

Table person
This table contains the information of a SME user/person.

Note: In the field group_name in table groups, any records having values that begin with 
“_ns” are for Report Manager’s internal use only. They do not correspond to real user-defined 
groups. This applies similarly for the company_name field in the table device group.

Field Name Data Type Description

objid NUMERIC (18,0)

login_name VARCHAR2 (20) Login name to SME.

passwd VARCHAR2 (20) SME password.

link2contact_info NUMERIC (18,0) Link2 to the contact information of this SME user.
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Table person_device
This table is used as a temporary cache to store a user's associated device groups and 
devices. Only used by the Report Server.

Table groups
This table contains the list of groups.

Table privilege_type
This table contains privilege type information.

Field Name Data Type Description

objid NUMERIC (18,0)

login_name VARCHAR2(20) Person.login_name.

link2device NUMERIC(18, 0) Device.objid.

link2device_vsys NUMERIC(18, 0) Device_vsys.objid.

vsys_name VARCHAR2(50) Device_vsys.vsys_name.

host_name VARCHAR2(70) Device host_name.

sn VARCHAR2(16) Device serial Number.

ip_addr VARCHAR2(15) Device IP Address.

company_name VARCHAR2(50) Device group.company_name.

cluster_id NUMERIC(10,0) Cluster_group.cluster_id.

Field Name Data Type Description

objid NUMERIC (18,0)

group_name VARCHAR2 (20) Name of group.

comments VARCHAR2 (256) Description of this group’s functionality.

Field Name Data Type Description

objid NUMERIC (18,0)

description VARCHAR2 (50) Description of this privilege combination.

read_dev Yes/No If yes, allows read access to device log/alarm/counters.

write_dev Yes/No If yes, allows write access to device configuration.

operator Yes/No If yes, allows SME operator access.

add_user_group Yes/No If yes, allows SME add user/group.
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Table mtm_customer_device
Contains the device and device_vsys that belongs to a device group.

Table mtm_groups_person
This table contains the group/person relationship.

Table mtm_privilege_groups_customer
This table contains the privilege information for managing SME device groups.

assoc_group_priv Yes/No If yes, allows SME to update to the 
mtm_privilege_groups_device, 
mtm_groups_person_customer, mtm_privilege_groups_sme 
tables.

config_glbpro Yes/No If yes, allows SME to: add Data Collector, add dev, assoc 
dev -> DC, modifying all SME global properties, plus all 
other misc. privileges.

Field Name Data Type Description

objid NUMERIC (18,0)

link2customer NUMERIC (18,0) Link to the device group that the given device, device_vsys are 
serving.

link2device NUMERIC (18,0) Link to the device table.

link2device_vsys NUMERIC (18,0) Link to the device_vsys table.

Field Name Data Type Description

objid NUMERIC (18,0)

link2groups NUMERIC (18,0) Protocol to the groups table.

link2person NUMERIC (18,0) Protocol to person table.

Field Name Data Type Description

objid NUMERIC (18,0)

link2groups NUMERIC (18,0) The group of people having this permission.

link2privilege_type NUMERIC (18,0) Link to the privilege type.

link2customer NUMERIC (18,0) Link to the customer table.

Field Name Data Type Description
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Table mtm_privilege_groups_report
This table contains privilege information for reports.

Table mtm_privilege_groups_sme
This table contains privilege information for managing SME.

Field Name Data Type Description

objid NUMERIC (18,0)

link2groups NUMERIC (18,0) The group of people having this permission.

link2privilege_type NUMERIC (18,0) Link to the privilege type.

link2report NUMERIC (18,0) Link to the report table.

Field Name Data Type Description

objid NUMERIC (18,0)

link2groups NUMERIC (18,0) Group of people having this permission.

link2privilege_type NUMERIC (18,0) Link to the privilege type.
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Database Tables Related to Customer
In order to let the service providers associate devices/device-virtual-systems with 
customers, we have included a table called customer in the schema. The relationships of 
customers, device, and device_vsys are specified in table mtm_customer_device.

Related tables include:

• customer

• addr

• contact_info

• person

• device_vsys

• device

• mtm_customer_device

Most of the customer detail info is stored in other systems of the service providers, namely 
the help-desk, service-level-agreements and billing systems. The Report Manager 
customer table is mainly intended for integrating with the above systems.

Note that in the field customer.company_name, any records having values that begin with 
"_ns" are for internal use only. They do not correspond to real customers.

Table customer
This table contains device group information.

Table addr
This table contains physical (mailing) address information.

Field Name Data Type Description

objid NUMERIC (18,0)

company_name VARCHAR2 (50) Device group's company name.

link2contact_info NUMERIC (18,0) Link2 to the contact information of this device group.

Field Name Data Type Description

objid NUMERIC (18,0)

st_addr VARCHAR2 (64) Street address

st_addr2 VARCHAR2 (64) Second line of street address

city VARCHAR2 (32) City

state VARCHAR2 (2) State

zipcode VARCHAR2 (12) Zip code
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Table contact_info
This table contains the general contact information.

Field Name Data Type Description

objid NUMERIC (18,0)

first_name VARCHAR2 (20) First name

last_name VARCHAR2 (20) Last name

phone1 VARCHAR2 (20) Phone number 1

phone2 VARCHAR2 (20) Phone number 2

email_addr1 VARCHAR2 (50) E-mail address 1

email_addr2 VARCHAR2 (50) E-mail address 2

link2addr NUMERIC (18,0) Link to address table
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Logs, Alarms, Table Counters
Tables in the database related to logs, alarms and table counters include:

• alarm_attack

• alarm_generic

• alarm_traffic

• log_config

• log_info

• log_self

• log_traffic

• tbl_policy

• tbl_protocol

• tbl_interface

• tbl_interface_attk

• tbl_interface_vrtl

• device_stat

• cluster_group_stat

• packet_fwd_counters

• rto_counters

• vpn_counters

• vsd_counters

• device_overview

• event_overview

The following is a mapping of the various logs to the corresponding database tables:

Reference Type

Configuration Log Data log_config

Information Log Data log_info

Self log Log Data log_self

Traffic Log Data log_traffic

Protocol Distribution Table tbl_protocol

Policy Statistics Table tbl_policy

Interface Statistics Table tbl_interface

Interface Attack Statistics Table tbl_interface_attk

Virtual Interface Statistics Table tbl_interface_vrtl

Protocol Names Table device_protocol

Device uptime/CPU/mem/session Statistics device_stat

Cluster related counters cluster_group_stat, packet_fwd_counters, 
rto_counters, vsd_counters
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The log tables have links back to the objid’s in the table device_vsys. The corresponding 
device record can be traced back to the table device via table device_vsys. Since Report 
Manager keeps track of previous definitions of virtual-systems (in device_vsys) and sub-
interfaces (in device_interface), the links in the log/tbl entries are valid even if the virtual 
systems or subinterfaces are subsequently redefined in the devices.

Report Manager provides utilities for cleaning up old log files in the Data Collector and 
the performance/fault records in the database. These utilities can be triggered by 
scheduled tasks initiated by the master controller.

Table alarm_attack
This table contains the log information for attack alarms.

VPN statistics vpn_counters

Traffic alarm alarm_traffic

Firewall attack alarm alarm_attack

Misc alarm alarm_misc

Field Name Data Type Description

objid NUMERIC (18,0)

time_stamp DATE First occurrence of the alarm.

alarm_type NUMERIC (10,0) Event type (link to event_static_info.type).

link2device_vsys NUMERIC (18,0) Link to table device_vsys.

counter NUMERIC (10,0) Current counter value that generates the alarm.

threshold NUMERIC (10,0) Current threshold value.

src_ip_addr VARCHAR2 (15) Source IP address.

dest_ip_addr VARCHAR2 (15) Destination IP address.

src_port NUMERIC (10,0) Source port.

dest_port NUMERIC (10,0) Destination port.

link2device_interface NUMERIC (18,0) Protocol to table device_interface.

protocol_id NUMERIC (10,0) Protocol ID: 1=ICMP, 2=TCP, 3=UDP, 4=GRE, 5=ESP, 6=AH, 
7=OSPF.

repeat_cnt NUMERIC (10,0) Repeat count.

last_occurance DATE Last occurrence of the alarm.

Reference Type
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Table alarm_attack_static_info (obsolete)
This table contains the static description and classifications of alarm_type in the table 
alarm_attack.

Table alarm_misc
This table contains log information for generic alarms.

Table alarm_misc_static_info (obsolete)
This table contains the static description and classifications of alarm_type in the table 
alarm_misc.

Field Name Data Type Description

objid NUMERIC (18,0)

alarm_type NUMERIC (10,0) Alarm type (predefined alarm type) same as the varIdx in NSP.

description VARCHAR2 (100) Description/explanation of this alarm type.

severity_level NUMERIC (10,0) 0 - Clear, 1 - Indeterminate, 2 - Warning, 3 - Minor, 4 - Major, 5 - 
Critical.

Field Name Data Type Description

objid NUMERIC (18,0)

time_stamp DATE First occurrence of the alarm.

alarm_type NUMERIC (10,0) Event type (link to event_static_info.type).

link2device_vsys NUMERIC (18,0) Link to table device_vsys.

msg VARCHAR2 (150) Alarm msg string   (note this is a varchar).

repeat_cnt NUMERIC (10,0) Repeat count.

last_occurance DATE Last occurrence of the alarm.

is_cluster NUMERIC(1,0) 0 = not cluster event, 1 = is cluster event.

Field Name Data Type Description

objid NUMERIC (18,0)

alarm_type NUMERIC (10,0) Alarm type (predefined alarm type, as in the firmware), same as 
the varIdx in NSP.

description VARCHAR2 (100) Description/explanation of this alarm type.

severity_level NUMERIC (10,0) 0-Clear, 1 - indeterminate, 2 - Warning, 3 - Minor, 4 - Major, 5 - 
Critical.
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Table alarm_traffic
This table contains log information for traffic alarms.

Table log_config
This table contains the configuration change log for all devices.

Table log_generic
This table contains generic events that are not device-specific.

Field Name Data Type Description

objid NUMERIC (18,0)

time_stamp DATE First occurrence of the alarm.

alarm_type NUMERIC (10,0) Event type (link to event_static_info.type).

link2device_vsys NUMERIC (18,0) Link to table device_vsys.

rate NUMERIC (10,0) Rate, in bytes.

threshold NUMERIC (10,0) Current threshold value.

threshold_type NUMERIC (10,0) 0 = secs, 1 = mins.

policy_id NUMERIC (10,0) Policy ID relative to device.

repeat_cnt NUMERIC (10,0) Repeat count.

last_occurrence DATE Last occurrence of the alarm.

Field Name Data Type Description

objid NUMERIC (18,0)

time_stamp DATE First occurrence of the configuration change.

link2device_vsys NUMERIC (18,0) Link to table device_vsys.

type NUMERIC (10,0) Event type (link to event_static_info.type).

msg VARCHAR2 (150) Msg string describing the change.

device_admin VARCHAR2 (50) Name Of Device_admin making this change.

repeat_cnt NUMERIC (10,0) Repeat count.

last_occurance DATE Last occurrence of the log.

is_cluster NUMERIC(1,0) 0 = not cluster event, 1 = is cluster event.

Field Name Data Type Description

objid NUMERIC (18,0)

time_stamp DATE Time stamp of event’s first occurrence.
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Table log_info
This table contains the information log for all devices.

Table log_self
This table contains the self log for all devices.

type NUMERIC(10, 0) Event type.

msg VARCHAR2 (150) Event’s message.

repeat_cnt NUMERIC(10, 0) Repeat count of event.

last_occurance DATE Time stamp of event’s last occurrence.

Field Name Data Type Description

objid NUMERIC (18,0)

time_stamp DATE First occurrence of the log.

link2device_vsys NUMERIC (18,0) Link to table device_vsys.

type NUMERIC (10,0) Event type (link to event_static_info.type).

msg VARCHAR2 (150) Msg string describing the change (note this is a varchar).

repeat_cnt NUMERIC (10,0) Repeat count.

last_occurance DATE Last occurrence of the log.

is_cluster NUMERIC(1,0) 0 = not cluster event, 1 = is cluster event.

Field Name Data Type Description

objid NUMERIC (18,0)

time_stamp DATE

link2device_vsys NUMERIC (18,0) Link to table device_vsys.

src_ip_addr VARCHAR2 (15)

dest_ip_addr VARCHAR2 (15)

src_port NUMERIC (10,0)

dest_port NUMERIC (10,0)

policy_id NUMERIC (10,0)

protocol_id NUMERIC (10,0) Protocol ID: 1=ICMP, 2=TCP, 3=UDP, 4=GRE, 5=ESP, 
6=AH, 7=OSPF

num_bytes NUMERIC (10,0)

duration NUMERIC (10,0)

Field Name Data Type Description
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Table log_traffic
This table contains the traffic logs for all devices.

Table tbl_interface
This table stores the daily summary of each interface performance log.

type NUMERIC (10,0) Event type (link to event_static_info.type)

Field Name Data Type Description

objid NUMERIC (18,0)

time_stamp DATE

link2device_vsys NUMERIC (18,0) Link to table device_vsys

src_ip_addr VARCHAR2 (15)

dest_ip_addr VARCHAR2 (15)

src_port NUMERIC (10,0)

dest_port NUMERIC (10,0)

policy_id NUMERIC (10,0)

protocol_id NUMERIC (10,0) Protocol ID: 1=ICMP, 2=TCP, 3=UDP, 4=GRE, 5=ESP, 6=AH, 
7=OSPF

num_bytes NUMERIC (10,0)

duration NUMERIC (10,0)

type NUMERIC (10,0) Event type (Link to event_static_info.type)

xlated_ip_addr VARCHAR2 (15) Translated IP addr

xlated_port NUMERIC(10, 0) Translated port

icmp_type NUMERIC(10, 0) ICMP type

num_packets NUMERIC(10, 0) Number of packets

Field Name Data Type Description

objid NUMERIC (18,0)

link2device_vsys NUMERIC (18,0) Link to table device_vsys.

link2device_interface NUMERIC (18,0) Protocol to the (sub)interface in that device.

bytes_in NUMERIC (18,0) Number bytes in; unit = bytes.

bytes_out NUMERIC (18,0) Number bytes out; unit = bytes.

packets_in NUMERIC (18,0) Number packets in.

Field Name Data Type Description
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Table tbl_interface_attk
This table stores the daily summary counters for the interface attack stats table.

packets_out NUMERIC (18,0) Number packets out.

bcast_out NUMERIC (10,0)

crc_error NUMERIC (10,0)

alignment_error NUMERIC (10,0)

short_frame NUMERIC (10,0)

rx_collision NUMERIC (10,0)

collection_time DATE End time of the interval.

start_time DATE Start time of the interval.

avg_util NUMERIC (10,0) Avg. interface utilization (%).

Field Name Data Type Description

objid NUMERIC (18,0)

link2device_vsys NUMERIC (18,0) Link to table device_vsys.

link2device_interface NUMERIC (18,0) Protocol to the (sub)interface in that device.

syn_attack NUMERIC (10,0) SYN attack.

tear_drop NUMERIC (10,0) Tear drop attack.

src_route NUMERIC (10,0) IP source route filter alarm.

ping_death NUMERIC (10,0) Ping of death alarm.

addr_spoof NUMERIC (10,0) IP spoof alarm.

land NUMERIC (10,0) Land attack.

icmp_flood NUMERIC (10,0) ICMP flood alarm.

udp_flood NUMERIC (10,0) UDP flood alarm.

win_nuke NUMERIC (10,0) Winnuke alarm.

port_scan NUMERIC (10,0) Port scan attack.

ip_sweep NUMERIC (10,0) Address sweep attack.

collection_time DATE End time of the interval.

start_time DATE Start time of the interval.

blk_java_activex NUMERIC (10,0) Block Java/ActiveX Component 

syn_frag NUMERIC (10,0) SYN Fragment Detection 

tcp_no_frag NUMERIC (10,0) TCP Packet Without Flag 

unknown_prot NUMERIC (10,0) Unknown Protocol Protection 

Field Name Data Type Description
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Table tbl_interface_vrtl
This table stores the daily summary counters for the virtual interface stats table.

bad_ip NUMERIC (10,0) Bad IP Option Detection 

ip_recd_route NUMERIC (10,0) IP Record Route Option 

ip_timestamp NUMERIC (10,0) IP Timestamp Option 

ip_security NUMERIC (10,0) IP Security Option 

loose_src_rou NUMERIC (10,0) IP Loose Src Route Option 

strict_src_rou NUMERIC (10,0) IP Strict Src Route Option 

ip_stream NUMERIC (10,0) IP Stream Option 

icmp_frag NUMERIC (10,0) ICMP Fragment 

large_icmp NUMERIC (10,0) Large ICMP Packet 

sync_fin_set NUMERIC (10,0) SYN and FIN bits set 

fin_no_ack NUMERIC (10,0) FIN bit with no ACK bit 

mal_URL NUMERIC (10,0) Malicious URL Protection

limit_sess NUMERIC (10,0) Limit session

syn_ack_ack NUMERIC (10,0) AYN-ACK-ACK proxy DoS

blk_frag_traffic NUMERIC (10,0) Block fragment traffic

Field Name Data Type Description

objid NUMERIC (18,0)

link2device_vsys NUMERIC (18,0) Link to table device_vsys

link2device_interface NUMERIC (18,0) Protocol to the (sub)interface in that device

bytes_in NUMERIC (18,0) Number bytes in; unit = bytes

bytes_out NUMERIC (18,0) Number bytes out; unit = bytes

packets_in NUMERIC (18,0) Number packets in

packets_out NUMERIC (18,0) Number packets out

vlan_in NUMERIC (10,0)

vlan_out NUMERIC (10,0)

connections NUMERIC (10,0)

dropped_packets NUMERIC (10,0)

denied_packets NUMERIC (10,0)

dropped_auth_fail NUMERIC (10,0)

dropped_url_blocking NUMERIC (10,0)

Field Name Data Type Description
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Table tbl_policy
This table stores the daily summary of each device policy performance log.

Table tbl_policy_summary
This table stores the monthly summary of each device policy performance log.

dropped_ipsec NUMERIC (10,0)

collection_time DATE End time of the interval.

start_time DATE Start time of the interval.

Field Name Data Type Description

objid NUMERIC (18,0)

link2device_vsys NUMERIC (18,0) Link to table device_vsys.

policy_id NUMERIC (10,0) Policy ID as defined in the device.

num_connections NUMERIC (10,0) Number connections in the observed period.

num_bytes NUMERIC (18,0) Number bytes in the observed period.

num_packets NUMERIC (18,0) Number packets in the observed period.

src_ip_addr VARCHAR2 (15) The policy's source IP.

src_netmask VARCHAR2 (15) The policy's source netmask.

dest_ip_addr VARCHAR2 (15) The policy's destination IP.

dest_netmask VARCHAR2 (15) The policy's destination netmask.

service_name VARCHAR2 (32) The policy's service name.

action_type VARCHAR2 (32) The policy's action type.

collection_time DATE End time of the interval.

start_time DATE Start time of the interval.

src_zone_id VARCHAR2 (32) Source zone ID.

dest_zone_id VARCHAR2 (32) Destination zone ID.

vpn_name VARCHAR2 (32) VPN name (if any VPN tunnel is used in this policy).

Field Name Data Type Description

objid NUMERIC (18,0)

link2device_vsys NUMERIC (18,0) Link to table device_vsys.

policy_id NUMERIC (10,0) Policy ID as defined in the device.

num_connections NUMERIC (10,0) Number connections in the observed period.

Field Name Data Type Description
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Table tbl_protocol
This table stores the daily protocol distribution summary.

Table tbl_protocol_summary
This table stores the monthly protocol distribution summary.

num_bytes NUMERIC (18,0) Number bytes in the observed period.

num_packets NUMERIC (18,0) Number packets in the observed period.

src_ip_addr VARCHAR2 (15) The policy's source IP.

src_netmask VARCHAR2 (15) The policy's source netmask.

dest_ip_addr VARCHAR2 (15) The policy's destination IP.

dest_netmask VARCHAR2 (15) The policy's destination netmask.

service_name VARCHAR2 (32) The policy's service name.

action_type VARCHAR2 (32) The policy's action type.

time_stamp DATE The last time we update data counters in this record (only 
one record exists for each (device, vsys, policy) combination 
per month.

src_zone_id VARCHAR2 (32) Source zone ID.

dest_zone_id VARCHAR2 (32) Destination zone ID.

vpn_name VARCHAR2 (32) VPN name (if any VPN tunnel is used in this policy).

Field Name Data Type Description

objid NUMERIC (18,0)

link2device_vsys NUMERIC (18,0) Link to table device_vsys.

link2device_interface NUMERIC (18,0) Protocol to the (sub)interface.

link2device_protocol NUMERIC (18,0) Protocol to the protocol.

bytes_in NUMERIC (18,0) Number bytes in for that protocol; unit = bytes.

bytes_out NUMERIC (18,0) Number bytes out; unit = bytes.

packets_in NUMERIC (18,0) Number packets in for that protocol.

packets_out NUMERIC (18,0) Number packets out.

collection_time DATE End time of the interval.

start_time DATE Start time of the interval.

Field Name Data Type Description

objid NUMERIC (18,0)

Field Name Data Type Description



Appendix A Database Schema

NetScreen-Global PRO Report Manager User’s Guide A-XIX

Table device_stat
This table contains device statistics data -- for SLA purposes.

Table cluster_group_stat
This table contains the VSD/RTO statistics.

link2device_vsys NUMERIC (18,0) Link to table device_vsys.

link2device_interface NUMERIC (18,0) Protocol to the (sub)interface.

link2device_protocol NUMERIC (18,0) Protocol to the protocol.

bytes_in NUMERIC (18,0) Number bytes in for that protocol; unit = bytes.

bytes_out NUMERIC (18,0) Number bytes out; unit = bytes.

packets_in NUMERIC (18,0) Number packets in for that protocol.

packets_out NUMERIC (18,0) Number packets out.

time_stamp DATE Last time the data counters was updated in this record. Only 
one record exists for each (device, vsys, interface, protocol) 
combination per month.

Field Name Data Type Description

objid NUMERIC (18,0)

link2device_vsys NUMERIC(18, 0)

up_time NUMERIC(10, 0) Accumulated value in this interval, in seconds.

avg_cpu_util NUMERIC(10, 0) Avg. CPU utilization (%).

avg_mem_alloc NUMERIC(10, 0) Avg. mem allocation, in bytes.

avg_mem_free NUMERIC(10, 0) Avg. mem free, in bytes.

avg_mem_fragment NUMERIC(10, 0) Avg. number fragment blocks, in bytes.

avg_active_sessions NUMERIC(10, 0) Avg. number active sessions.

avg_alloc_sessions NUMERIC(10, 0) Avg. number allocated sessions.

max_sessions NUMERIC(10, 0) Max sessions allowed.

failed_sessions NUMERIC(10, 0) Total number failed sessions.

start_time DATE Start time of the interval.

collection_time DATE End time of the interval.

Field Name Data Type Description

objid NUMERIC (18,0)

link2cluster_group NUMERIC (18,0) Link to table cluster_group.

Field Name Data Type Description



Appendix A Database Schema

A-XX NetScreen-Global PRO

Table packet_fwd_counters
This table contains information related to packet forward counters.

Table rto_counters
This table contains the RTO counters.

up_time NUMERIC (10,0) Up time of the cluster in this interval, unit = sec.

start_time DATE Start time of the interval.

collection_time DATE End time of the interval.

Field Name Data Type Description

objid NUMERIC (18,0)

link2device_vsys NUMERIC(18, 0) Link to the root vsys of this device.

forwarded_pkts NUMERIC(18, 0) Count of packets forwarded by this device in this interval.

received_pkts NUMERIC(18, 0) Count of packets forwarded to this device in this interval.

start_time DATE Start time of the interval.

collection_time DATE End time of the interval.

Field Name Data Type Description

objid NUMERIC (18,0)

link2device_vsys NUMERIC(18, 0)

link2cluster_group_device NUMERIC(18, 0) Link to the rto record.

unit_status NUMERIC(1, 0) Rto member status (0 = undefined, 1 = set, 2 = active).

direction NUMERIC(1, 0) 1 = out, 2 = in.

lost_hbeat NUMERIC(10, 0) Count of lost heartbeats.

to_active NUMERIC(10, 0) Count of state transition to active.

to_set NUMERIC(10, 0) Count of state transition to set.

lost_peer NUMERIC(10, 0) Count of number of times lost peer.

group_detach NUMERIC(10, 0) Count of number of times detached from group.

start_time DATE Start time of this interval.

collection_time DATE End time of this interval.

Field Name Data Type Description
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Table vpn_counters
This table contains VPN throughput data.

Table vsd_counters
This table contains Vsd counters.

Field Name Data Type Description

objid NUMERIC (18,0)

link2device_vsys NUMERIC(18, 0)

link2vpn_info NUMERIC(18, 0) Link to the VPN definition.

policy_id_in NUMERIC(10, 0) Incoming policy ID.

policy_id_out NUMERIC(10, 0) Out-going policy ID.

link2vpn_user NUMERIC(18, 0) Dialup group / dialup user, if any.

link2vpn_remote_user NUMERIC(18, 0) DN of remote user, if any.

peer_ip VARCHAR2 (15) Remote gateway IP.

avg_latency NUMERIC(10, 0) Average latency (if VPN mon on) in milliseconds.

avg_avail NUMERIC(10, 0) Average of all DC-pollings for the instances when this tunnel 
is up, in this interval.

bytes_in NUMERIC(18, 0) Bytes in

bytes_out NUMERIC(18, 0) Bytes out

packets_in NUMERIC(18, 0) Packets in

packets_out NUMERIC(18, 0) Packets out

up_time NUMERIC(10, 0) Up time of the VPN in this interval.

start_time DATE Start time of the interval.

collection_time DATE End time of the interval.

Field Name Data Type Description

objid NUMERIC (18,0)

link2cluster_group_device NUMERIC(18, 0) Link to the vsd record.

state_change NUMERIC(10, 0) Number of state transition events.

to_init NUMERIC(10, 0) Number of "init" state transitions.

to_master NUMERIC(10, 0) Number of "master" state transitions.

to_pbackup NUMERIC(10, 0) Number of "primary bkup" state transitions.

to_backup NUMERIC(10, 0) Number of "backup" state transitions.

to_ineligible NUMERIC(10, 0) Number of "ineligible" state transitions.
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Table device_overview
This table contains summary information of the event count per report group for each 
virtual system of each device.

Table event_overview
This table contains summary information of the event count per report group for each 
virtual system of each device.

to_inoperable NUMERIC(10, 0) Number of "inoperable" state transitions.

master_conflict NUMERIC(10, 0) Number of times multiple master exists when local unit is in 
"master" state.

pb_conflict NUMERIC(10, 0) Number of times "primary backup" exists when local unit is 
in "primary backup" state.

tx_hbeat NUMERIC(10, 0) Number of heartbeats transmitted by a group.

rx_hbeat NUMERIC(10, 0) Number of heartbeats received by a group.

start_time DATE Start time of the interval.

collection_time DATE End time of the interval.

Field Name Data Type Description

link2device_vsys NUMERIC (10,0) Link to the corresponding virtual system of each device.

group_name VARCHAR2 (250) Name of the report group.

time_stamp DATE Last update time stamp.

count NUMERIC (10,0) Event count of this event type for the virtual system of this device.

Field Name Data Type Description

group_name VARCHAR2 (250) Name of the report group.

event_type VARCHAR2 (250) Event type.

time_stamp DATE Last update time stamp.

count NUMERIC (10,0) Event count of this event type for the virtual system of this device.

Field Name Data Type Description
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Scheduled Data Collector Tasks
Report Manager supports scheduled tasks performed by the Data Collector. Tables in the 
database related to scheduled tasks include:

• polling_interval

• polling_attribute

• server_dc

• device

• server_dc_properties

The table polling_interval contains the Data Collector scheduled device polling. The 
tables server_dc and device (field: link2current_server_dc) together define which 
Data Collector is polling which devices.

Table polling_attribute defines which log or alarm is pushed from the device and 
which table is pulled from the device.

Table server_dc_properties contains other scheduled tasks (configured as name-
value pairs) that can be configured on a per Data Collector basis.

Table polling_interval
This table contains scheduled pollings to be performed by the Data Collector.

Table polling_attribute
This table contains the attributes/type of data that Report Manager polls from the 
devices.

Field Name Data Type Description

objid NUMERIC (18,0)

link2device NUMERIC (18,0) Link to the device that is getting polled.

pd_tbl_interval NUMERIC (10,0) Polling interval for protocol (pd) tbl, unit=seconds.

policy_tbl_interval NUMERIC (10,0) Polling interval for policy tbl, unit=seconds.

Field Name Data Type Description

objid NUMERIC (18,0)

pd_tbl Yes/No Whether the protocol distribution table should be polled.

policy_tbl Yes/No Whether the policy table (bytes in/out per policy) should be 
polled.

interface_tbl Yes/No Whether the interface statistics table should be polled.

interface_attk_tbl Yes/No Whether the interface-attack table should be polled.

interface_vrtl_tbl Yes/No Whether the interface-virtual table should be polled.
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Table server_dc
This table contains the list of server Data Collectors.

traffic_alarm Yes/No Whether the traffic alarm should be enabled (pushed from 
device).

attack_alarm Yes/No Whether the attack_alarm should be enabled (pushed from 
device).

misc_alarm Yes/No Whether the misc_alarm should be enabled (pushed from 
device).

config_log Yes/No Whether the config_log should be enabled (pushed from 
device).

info_log Yes/No Whether the info_log should be enabled (pushed from 
device).

traffic_log Yes/No Whether the traffic_log should be enabled (pushed from 
device).

self_log Yes/No Whether the self_log should be enabled (pushed from 
device).

link2device NUMERIC (18,0) Protocol to the device.

Field Name Data Type Description

objid NUMERIC (18,0)

server_name VARCHAR2 (64) Name of server.

ip_addr VARCHAR2 (15) IP address of server.

link2person NUMERIC (18,0) Link to person table for primary contact.

link2addr NUMERIC (18,0) Link to location of the server.

link2backup_server_dc NUMERIC (18,0) Link to the back up server.

cpu_load NUMERIC (10,0) CPU load of the server, in percentage.

jvm_free_mem NUMERIC (10,0) Free memory in the Java JVM, in percentage.

devlog_free_disk NUMERIC (10,0) Free disk space in the device log directory, in percentage 
(percentage of the free disk space); if null, it implies prob-
lems with reaching the disk partition.

last_heartbeat DATE Last known heartbeat of the server.

max_interval_alert_heartbeat NUMERIC (10,0) Send alert if a heartbeat from server for n seconds was not 
received.

link2current_server_mc NUMERIC (18,0) Link to the Master Controller that this Data Collector is 
connected to.

general_system_info VARCHAR2 (256) Server status, obtained from a system call to the server

end_date DATE Set to the data that this server is removed from service.

Field Name Data Type Description
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Table device
This table contains the core device attributes; other attributes are grouped into the 
device_* tables.

Table server_dc_properties
This table stores the configuration properties for the server’s Data Collector.

Field Name Data Type Description

objid NUMERIC (18,0)

sn VARCHAR2 (16) Serial number.

operation_mode VARCHAR2 (128) For example, Network Address Translation Mode, Routing 
mode, Transparent Mode …  

version VARCHAR2 (50) Firmware version number.

description VARCHAR2 (50) Device description (For example, Firewall+VPN).

ip_addr VARCHAR2 (15) IP addr of the interface that is talking to the Data Collector.

host_name VARCHAR2 (50) Device host name.

domain VARCHAR2 (50) Domain that the device belongs to.

admin_id VARCHAR2 (50) Admin login ID to the device.

admin_passwd VARCHAR2 (50) Admin passwd to the device, this should be encrypted.

init_datetime DATE Date/time that the device was initialized.

device_type VARCHAR2 (50) For example, Netscreen-5, Netscreen-10, Netscreen-100, 
Netscreen-1000 … 

platform_type NUMERIC (10,0) 0 = NS5, 1 = NS10, 2 = NS100, 3 = NS100P, 4=NS100T, 5 = 
NS1000, 6=NS1000N, 7=Others, 8=NS500, 9=NS25, 
10=NS50, 11=NS5204, 12=NS5208, 13=NS5XT.

link2person NUMERIC (18,0) Link to person table for primary contact.

link2current_server_dc NUMERIC (18,0) Link to the data-collector server currently managing this 
device.

link2primary_server_dc NUMERIC (18,0) Link to the default data-collector server managing this device.

link2secondary_server_dc NUMERIC (18,0) Link to the backup data-collector server managing this device.

end_date DATE End date with version number (if NULL, this record is the 
current firmware version running in the device).

comments VARCHAR2 (256) Any comments/notes on this device_vsys.

Field Name Data Type Description

objid NUMERIC (18,0)

link2server_dc NUMERIC (18,0) Link to the data-collector server for this property.
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Table server_dc_tasks
This table stores tasks that are to be forwarded to the Data Collector to perform.

property_name VARCHAR2 (50) Name of the property.

property_value VARCHAR2 (200) Value of the property.

Field Name Data Type Description

objid NUMERIC (18,0)

link2device NUMERIC (18,0) Protocol to device -- for which Task would be performed.

link2server_dc NUMERIC (18,0) Link to the current data-collector server managing that device.

task_params VARCHAR2 (100) Type/content of the task.

msg_read Yes/No If yes, this msg has been read by a Master Controller and pushed out to 
a Data Collector.

Field Name Data Type Description
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Scheduled HRS Tasks
Other scheduled tasks are performed by the Historical Reports Server. Tables in the 
database related to HRS tasks include:

• task

• profile

• report

Table task
This table contains scheduled tasks generated by the report task scheduler.

Table profile
This table contains report scheduler profile information (i.e. report settings that a user 
can define for generating reports in a specific time period).

Field Name Data Type Description

objid NUMERIC (18,0)

link2profile NUMERIC (18,0) Link to the profile this task belongs to.

invoke_time DATE Identifies when this task should be invoked.

parameter VARCHAR2 (2000) Task parameters, such as which report to generate, time interval, etc.

status NUMERIC (1,0) Task status: 0=created; 1=in progress; 2=done; 3=mailing; 4=mailing 
completed; 5= deleted; 6=abort; 7=abort mailed

Field Name Data Type Description

objid NUMERIC (18,0)

link2person NUMERIC (18,0) owner of the profile

name VARCHAR2 (100) report name

invoke_point DATE first time profile is invoked

parameter VARCHAR2 (2000) task-specific parameters

type NUMERIC (1,0) 0=historic report, 1=database cleanup, 2=file cleanup

frequency NUMERIC (1,0) indicates how often task will be run:

0=once, 1=hourly, 2=daily, 3=weekly, 4=monthly, 5=quar-
terly

status NUMERIC (1,0) profile status

range NUMERIC (10,0)

range_type NUMERIC (1,0) task date range sampling:

0=days, 1=weeks, 2=months, 3=quarters
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Table report
This table contains report definitions.

alert NUMERIC (1,0) determines whether e-mail notification will be sent

expiration date DATE date when profile expires

Field Name Data Type Description

objid NUMERIC (18,0)

report_id NUMERIC(10, 0)

report_name VARCHAR2 (64)

category_id NUMERIC(10, 0)

category_name VARCHAR2 (64)

report_image_filename VARCHAR2 (128) Path/filename Of This Report's Image Icon.

report_type NUMERIC(2, 0) 0 - 9: for base type. 10 - 19: for VPN. 20 - 29: for NSRP.

template_name VARCHAR2 (64)

Field Name Data Type Description
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Versioning
Report Manager verifies that the executable and the database schema are running in 
consistent versions. It also keeps track of the firmware versions running in the devices so 
that the Report Manager internal Java objects behave accordingly. For example, 
depending on the firmware version, Java objects know the subset of fields in the database 
to read and write.

Related tables:

• global_param

• device

The table global_param contains the version number of the database schema. The 
Report Manager executable has a matching, hard-coded version constant.The Report 
Manager executable performs version checking each time it starts up.

The table device keeps track of the latest firmware version of the devices.

Table global_param
This table contains global parameters used within the Report Manager

Field Name Data Type Description

objid NUMERIC (18,0)

email_server VARCHAR2 (30) Email server for SME to send out email msgs.

sme_version VARCHAR2 (10) Version number of this SME release.

db_version VARCHAR2 (10) Version number of this database schema.
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Device / Virtual system / Sub-Interface
The device related tables Report Manager support logging and reporting. Related tables 
include:

• device

• device_interface

• device_vsys

The table device contains the basic attributes for each physical device. Each applicable 
device can have zero or more virtual systems, which is defined in table device_vsys. To 
capture the concept of “root” and virtual-systems in the NetScreen-1000, Report Manager 
creates one record for each virtual-system in the table device_vsys. In addition, Report 
Manager creates a record with vsys_id = NULL to represent the “root.” 

For devices that do not support virtual systems, Report Manager still creates a record 
with vsys_id = NULL, so that it can treat all devices uniformly.

All physical interfaces and sub-interfaces are defined in table device_interface. The 
interface_type field in device_interface indicates whether it is a physical or virtual 
interface. Relationships of sub-interface and virtual systems are also defined in this table.

Table device_protocol
This table contains the list of device-supported protocols.

Table device_interface
This table contains interface information for each device.

Field Name Data Type Description

objid NUMERIC (18,0)

protocol_name VARCHAR2 (36) Name of the protocol.

protocol_id NUMERIC (10,0) ID of the protocol.

link2device_vsys NUMERIC (18,0) Link to table device_vsys.

end_date DATE End date with this version number (if NULL, this record is current).

Field Name Data Type Description

objid NUMERIC (18,0)

ip_addr VARCHAR2 (15) IP address of the interface.

netmask VARCHAR2 (15) Netmask

gateway VARCHAR2 (15) Default gateway.

mac_addr VARCHAR2 (20) Mac addr of this interface.

traffic_bandwidth NUMERIC (10,0) Max bandwidth allowed.
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Table device_vsys
This table contains virtual system information for each device.

interface_type NUMERIC (10,0) Type of interface: 0 = physical, 1 = virtual.

link2device NUMERIC (18,0) The physical device that this interface belongs to.

link2device_vsys NUMERIC (18,0) Link to the corresponding virtual system of each device.

end_date DATE The date with this version number (if NULL, this record is 
current).

name VARCHAR2 (50) Identifier name of this (sub)interface (For example, "trust/
<ID>").

interface_id NUMERIC (10,0) Interface ID as used in the device.

status NUMERIC (10,0) 0 = down, 1 = up, 2 = not available.

direction NUMERIC (1,0) 0 = half duplex, 1 = full duplex.

speed NUMERIC (10,0) Interface speed (unit = MB), For example, -1, 10, 100, 1000.

link2device_interface_phy
sical

NUMERIC (18,0) Link to the physical interface that this virtual interface is 
bonded to.

zone ID VARCHAR2 (32) Zone that this interface belongs to.

Field Name Data Type Description

objid NUMERIC (18,0)

vsys_name VARCHAR2 (50) Identifier name of virtual system.

vsys_id NUMERIC (10,0) ID of vsys as used in the device.

link2device NUMERIC (18,0) The device that this virtual system belongs to.

end_date DATE End date with this version number (if NULL, this record is current).

comments VARCHAR2 (256) Any comments/notes on this device_vsys.

Field Name Data Type Description
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Failover
Report Manager supports failover for the Data Collectors. To support that feature, each 
Data Collector sends heartbeats back to the Master Controllers. The heartbeats are then 
stored in the database.

The device table contains links to the configured primary and secondary Data Collectors.

The server_dc table contains links to the backup or secondary Data Collector for any 
given Data Collector. It also contains other miscellaneous information to support the 
merging back of data from a backup Data Collector. It also stores the heartbeat and 
health status of the Data Collector.

Device and Server Heartbeats
Heartbeats of the devices are logged to the heartbeat_device table.

Detailed status of the Data Collector, including CPU load, memory usage, disc usage, and 
general system information is updated periodically in the server_dc table. Similarly, 
status of the Master Controller is updated in the server_mc table.

Table heartbeat_device
This table contains the heartbeat information for each device.

Table server_mc
This table stores the list of server Master Controllers.

Field Name Data Type Description

objid NUMERIC (18,0)

last_heartbeat DATE Last known device-alive timestamp.

max_interval_alert_heartbeat NUMERIC (10,0) Send alert if we did not receive heartbeat from device for n 
seconds.

link2device Objid Protocol to the corresponding device.

start_monitor Yes/No If yes, the background daemon should be monitoring this 
record.

alert_sent Yes/No If yes, an alert msg has been sent out, and further alert msg 
will not be sent till this is reset to no.

Field Name Data Type Description

objid NUMERIC (18,0)

server_name VARCHAR2 (64) Name of server.

ip_addr VARCHAR2 (15) IP address of server.
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cpu_load NUMERIC (10,0) CPU load of the server, in percentage.

jvm_free_mem NUMERIC (10,0) Free memory in the Java JVM, in percentage.

last_heartbeat DATE Last known heartbeat of the server.

max_interval_alert_heartb
eat

NUMERIC (10,0) Send alert if we did not receive heartbeat from server for n 
seconds.

general_system_info VARCHAR2 (256) Server status, obtained from some system call in the server.

end_date DATE Set to the data that this server is removed from service.

last_purge_completed DATE Time when the last database auto-purge is completed by this 
Master Controller.

last_purge_count NUMERIC (18,0) Total number of database records being purged by this Mas-
ter Controller during its last auto-purge operation.

Field Name Data Type Description
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Static Information
Static information from the Report Manager property files is stored in database tables 
appended with _static_info. These tables include:

• device_platform_static_info

• appl_port_static_info

• event_static_info

• icmp_type_static_info

• ip_protocol_static_info

The event_static_info table contains descriptions of alarm and event types and their 
corresponding severity levels. The device_platform_static_info table contains descriptions 
of device_type and platform and whether the device type supports vsys. The tables 
appl_port_static_info, icmp_type_static_info, and ip_protocol_static_info contain 
description information for the types and IDs referenced in the log_* tables. These tables 
are primarily intended to support reporting.

Table device_platform_static_info
This table contains the static data of device platform types.

Table appl_port_static_info
This table contains the mappings of (protocol_id,port_number) - > application name. 
Protocol_id is the same as the fields in: log_traffic.protocol_id; the min_port, max_port are 
the range of 'ports' referenced in: log_traffic.dest_port.

Note: The keys into these *_static_info are not by objid, but by the actual *_type 
or *_id fields.

Field Name Data Type Description

objid NUMERIC (18,0)

platform_type NUMERIC (10,0) The same identifier that is being used in the table “device.”

description VARCHAR2 (30) For example, NS5, NS10, NS100, NS100P…

has_vsys Yes/No Whether the device type can have vsys or not.

Field Name Data Type Description

objid NUMERIC (18,0)

protocol_id NUMERIC (10,0) Protocol ID

min_port NUMERIC (10,0) Min port number

max_port NUMERIC (10,0) Max Port Number

name VARCHAR2 (20) Application name
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Table event_static_info
This table contains severity level/description for all log/alarms.

Table icmp_type_static_info
This table contains mappings of ICMP_types/descriptions. The ID's are the same as the 
fields referenced in log_traffic.icmp_type.

Table ip_protocol_static_info
This table contains mappings of IP_protocols ID/descriptions. The ID's are the same as 
the fields referenced in alarm_attack.protocol_id, log_self.protocol_id, and 
log_traffic.protocol_id.

description VARCHAR2 (64)

Field Name Data Type Description

objid NUMERIC (18,0)

event_group NUMERIC(10, 0) Event group: alarm_attack = 16, alarm_misc = 17, alarm_traffic = 
15, log_config = 7, log_info = 8, log_self = 21, log_traffic = 9.

type NUMERIC(10, 0) Event type.

description VARCHAR2 (100) Description of event.

severity_level NUMERIC(10, 0) Severity level of event.

Field Name Data Type Description

objid NUMERIC (18,0)

ID NUMERIC(10, 0) ID of ICMP type.

name VARCHAR2 (16) Name of type.

description VARCHAR2 (40) Description of type.

Field Name Data Type Description

objid NUMERIC (18,0)

ID NUMERIC(10, 0) Protocol ID.

name VARCHAR2 (16) Name of type.

description VARCHAR2 (40) Description of type.

Field Name Data Type Description



Appendix A Database Schema

A-XXXVI NetScreen-Global PRO

Database Tables Related To Clusters
Tables related to NSRP/Clusters include:

• cluster_group

• cluster_group_device

• cluster_general_config

Table cluster_group
This table contains information related to cluster groups.

Table cluster_group_device
This table contains VSD/RTO membership information.

Table cluster_general_config
This table contains general configuration information about clusters.

Field Name Data Type Description

objid NUMERIC (18,0)

cluster_id NUMERIC(10, 0) Cluster ID

group_type NUMERIC(1, 0) 0 = vsd_group, 1 = rto_group.

group_id NUMERIC(10, 0) vsd_group_id (if group_type = 0), rto_group_id (if group_type = 1).

end_date DATE If not null, this record is expired.

Field Name Data Type Description

objid NUMERIC (18,0)

link2cluster_group NUMERIC (18,0) Link to table cluster_group.

unit_id NUMERIC (10,0) vsd_group_member_id (if vsd group), or rto_group_member_id.

link2device_vsys NUMERIC (18,0) Link to table device_vsys.

end_date DATE If not null, this record is expired.

Field Name Data Type Description

objid NUMERIC (18,0)

link2device_vsys NUMERIC (18,0)

cluster_id NUMERIC (10,0) Cluster identifier.

cluster_local_unit_id NUMERIC (10,0) Local device’s unit identifier.

encryp_enable NUMERIC (1,0) Encryption enabled (0 = disable, 1 = enable).
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auth_enable NUMERIC (1,0) Authentication enabled (0 = disable, 1 = enable).

if_monitor VARCHAR2 (256) Interfaces monitored.

grat_arps NUMERIC (10,0) Number of gratuitous arps.

vsd_init_hold_time NUMERIC (10,0) VSD group init hold time (unit = secs).

vsd_hb_interval NUMERIC (10,0) VSD group heartbeat interval in ms.

vsd_hb_lost_thresh NUMERIC (10,0) VSD heartbeat lost threshold.

rto_hb_interval NUMERIC (10,0) RTO heartbeat interval (unit = secs).

rto_hb_lost_thresh NUMERIC (10,0) RTO heartbeat lost threshold.

rto_sess_sync_enable NUMERIC (1,0) Session sync enabled (0 = disable, 1 = enable).

track_enable NUMERIC (1,0) Track IP enabled (0 = disable, 1 = enable).

track_threshold NUMERIC (10,0) Track IP failover threshold.

track_failover_enable NUMERIC (1,0) Failover enable switch.

Field Name Data Type Description
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Database Tables Related to VPN
There are several tables related to monitoring VPN:

• vpn_dialup_group

• vpn_remote_user

• vpn_user

• vpn_info

• policy_info

Table vpn_dialup_group
This table stores dial-up groups that can be used in a VPN. If the dialup_group_name 
table is null, the user does not belong to a dial-up group. If the user_name table is null, 
the record is a definition of a dial-up group.

Table vpn_remote_user
This table contains current mappings of sa_id and DN of remote users.

Table vpn_user
This table contains definitions of dial-up group/dial-up_users that can be used in VPNs.

Field Name Data Type Description

objid NUMERIC (18,0)

link2device_vsys NUMERIC (18,0)

group_id NUMERIC (10,0) Dialup group ID.

group_name VARCHAR2(64) Dialup group name.

end_date DATE If not null, this record is expired.

Field Name Data Type Description

objid NUMERIC (18,0)

link2device_vsys NUMERIC(18, 0)

dn VARCHAR2(512) DN of remote user.

sa_id NUMERIC(10, 0) SA_id corresponds to this DN.

Field Name Data Type Description

objid NUMERIC (18,0)

link2device_vsys NUMERIC(18, 0)

link2vpn_dialup_group NUMERIC(18, 0) If null, this dialup user does not belongs to any dialup group.
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Table vpn_info
This table contains static VPN configuration information. The vpn_uptime and 
vpn_counters tables will reference this table.

Table policy_info
This table contains device policy configuration information.

user_id NUMERIC(10, 0) Dial-up[manual/ike] user ID.

user_name VARCHAR2 (64) Dial-up[manual/ike] user name.

manual_dialup NUMERIC(1, 0) MANUAL key user, 0/1: no/yes

ike_dialup NUMERIC(1, 0) IKE user, 0/1: no/yes

l2tp_dialup NUMERIC(1, 0) l2tp user, 0/1: no/yes

auth NUMERIC(1, 0) Auth user, 0/1: no/yes

ike_identity VARCHAR2 (512) IKE identity or remote SPI (manual).

end_date DATE If not null, this record is expired.

Field Name Data Type Description

objid NUMERIC (18,0)

link2device_vsys NUMERIC (18,0)

vpn_name VARCHAR2 (32) VPN name

vpn_type NUMERIC(1, 0) Site-to-site: 2, remote user: 1

key_type NUMERIC(1, 0) 0 = manual, 1 = autoIKE

peer_id VARCHAR2 (512) Peer identifier

link2device_interface NUMERIC (18,0)

link2vpn_dialup_group NUMERIC (18,0) VPN dialup group information for this VPN (if any).

link2vpn_user NUMERIC (18,0) VPN dialup user information for this VPN (if any).

end_date DATE If not null, this record is expired.

Field Name Data Type Description

objid NUMERIC (18,0)

link2device_vsys NUMERIC (18,0) Service/vsys this policy corresponds to.

src_zone_id VARCHAR2 (32) source zone ID

dest_zone_id VARCHAR2 (32) Destination zone ID

policy_id NUMERIC(10, 0) Policy ID

Field Name Data Type Description
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policy_name VARCHAR2 (32) Policy name

src_ip VARCHAR2 (15) source IP addr

dest_ip VARCHAR2 (15) Destination IP addr

service VARCHAR2 (32) Service

action_type VARCHAR2 (32) Action type

vpn_name VARCHAR2 (32) VPN name (if the policy is using a VPN).

end_date DATE if not null, this record is expired.

Field Name Data Type Description
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Miscellaneous Tables
The following table is also present in the database schema.

Table global_properties
This table contains the configuration properties that are shared by all the Report 
Manager components.

Field Name Data Type Description

objid NUMERIC (18,0)

property_name VARCHAR2 (20) Name of the property.

property_value VARCHAR2 (20) Value of the property.
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B
Appendix B

Glossary

Term Description

Absolute Value Absolute refers to the cumulative value since the device restart.

Access Policies Access Policies provide the initial protection mechanism for the 
firewall, allowing you to determine what traffic passes across it 
based on IP session details. They protect the Trusted network from 
outsider attacks, such as the scanning of Trusted servers. Access 
Policies create an environment in which you set up security Poli-
cies to monitor traffic attempting to cross your firewall.

Address Spoofing You can enable a NetScreen device to guard against spoofing 
attacks by checking its own route table. If the IP address is not in 
the route table, traffic through the NetScreen device is not allowed.

Advanced Encryption Standard (AES) An emerging encryption standard which, when adopted by Internet 
infrastructures worldwide, will offer greater interoperability with 
other network security devices. This version of AES uses a 128-bit 
key.

Authentication Authentication ensures that digital data transmissions are delivered 
to the intended receiver. Authentication also assures the receiver of 
the integrity of the message and its source (where or whom it came 
from). The simplest form of authentication requires a user name 
and password to gain access to a particular account. Authentication 
protocols can also be based on secret-key encryption, such as DES, 
or on public-key systems using digital signatures.

Authentication Header (AH) See ESP/AH

Bastion Host A hardened system taken one step further - configured with the 
minimal software to support a single network service.

Broadcast Out. The number of broadcast-type packets processed through the 
NetScreen device over the selected interface.

Bytes In The number of bytes of incoming traffic processed through the 
NetScreen device over the selected interface.

Bytes Out The number of bytes of outgoing traffic processed through the 
NetScreen device over the selected interface.

Circuit-level Proxy Proxy or Proxy Server is a technique used to cache information on 
a Web server and acts as an intermediary between a Web client and 
that Web server. It basically holds the most commonly and recently 
used content from the World Wide Web for users in order to pro-
vide quicker access and to increase server security. 

CLI The command line interface.

Data Encryption Standard (DES) A cryptographic block algorithm with a 56-bit key.
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CRC Errors The number of packets generating a cyclic redundancy code error 
processed through the NetScreen device over the selected interface.

Data Encryption Standard (DES) A 40- and 56-bit encryption algorithm that was developed by the 
National Institute of Standards and Technology (NIST). DES is a 
block encryption method originally developed by IBM. It has since 
been certified by the U.S. government for transmission of any data 
that is not classified top secret. DES uses an algorithm for private-
key encryption.

Data Encryption Standard-Cipher Block 
Chaining (DES-CBC)

Until recently, the most significant use of triple-DES (3DES) was 
for the encryption of single DES keys, and there was really no need 
to consider how one might implement various block cipher modes 
when the block cipher in question is actually one derived from mul-
tiple encryption. However, as DES nears the end of its useful life-
time, more thought is being given to an increasingly widespread 
use of triple-DES.

Delta Value Delta refers to the rate of change. For instance the difference 
between the last set of counter values and the current set of counter 
values.

De-Militarized Zone (DMZ) From the military term for an area between two opponents where 
fighting is prevented. DMZ Ethernets connect networks and com-
puters controlled by different bodies. They may be external or 
internal. External DMZ Ethernets link regional networks with rout-
ers.

Denial of Service (DoS) Attack An attack designed to disrupt a network service. Typically in a DoS 
attack, a flood of information from the attacker will overwhelm a 
serving system’s resources, causing it to be unable to field valid 
network requests. Other DoS attacks can cause the serving process 
to crash, also denying the service.

Device Group Authentication ID The initial Device Group authentication ID is arbitrary but must be 
consistent for all components. This should be a unique password, 
containing both letters and characters. You can create any Device 
Group Authentication ID you like, but you must consistently use 
the same Device Group Authentication ID for all components. The 
system permanently encrypts it.

DHCP The Dynamic Host Configuration Protocol used to dynamically 
assign IP addresses to networked computers.

Distributed Denial of Service (DDoS) Attack A DoS attack (typically a flood) from multiple source points. This 
is more effective than a DoS attack, as it is no longer one computer 
against one server in an effort to overwhelm the server.

DNS The Domain Name System maps domain names to IP addresses.

Term Description



Appendix B Glossary

NetScreen-Global PRO Report Manager User’s Guide B-III

ESP/AH The IP level security headers, AH and ESP, were originally pro-
posed by the Network Working Group focused on IP security 
mechanisms, IPSec. The term IPSec is used loosely here to refer to 
packets, keys, and routes that are associated with these headers. 
The IP Authentication Header (AH) is used to provide authentica-
tion. The IP Encapsulating Security Header (ESP) is used to pro-
vide confidentiality to IP datagrams.

Firewall A device that protects and controls the connection of one network 
to another, for traffic both entering and leaving. Firewalls are used 
by companies that want to protect any network-connected server 
from damage (intentional or otherwise) by those who log in to it. 
This could be a dedicated computer equipped with security mea-
sures or it could be a software-based protection.

GBIC A Gigabit Interface Connector (GBIC) is the kind of interface mod-
ule card used on the NetScreen-2/500 for connecting to a fiber optic 
network.

GMT (Greenwich Mean Time) The Greenwich, England mean solar time. Also known as Univer-
sal Time, it is used for calculating time throughout most of the 
world.

Hardened System A server with all appropriate security patches and bug fixes that has 
been configured securely. These systems are designed to resist pen-
etration.

Histogram A vertical graph in which different amounts are represented by 
thin, color-coded bands or bars. These bars represent a frequency 
distribution; heights of the bars represent observed frequencies. 

ICMP Flood  ICMP pings can be so numerous that they overload a system with 
so many echo requests that the system expends all its resources 
responding until it can no longer process valid network traffic. If 
you set a threshold to invoke ICMP flood attack protection when 
exceeded, ICMP flood attacks are recorded as statistics.

Internet Control Message Protocol (ICMP). Occasionally a gateway or destination host will communicate with 
a source host, for example, to report an error in datagram process-
ing. For such purposes the protocol, the Internet Control Message 
Protocol (ICMP), is used. ICMP uses the basic support of IP as if it 
were a higher level protocol, however, ICMP is actually an integral 
part of IP, and must be implemented by every IP module. ICMP 
messages are sent in several situations.

Internet Key Exchange (IKE) The method for exchanging keys for encryption and authentication 
over an unsecured medium, such as the Internet.

Internet Protocol (IP) An Internet standard protocol that defines a basic unit of data called 
a datagram. A datagram is used in a connectionless, best-effort, 
delivery system. Internet protocol defines how information gets 
passed between systems.

Term Description
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IP Address Spoofing Depending on the circumstances, a spoofed IP can be used to per-
form difficult-to-trace DDoS attacks, hiding their true address in a 
clutter of bogus addresses, or in rare occasions taking advantage of 
IP address related trusted relationships between two hosts. The 
attacker sends Crafted Packets (Packets made from the ground up, 
and not created and processed normally through the IP Stack) that 
have source IP addresses other than what has been assigned to the 
interface. 

IP Gateway Also called a router, a gateway is a program or a special-purpose 
device that transfers IP datagrams from one network to another 
until the final destination is reached.

IP Security (IPSec) Security standard produced by the Internet Engineering Task Force 
(IETF). It is a protocol suite that provides everything you need for 
secure communications—authentication, integrity, and confidenti-
ality—and makes key exchange practical even in larger networks. 
See also DES-CBC, ESP/AH.

IP Sweep This is the same as an address sweep attack, and similar to a port 
scan attack. It occurs when an attacker sends ICMP echo requests 
(or pings) to different destination addresses hoping that one will 
reply, thus uncovering an address to a target. If a remote host pings 
10 addresses in 0.3 seconds, the NetScreen device flags this as an 
address sweep attack and drops the connection.

ISAKMP The Internet Security Association and Key Management Protocol 
(ISAKMP) provides a framework for Internet key management and 
provides the specific protocol support for negotiation of security 
attributes. By itself, it does not establish session keys, however it 
can be used with various session key establishment protocols to 
provide a complete solution to Internet key management.

Land Attack Combining a SYN attack with IP spoofing, a Land attack occurs 
when an attacker sends spoofed SYN packets containing the IP 
address of the victim as both the destination and source IP address. 
This creates an empty connection. Flooding a system with such 
empty connections can overwhelm the system, causing a Denial of 
Service. The NetScreen device blocks any attempts of this nature 
and records such attempts as a Land attack.

Load balancing Load balancing is the mapping (or re-mapping) of work to proces-
sors, with the intent of improving the efficiency of a concurrent 
computation.

MD5 Message Digest (version) 5, an algorithm that produces a 128-bit 
message digest (or hash) from a message of arbitrary length. The 
resulting hash is used, like a “fingerprint” of the input, to verify 
authenticity.

Term Description
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Packet Filtering A router/firewall process that contains access control lists (ACL) 
that restrict flow of information through it based upon protocol 
characteristics such as source/destination IP address, protocol or 
port used. Generally, packet-filtering routers do not track sessions 
through them unless the router is also doing a NAT process, and the 
NAT process would track the session for NAT purposes.

Ping of Death Intentionally oversized or irregular ICMP packets can trigger a 
Denial of Service condition, freezing, or other adverse system reac-
tions. You can configure a NetScreen device to detect and reject 
oversized or irregular packet sizes.

Policies See Access Policies.

Port Scan A port scan attack occurs when packets are sent out to different port 
numbers, for the purpose of scanning the available services in 
hopes that one port will respond. If a remote host scans 10 ports in 
0.3 seconds, the NetScreen device flags this as a port scan attack 
and drops the connection.

Protocols Protocols are pre-defined services (like HTTP, SNMP, or Telnet) 
that are enabled for the NetScreen device.

RADIUS Remote Authentication Dial-In User Service is a service for 
authenticating and authorizing dialup users.

Receive Collisions The number of collisions on the line detected by the Carrier Sense 
Multiple Access Collision Detection (CSMA/CD) protocol.

Security Association The combination of a Security Parameters Index and a destination 
address. Required for both Authentication Header and Encapsulat-
ing Security Payload protocols. See also Security Parameters 
Index. 

Security Parameters Index (SPI) The SPI is a hexadecimal value which uniquely identifies each tun-
nel. It also tells the NetScreen device which key to use to decrypt 
packets. 

Server Farm A server farm is a network where clients install their own comput-
ers to run Web servers, e-mail, or any other TCP/IP based services 
they require, making use of leased permanent Internet connections 
with 24-hour worldwide access. Instead of expensive dedicated-
line connections to various offices, servers can be placed on server 
farm networks to have them connected to the Internet at high-speed 
for a fraction of the cost of a leased line.

SHA-1 Secure Hash Algorithm-1, an algorithm that produces a 160-bit 
hash from a message of arbitrary length. (It is generally regarded as 
more secure than MD5 because of the larger hashes it produces.

Short Frames The number of frames containing less than 64 bytes of data.

Source Route The Source Route option applied in an IP header can allow an 
attacker to enter a network with a false IP address and have data 
sent back to the attacker’s real address.

Term Description
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Stateful Inspection A firewall process that checks the TCP header for information on 
the session’s state. The process checks whether it is initializing 
(SYN), ongoing (SYN/ACK), or terminating (FIN). A stateful 
inspector firewall will typically track each session flowing through 
it. Packets from unknown sessions that appear to be part of an 
ongoing or illegal session are dropped. All NetScreen network 
security devices are stateful inspectors.

SYN Attack SYN packets overwhelm a network by initiating so many connec-
tion attempts or information requests that the network can no 
longer process legitimate connection requests, resulting in a Denial 
of Service.

Tear Drop Attack When the first and second parts of a fragmented packet overlap, the 
server attempting to reassemble the packet can crash. If the 
NetScreen device sees this discrepancy in a fragmented packet, it 
drops the packet.

Transmission Control Protocol/Internet Pro-
tocol (TCP/IP)

A set of communications protocols that support peer-to-peer con-
nectivity functions for both local and wide area networks. A com-
munications protocol which allows computers with different 
operating systems to communicate with each other. Controls how 
data is transferred between computers on the Internet.

Triple DES (3DES) A more powerful version of DES in which the original DES algo-
rithm is applied in three rounds, using a 168-bit key. DES provides 
a significant performance savings but is considered unacceptable 
for many classified or sensitive material transfers.

Trojan Horse A program with functionality (typically malicious) not made 
known to an end-user. A common example of this would be a game 
received as an email attachment. This ‘Trojaned’ program might 
also secretly install a remote administration (known as a back door) 
program that allowed an attacker access to your computer. 

Trunk Port A trunk port allows a switch to bundle traffic from several VLANs 
through a single physical port, sorting the various packets by the 
VLAN identifier (VID) in their frame headers.

User Datagram Protocol (UDP) A protocol in the TCP/IP protocol suite, the User Datagram Proto-
col or UDP allows an application program to send datagrams to 
other application programs on a remote machine. Basically UDP is 
a protocol that provides an unreliable and connectionless datagram 
service where delivery and duplicate detection are not guaranteed. 
It does not use acknowledgments, or control the order of arrival.

UDP Flood UDP packets are sent with the purpose of slowing down the system 
to the point that it can no longer handle valid connections. If you 
set a threshold to invoke UDP flood attack protection, when 
exceeded, UDP flood attacks are recorded as statistics.

Term Description
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Universal Resource Locator (URL) A standard way developed to specify the location of a resource 
available electronically.Also referred to as a location or address, 
URLs specify the location of files on servers. A general URL has 
the syntax protocol://address. For example, http://
www.srl.rmit.edu.au/pd/index.html specifies that the protocol is 
http and the address is www.srl.rmit.edu.au/pd/index.html.

Virtual-Interface Object (VIF) TBC. See also SIF.

Virtual Local Area Network (VLAN) A logical rather than physical grouping of devices that constitute a 
single broadcast domain. VLAN members are not identified by 
their location on a physical subnetwork but through the use of tags 
in the frame headers of their transmitted data. VLANs are 
described in the IEEE 802.1Q standard.

VLAN Identifier (VID) TBC.

Virtual Private Network (VPN) A VPN is an easy, cost-effective and secure way for corporations to 
provide telecommuters and mobile professionals local dial-up 
access to their corporate network or to another Internet Service Pro-
vider (ISP). Secure private connections over the Internet are more 
cost-effective than dedicated private lines. VPNs are possible 
because of technologies and standards such as tunneling, screening, 
encryption, and IPSec.

Virtual System (Vsys) A feature unique to the NetScreen-1000, a Virtual System is a sub-
division of the main system that appears to the user to be a stand-
alone entity. Virtual Systems reside separately from each other in 
the same NetScreen-1000 device. Each one can be managed by its 
own Virtual System Administrator.

WinNuke Attack WinNuke can cause any computer on the Internet running Win-
dows to crash. WinNuke introduces a NetBIOS anomaly that forces 
Windows to restart. The NetScreen device can scan any incoming 
Microsoft NetBIOS Session Service packets, modify them, and 
record the event as a WinNuke attack.

Worm A self-replicating attack program. Worms differ from typical 
viruses in that they are completely automatic – no interaction with a 
user is required. When a vulnerable target is found, it immediately 
and automatically infects the new host with the code. The newly 
infected host starts this process all over again. Each infected host 
will attempt to infect more hosts.

Term Description
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